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KATA PENGANTAR
Alhamdulillah, Segala puji hanya bagi Allah, yang telah memberikan Karunia-nya sehingga penulis
dapat  menyelesaikan buku panduan ini.  Buku Panduan ini  untuk melengkapi  sekaligus  sebagai
panduan  sederhana  dalam  menggunakan  distro  linux  Asril  OS  6.0  Loka.  Pada  dasarnya  buku
panduan ini hanyalah menguraikan secara sederhana program-program yang disertakan pada rilis
Asril OS kali ini. 

Buku  panduan  ini  di  dipersembahkan  untuk  para  pengguna  open  source  di  seluruh  Indonesia.
Penulis  juga  mengucapkan  terima  kasih  kepada  temen-temen  di  dunia  nyata  dan  dunia  maya,
khususnya  di  forum-forum  komunitas  linux,  yang  telah  memberikan  dukungan  sehingga  Tim
Pengembang Asril OS dapat menyelesaikan pengembangan distro linux Asril OS ini. 
Semoga dengan adanya buku panduan ini selain sebagai pelengkap distro linux Asril OS diharapkan
juga  dapat  meningkatkan  kesadaran  masyarakat  untuk  menghargai  hak  cipta  orang  lain  serta
mengurangi budaya yang keliru yaitu nyaman menggunakan perangkat lunak bajakan. Akhir kata
buku panduan ini masih bayak kekurangan sehingga perlu adanya saran dan kritik untuk perbaikan. 

Cirebon, Mei 2018

Penulis

 Halaman iii   



 Kata Pengantar  

 Halaman iv   



 Daftar Isi 

DAFTAR ISI

COVER.................................................................................................................................................i
KATA PENGANTAR..........................................................................................................................iii

DAFTAR ISI.........................................................................................................................................v
PENDAHULUAN................................................................................................................................1

0.1 Ihwal Buku Ini...........................................................................................................................1
0.2 Penulis Lanjutan, Sampul dan Tata Letak..................................................................................1

0.3 Lisensi........................................................................................................................................1
0.4 Merek Dagang............................................................................................................................1

BAB 1 Apa itu Linux dan Asril OS......................................................................................................3
1.1 Apa itu Linux?...........................................................................................................................3

1.2 Kelebihan Linux........................................................................................................................3
1.3 Apa itu Asril OS?.......................................................................................................................4

1.4 Asal nama Asril OS....................................................................................................................4
1.5 Fitur Asril OS 6.0 Loka..............................................................................................................4

1.6 Info Lebih Lanjut.......................................................................................................................5
BAB 2 Memasang Asril OS.................................................................................................................7

2.1 Kebutuhan Sistem......................................................................................................................7
2.2 Cara Mendapatkan Asril OS......................................................................................................7

2.3 Persiapan Menjelang Pemasangan.............................................................................................7
2.4 Persiapan Partisi.........................................................................................................................8

2.4.1 Catatan Mengenai Partisi...................................................................................................8
2.5 Memasang Asril OS Melalui Live DVD....................................................................................9

BAB 3 Desktop Asril OS 6.0 Loka....................................................................................................15
3.1 Bagian-bagian Desktop............................................................................................................15

3.2 Tombol Menu Utama...............................................................................................................15
3.3 Jam dan Tanggal......................................................................................................................16

3.4 Daftar Jendela dan Notifikasi..................................................................................................17
3.5 Pojok Interaktif........................................................................................................................17

3.6 Bekerja dengan Program..........................................................................................................17
3.7 Menambahkan Menu Program pada Panel..............................................................................17

3.8 Mengunci Layar.......................................................................................................................18
3.9 Pengaturan Latar Belakang......................................................................................................18

3.10 Pengaturan Informasi Pribadi................................................................................................19
3.11 Mengakhiri Sesi.....................................................................................................................20

3.12 Mematikan Komputer............................................................................................................20
BAB 4 Menggunakan Perambah Berkas............................................................................................23

4.1 Menggunakan Nemo................................................................................................................23

 Halaman v  



 Daftar Isi 

4.2 Hirarki Partisi...........................................................................................................................24
4.3 Hak Akses Berkas dan atau direktori.......................................................................................25

4.4 Mengakses Media Penyimpanan Lain.....................................................................................27
4.5 Memampatkan Berkas/direktori..............................................................................................27

4.6 Format Perangkat USB............................................................................................................28
4.7 Mencari berkas/direktori..........................................................................................................28

4.8 Berbagi direktori melalui Jaringan..........................................................................................29
4.9 Salin File ke FlashDisk............................................................................................................29

BAB 5 Pasang, Hapus dan Perawatan Perangkat Lunak....................................................................31
5.1 Pengaturan Perangkat Lunak pada Asril OS............................................................................31

5.2 Pengaturan Lumbung Paket.....................................................................................................31
5.2.1 Lumbung Paket (Internet)................................................................................................32

5.2.2 Lumbung Paket Jaringan Lokal (Intranet).......................................................................32
5.3 Memasang dan Menghapus Perangkat Lunak.........................................................................32

5.3.1 Manajer Paket Synaptic...................................................................................................32
5.3.2 Melalui Perintah apt-get...................................................................................................33

5.4 Pemasangan melalui Berkas DEB...........................................................................................34
5.5 Merawat Sistem.......................................................................................................................35

BAB 6 Program Perkantoran..............................................................................................................37
6.1 LibreOffice...............................................................................................................................37

6.1.1 LibreOffice Writer............................................................................................................37
6.1.2 LibreOffice Calc...............................................................................................................43

6.1.3 LibreOffice Impress.........................................................................................................49
6.1.4 LibreOffice Draw.............................................................................................................51

6.2 PDF Chain................................................................................................................................52
6.3 xCHM......................................................................................................................................54

6.4 Adobe Reader...........................................................................................................................54
BAB 7 Program Multimedia dan Hiburan..........................................................................................55

7.1 Brasero.....................................................................................................................................55
7.2 VLC Media Player...................................................................................................................56

7.3 Audacity...................................................................................................................................57
7.4 Cheesee....................................................................................................................................58

7.5 Mobile Media Converter..........................................................................................................59
7.6 Radio Tray................................................................................................................................62

7.7 Media Player............................................................................................................................62
7.8 OpenShot Video Editor............................................................................................................63

7.9 TV-MAXE...............................................................................................................................64
BAB 8 Program Desain Grafis...........................................................................................................65

8.1 Penampil Gambar....................................................................................................................65
8.2 Pix............................................................................................................................................65

 Halaman vi  



 Daftar Isi 

8.3 GIMP Editor Gambar...............................................................................................................66
8.3.1 Memulai program GIMP..................................................................................................66

8.3.2 Manipulasi Foto Dengan GIMP.......................................................................................68
8.3.3 Keyboard Shortcut...........................................................................................................68

8.3.4 Lebih Lanjut Dengan GIMP............................................................................................70
8.4 Inkscape...................................................................................................................................70

8.4.1 Memulai Inkscape............................................................................................................70
8.4.2 Bekerja Dengan Inkscape.................................................................................................71

8.4.3 Mempelajari Inkscape Lebih Lanjut................................................................................72
8.5 Scribus.....................................................................................................................................73

8.6 Pemindai Ringkas....................................................................................................................74
8.7 Pinta.........................................................................................................................................75

BAB 9 Program Pendidikan...............................................................................................................77
9.1 Tux Paint..................................................................................................................................77

9.2 Tux Math..................................................................................................................................78
9.3 Tux Typing...............................................................................................................................78

9.4 GCompris.................................................................................................................................79
9.5 Otodidak...................................................................................................................................80

9.6 GNU PSPP...............................................................................................................................82
9.7 Stellarium.................................................................................................................................83

9.7.1 Fitur..................................................................................................................................83
BAB 10 Program Islami.....................................................................................................................87

10.1 Waktu Shalat Minbar.............................................................................................................87
10.1.1 Mengatur Waktu Sholat di Waktu Shalat Minbar...........................................................87

10.1.2 Mengatur pengingat Adzan di Waktu Shalat Minbar.....................................................88
10.1.3 Melihat Kalender Jadwal Waktu Sholat.........................................................................88

10.2 Hijra Applet............................................................................................................................89
10.3 Zekr........................................................................................................................................89

10.4 Zakat Kalkulator....................................................................................................................90
10.5 Monajat..................................................................................................................................91

10.6 SalafiDB.................................................................................................................................92
10.6.1 Fitur-Fitur yang Disediakan...........................................................................................92

10.6.2 Isi Indeks (Februari 2011)..............................................................................................92
10.7 Alfanous.................................................................................................................................93

10.7.1 Keistimewaan Al Fanous...............................................................................................93
10.8 Elforkane................................................................................................................................94

10.9 Hadist Web.............................................................................................................................94
10.10 Folder Islami........................................................................................................................95

10.11 Ayat......................................................................................................................................95
BAB 11 Program Internet...................................................................................................................97

 Halaman vii  



 Daftar Isi 

11.1 Koneksi ke Jaringan Internet.................................................................................................97
11.1.1 Melalui kabel LAN.........................................................................................................97

11.1.2 Melalui hotspot atau Wireless LAN...............................................................................98
11.1.3 Melalui modem ADSL...................................................................................................99

11.1.4 Melalui Mobile Broadband............................................................................................99
11.2 Web Browser........................................................................................................................103

11.2.1 Perambah Web Firefox.................................................................................................103
11.2.2 Perambah Web Chromium...........................................................................................104

11.3 Xtreme Download Manager.................................................................................................106
11.4 Pesan Internet Pidgin...........................................................................................................107

BAB 12 Program Utility...................................................................................................................111
12.1 APTonCD.............................................................................................................................111

12.2 Gparted.................................................................................................................................112
12.3 Startup Disk Creator............................................................................................................113

12.4 MultiSystem.........................................................................................................................114
12.5 UNetbootin...........................................................................................................................115

12.6 apt-id....................................................................................................................................117
12.7 AllDeb..................................................................................................................................118

12.7.1 Keuntungan AllDeb......................................................................................................118
12.7.2 AllDeb Webmaker........................................................................................................119

12.7.3 AllDeb Manager...........................................................................................................119
 BAB 13 Program Aksesoris.............................................................................................................121

13.1 Kalkulator............................................................................................................................121
13.2 Tabel Karakter......................................................................................................................121

13.3 Cuplikan Layar....................................................................................................................122
13.4 Penyunting Teks...................................................................................................................123

13.5 StarDict................................................................................................................................123
13.6 Keyboard Virtual..................................................................................................................124

13.7 Penampil Dokumen..............................................................................................................125
BAB 14 Pengenalan Antarmuka Teks..............................................................................................127

14.1 Membuka Antarmuka Teks..................................................................................................127
14.1.1 Membuka Terminal......................................................................................................127

14.1.2 Membuka Virtual Console...........................................................................................128
14.2 Pengenalan Antarmuka Teks................................................................................................128

14.3 Perintah-perintah dalam Antarmuka Teks............................................................................130
14.3.1 Berpindah Folder/Direktori (cd)..................................................................................130

14.3.2 Melihat Isi Folder/Direktori (ls)...................................................................................130
14.3.3 Membuka Berkas.........................................................................................................131

14.3.4 Membuat Direktori (mkdir).........................................................................................131
14.3.5 Menghapus Direktori (rmdir).......................................................................................132

 Halaman viii  



 Daftar Isi 

14.3.6 Menghapus Berkas (rm)...............................................................................................132
14.3.7 Menggandakan Berkas (cp)..........................................................................................133

14.3.8 Memindahkan Berkas/Folder (mv)..............................................................................133
14.3.9 Mengubah Nama Berkas/Folder (mv)..........................................................................134

14.3.10 Mengubah Hak Akses Berkas/Folder (chmod)..........................................................134
14.3.11 Mengubah ID Pemilik / Grup pada Berkas/Folder (chown)......................................135

14.3.12 Membuat Berkas Tar (tar)..........................................................................................136
14.3.13 Kompresi Gzip (gzip).................................................................................................137

14.3.14 Kompresi Bzip2 (bzip2).............................................................................................137
14.3.15 Pencarian Berkas (find)..............................................................................................138

BAB 15 Pengaturan Perangkat Keras...............................................................................................139
15.1 Pengaturan Tampilan...........................................................................................................139

15.2 Pengaturan Printer................................................................................................................140
15.3 Pengaturan Pemindai...........................................................................................................142

15.4 Pengaturan Kartu Wireless LAN.........................................................................................143
15.5 Pengaturan Bluetooth...........................................................................................................144

15.6 Penganalisa Penggunaan Disk.............................................................................................145
BAB 16 Pengaturan Pengguna.........................................................................................................147

16.1 Pengaturan pengguna...........................................................................................................147
16.2 Menambah Pengguna...........................................................................................................147

16.3 Mengganti Gambar Pengguna.............................................................................................148
16.4 Menghapus Pengguna..........................................................................................................149

16.5 Pengaturan Grup..................................................................................................................149
BAB 17 Aksara Nusantara................................................................................................................151

17.1 Mengaktifkan Metode Input................................................................................................151
17.2 Menggunakan Metode Input................................................................................................151

17.3 Teknik Pengetikan................................................................................................................152
17.4 Pengetikan Aksara Nusantara..............................................................................................152

17.4.1 Aksara Bugis................................................................................................................152
17.4.2 Aksara Bali...................................................................................................................152

BAB 18 Content Management System.............................................................................................157
18.1 Web Server...........................................................................................................................157

18.1.1 Web Server XAMPP....................................................................................................158
18.1.2 Fitur Web Server XAMPP............................................................................................159

18.2 Aplikasi CMS.......................................................................................................................160
18.2.1 AhadPOS......................................................................................................................160

18.2.2 JIBAS...........................................................................................................................162
18.2.3 SLIMS..........................................................................................................................163

18.2.4 TCExam.......................................................................................................................166
Daftar Pustaka..................................................................................................................................169

 Halaman ix  



 Daftar Isi 

Ucapan Terima Kasih.......................................................................................................................171
COVER.............................................................................................................................................174

 Halaman x  



 Pendahuluan 

PENDAHULUAN

0.1 Ihwal Buku Ini

Buku ini ditulis dan dikembangkan untuk digunakan pada distro linux Asril OS 6.0 Loka yang 
ditulis dengan mengacu pada Buku Panduan BlankOn Rote yang ditulis oleh :

• Agus Purnomo, Paguyuban Pengguna BlankOn Surabaya, goesspoerr@gmail.com 

• Sokhibi, Sahabat BlankOn Semarang, istanalinux@gmail.com 

• Aries Febrianto, ariesfebrianto@gmail.com 

• Krida Pandu Gunata, kridagoen@pandu32.com 

• Sigid Wahyu Utomo, sigid.wahyu@gmail.com 

• M Andik Rahmawan, mrclimis@gmail.com

0.2 Penulis Lanjutan, Sampul dan Tata Letak

• Asril Marhamah, Pengembang Distro Linux Asril OS, info@asrilos.or.id

0.3 Lisensi

Buku ini menggunakan lisensi Creative Commons Attribution-NoDerivs 3.0 Unported License (CC 
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0.4 Merek Dagang

Seluruh hak cipta dan merek dagang yang digunakan dalam buku ini merupakan hak cipta atau
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© 2018, Tim Pengembang Asril OS
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BAB 1 Apa itu Linux dan Asril OS

1.1 Apa itu Linux? 

Kata Linux saat ini semakin banyak didengar  oleh pecinta Teknologi Informasi dan Komunikasi
(TIK) di  seluruh dunia  termasuk di  Indonesia.  Saat  ini,  Linux telah  menjadi  salah  satu  sistem
operasi  yang banyak digunakan di  berbagai  kalangan,  seperti  kalangan bisnis,  pendidikan,  dan
pemerintahan. Hal ini disebabkan oleh Linux yang bersifat terbuka dan merdeka. Siapapun bisa
mengembangkannya dan menggunakannya secara bebas. 

Linux merupakan  kernel  atau  dasar  dari  sistem operasi  yang pertama kali  ditulis  oleh  seorang
mahasiswa  Finlandia  bernama  Linus  Benedict  Torvalds pada  tahun  1991.  Hasil  karyanya
dilisensikan  secara  bebas  dan  terbuka  (Free  Software)  sehingga  siapa  saja  boleh
mengembangkannya. 
Kemudian Richard Stallman, seorang aktivis perangkat lunak pendiri Free Sofware Foundation
(FSF) berniat untuk menggabungkan Linux ke dalam proyek sistem operasinya yang bernama GNU
(GNU  is  Not  Unix).  Karena  pada  saat  itu,  proyek  GNU  sama  sekali  belum  selesai
mengimplementasikan kernel sistem operasi. Akhirnya, dengan dirilisnya kernel Linux, terjadilah
perkawinan antara peralatan (tools) yang dibuat oleh proyek GNU dengan kernel Linux yang dibuat
oleh  Linus  Torvalds,  sehingga  menghasilkan  sistem operasi  baru  bernama GNU/Linux,  sebuah
sistem operasi  yang mirip  dengan  UNIX.  Kesemua komponen dari  sistem operasi  GNU/Linux
dilisensikan berdasarkan lisensi yang disebut  GNU General Public License (GPL) yang ditulis
sendiri  oleh  Richard  Stallman.  Lisensi  ini  memungkinkan  setiap  orang  untuk  secara  bebas
mengembangkan bahkan menjual Linux dengan syarat semua pengembangan  yang telah dilakukan
harus juga dipublikasikan kepada umum. 

Pada  perkembangan  selanjutnya,  Linux  juga  dipaketkan  dengan  perangkat  lunak  lain  untuk
keperluan tertentu seperti server, desktop, perkantoran, internet, multimedia, dan lain-lain sehingga
menjadikannya apa yang disebut dengan distribusi Linux atau yang sering dikenal dengan istilah
distro Linux. Karena sifat Linux yang terbuka, siapapun bisa memaketkan Linux dengan perangkat
lunak pilihannya dengan cara pemaketan masing-masing untuk membuat distribusi Linux. 
Saat ini, banyak sekali terdapat distro-distro Linux yang memiliki segmen pasar, fitur, kelengkapan
dan  cita  rasa  yang  berbeda.  Anda  bisa  melihat  semua  distribusi  Linux  yang  ada  melalui  situs
http://www.distrowatch.com atau  distribusi  Linux  lokal  Indonesia  melalui  situs
http://omahbiasawae.com/distrolokal/. Distro Linux juga bisa disebut sebagai sistem operasi atau
operating  system (OS)  karena  sudah  memiliki  perangkat  lunak  untuk  melakukan  operasi  pada
komputer. 

Linux  pada  awalnya  berkembang  di  lingkungan  server,  karena  Linux  sangat  handal  dalam hal
kestabilan sistem. Namun, dengan semakin pesatnya dunia perangkat lunak terbuka, Linux kini juga
merambah ke dunia desktop. Perkembangan sangat pesat ini tidak lepas dari peran para sukarelawan
yang berjasa dalam menyumbangkan ide dan tenaganya untuk mengembangkan Linux. 

1.2 Kelebihan Linux

Sebagai suatu sistem operasi,  Linux secara umum memiliki berbagai kelebihan dan kekurangan
daripada sistem operasi lainnya. Berikut adalah kelebihan dari Linux : 

• Linux  bisa  didapatkan  secara  bebas  tanpa  perlu  membayar  lisensi.  Anda  juga  bisa
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mengunduh kode sumber Linux jika ingin melihatnya tanpa ada batasan apapun. 
• Linux memiliki koleksi perangkat lunak tersendiri  yang sangat lengkap untuk keperluan

laptop, desktop dan server. Jika perangkat lunak yang tersedia terasa kurang, Anda dapat
menambahkannya dengan mudah melalui repository yang tersedia. 

• Linux sangat stabil karena jarang sekali crash maupun hang. Anda juga tidak perlu bahkan
tidak pernah melakukan restart jika melakukan konfigurasi sistem. 

•  Linux lebih aman terhadap virus, karena selain jumlah virus di Linux sangat sedikit. Linux
juga sangat ketat dalam hal pengelolaan keamanan. 

• Perbaikan  kutu  (bug)  atau  cacat  yang  terdapat  di  Linux  sangat  cepat,  karena  Linux
dikembangkan secara komunitas dan setiap komunitas bisa memberikan masukan-masukan
dan perbaikan untuk kutu atau cacat tersebut. 

Apapun yang memiliki  kelebihan pasti  memiliki  kekurangan,  karena pada hakikatnya apa yang
diciptakan oleh manusia  tidak akan pernah sempurna.  Berikut  adalah berbagai  kekurangan dari
Linux : 

• Linux kurang memiliki  dukungan  dari  produsen perangkat  keras  dalam hal  penyediaan
perangkat lunak pengendali (driver). Hampir semua perangkat lunak pengendali yang saat
ini  ada  di  Linux   merupakan  hasil  jerih  payah  komunitas,  dan  sebagian  kecil  murni
dukungan dari produsen perangkat keras. 

• Linux masih kurang didukung oleh beberapa pembuat permainan. Kebanyakan permbuat
permainan  masih  menggunakan  sistem  operasi  Microsoft  Windows  sebagai  platform
mereka. 

1.3 Apa itu Asril OS?

Asril OS merupakan Distro Linux Lokal Indonesia yang berisikan perangkat lunak (software) yang
dapat  digunakan  untuk  keperluan  desktop,  laptop  dan  notebook.  Asril  OS  dilengkapi  dengan
berbagai pernak-pernik khas Indonesia, distro ini cocok digunakan untuk pengguna komputer di
Indonesia.

Asril OS dikembangkan oleh Asril Marhamah bersama Tim Pengembang Asril OS. Asril OS bisa
didapatkan oleh siapa saja tanpa perlu membayar untuk mengunduhnya. Pengembangan Asril OS
dimaksudkan sebagai  distribusi  alternatif  dalam menggunakan perangkat  lunak yang bebas  dan
legal.  Asril  OS  menawarkan  lingkungan  kerja  dengan  Desktop  Cinnamon  yang  mudah  dalam
penggunaan  yang  dilengkapi  dengan  Program  Office,  Desain  Grafis,  Multimedia,  Pendidikan,
Islami, Internet dan lain-lain.

1.4 Asal nama Asril OS

Asril OS, kalau dibaca bersambung menjadi asrilos. Frase asrilos terdiri dari dua kata yakni asri dan
los. Menurut Kamus Besar Bahasa Indonesia Asri yang berarti Indah dan los berarti bebas, lepas.
Maka digunakanlah semboyan "Indah, bebas, lepas" untuk distro yang sederhana ini. Asril OS bisa
juga  diartikan  sebagai  Distro  Linux  yang  dikembangkan  oleh  Asril  Marhamah,  sekaligus
memberikan identitas pada yang membuat distro linux ini.

1.5 Fitur Asril OS 6.0 Loka

Asril OS secara bawaan sudah terpasang banyak sekali program yang siap pakai untuk keperluan
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sehari-hari. Bila perlu, Anda bisa memasang program lain dari katalog yang tersedia. Adapun fitur-
fitur Asril OS 6.0 Loka secara umum adalah sebagai berikut: 

1. Menggunakan kernel Linux versi 4.13.0-37-generic dengan dukungan perangkat keras yang
sangat banyak.

2. Menggunakan Desktop Environment Cinnamon versi 3.6.6
3. Perangkat lunak untuk keperluan Anda berkomputer, seperti keperluan perkantoran, desain

grafis, multimedia, pendidikan, islami, internet, dan lain-lain. 
4. Tersedia antarmuka menggunakan Bahasa Indonesia, sehingga bisa lebih dimengerti oleh

orang awam, 
5. Sudah  menyertakan  dukungan  format  multimedia  yang  lengkap,  seperti  untuk  memutar

mp3, DVD, dan format lainnya, 
6. Menggunakan tema dan tampilan grafis yang intuitif dan ramah pengguna ( user friendly). 
7. LibreOffice  untuk  keperluan  perkantoran  yang  sangat  mirip  dan  kompatibel  dengan

Microsoft Office, dilengkapi dengan banyak Clip Art, palet (template) dan ekstensi.
8. GIMP dan Inkscape untuk kebutuhan grafis, 
9. Peramban web Google Chrome dan Mozilla Firefox untuk mengakses situs Internet, 
10. Program islami Minbar, HadisWeb, Zakat Kalkulator, Ayat, SalafiDB, Alfanous, Elforkane,

Zekr, Hijri Applet dan sebagainya.
11. dan masih banyak lagi perangkat lunak lainnya 

1.6 Info Lebih Lanjut

Info lebih lanjut mengenai Asril OS ini, anda dapat mengunjungi :

1. https://www.asrilos.or.id/ web resmi Asril OS
2. https://www.facebook.com/AsrilOS Fans Page resmi Asril OS

3. http://asril-os.sourceforge.net  / SourceForge Page resmi Asril OS
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BAB 2 Memasang Asril OS

Bab ini akan membahas bagaimana cara memasang Asril OS pada komputer. Pemasangan Asril OS
akan sangat mudah dilakukan apabila anda sudah memahami persiapan dan langkah-langkah apa
saja yang perlu dilakukan. 

2.1 Kebutuhan Sistem

Sebelum melakukan pemasangan, terlebih dahulu komputer anda harus memenuhi syarat spesifikasi
minimal agar Asril OS bisa berjalan dengan lancar. Berikut ini adalah spesifikasi minimal untuk
Asril OS 6.0 Loka : 

1. Prosessor dengan arsitektur i386 (dapat bekerja pada prosessor 32-bit dan 64-bit).
2. Memori RAM 512 MB (direkomendasikan 1 GB untuk lebih baik).

3. Kartu video atau VGA minimal memiliki resolusi 800x600 (direkomendasikan 1024 x 768). 
4. Harddisk dengan ukuran 10 GB (direkomenasikan 25 GB, lebih besar lebih baik).

5. Dukungan DVD Drive atau USB Port.

2.2 Cara Mendapatkan  Asril OS

Untuk mendapatkan DVD Asril OS, anda bisa mengunduh file ISO-nya dari web resmi Asril OS.
Berkas ISO tersebut selanjutnya di burning ke DVD kosong menggunakan aplikasi pembakar CD /
DVD seperti  Brasero,  K3b,  Nero,  Roxio,  dsb.  Bagi  anda  yang  memiliki  koneksi  terbatas  atau
bahkan tidak memiliki internet sama sekali,  jangan khawatir.  Untuk mendapatkannya anda bisa
membeli DVD Asril OS dengan memesannya kepada kami, untuk info selengkapnya silahkan cek di
web resmi Asril OS.

2.3 Persiapan Menjelang Pemasangan

Sebelum melakukan pemasangan  Asril OS lakukan beberapa persiapan seperti berikut: 
1. Persiapkan  DVD  Asril  OS  sebagai  bekal  proses  pemasangan,  baca  kembali  sub  bab

sebelumnya  untuk  mengetahui  cara  mendapatkan  DVD Asril  OS,  pastikan  DVD dalam
keadaan baik agar proses pemasangan lancar. 

2. Backup atau buat cadangan dari data penting anda ke media penyimpanan cadangan (seperti
Flashdisk, Harddisk, CD/DVD) agar data anda aman dan terhindar dari resiko kehilangan. 

3. Tentukan skema partisi harddisk yang anda inginkan. Partisi merupakan bagian ruang-ruang
data yang terdapat pada harddisk. Jika anda ingin melakukan dual-boot (terdapat dua sistem
operasi dalam satu komputer),  anda harus membuat partisi baru pada harddisk komputer
yang nantinya  akan digunakan sebagai  tempat  pemasangan Asril  OS.  Pembahasan lebih
lanjut akan dijelaskan pada sub bab pemasangan. 

4. Pastikan untuk menjaga kestabilan tegangan listrik. Hal ini untuk menghindari listrik yang
tiba-tiba padam pada saat pemasangan dan menyebabkan terjadinya kerusakan fisik pada
komputer (terutama harddisk). 

5. Lakukan penyetelan BIOS agar komputer membaca CD/DVD terlebih dahulu untuk proses
booting.  Silahkan  merujuk  ke  manual  komputer  atau  motherboard  anda  mengenai  cara
melakukan penyetelan ini. 
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2.4 Persiapan Partisi

Sebelum mulai pemasangan, terlebih dahulu persiapkan partisi kosong untuk yang akan digunakan
sebagai tempat pemasangan Asril OS, misal di Windows, anda mempunyai drive C, dan D. salin
data yang ada di drive D ke media lain (flashdisk, external harddisk, atau harddisk lain). Drive D
akan kita gunakan sebagai tempat instalasi Asril OS. Jika anda mempunyai drive C, D, dan E, anda
bisa memindahkan data di drive E ke drive D, lalu drive E yang akan kita gunakan untuk instalasi
Asril OS. Jika semua bagian harddisk sudah terpartisi, anda bisa memotong partisi harddisk terakhir
dengan langkah berikut ini: 
Peringatan!  Jika  partisi  tersebut  merupakan  partisi  windows,  lakukan  terlebih  dahulu
defragmenting  melalui  tools  “Disk  Defragmenter”  yang  terdapat  di  sistem  operasi  Microsoft
Windows. Hal ini untuk menghindari partisi yang rusak pada saat melakukan pemotongan partisi. 

1. Buka aplikasi editor partisi melalui Menu  > Preferensi > Gparted (Editor Partisi). 
2. Pada baris partisi yang ditampilkan, klik kanan pada partisi terakhir (yang paling kanan),

lalu pilih menu [>Ubah Ukuran/Pindahkan?<]. 

3. Tentukan ukuran baru dari partisi yang anda potong pada opsi [>Ukuran Baru (MiB)<].
Kemudian klik tombol [>Ubah Ukuran/Pindahkan?<]. 

4. Terakhir,  klik  tombol  [>Terapkan<]  pada  toolbar  untuk  menerapkan  perubahan  yang
dilakukan. 

Sekarang anda telah memiliki partisi kosong yang bisa anda manfaatkan untuk memasang Asril OS.

2.4.1 Catatan Mengenai Partisi

Partisi Primary /Primer

Jenis  partisi  ini  merupakan jenis  partisi  utama diharddisk  untuk system operasi  pada
umumnya. Partisi primer hanya bisa dibuat maksimal 4 partisi,  hal ini sangat berbeda
dengan sistem DOS yang hanya mengijinkan satu jenis partisi primer untuk sistem. Jika
kita memakai sistem operasi Linux jenis partisi ini akan terbaca sebagai partisi 1, 2, 3 dan
4. Misalnya terbaca sebagai sda1, sda2, sda3 dan sda4, sedangkan jika kita menggunakan
Sistem Operasi Windows akan terbaca sebagai partisi C,D,E dan F. 
Partisi Extended /Perluasan

Merupakan partisi perluasan untuk mengatasi kekurangan partisi primer dimana hanya
dimungkinkan adanya 4  partisi.  Jika  ingin  memiliki  partisi  lebih  dari  4  maka  partisi
extended /perluasan dibutuhkan yaitu dengan cara mengorbankan satu jenis partisi primer
kemudian digunakan sebagai partisi extended /perluasan.Didalam partisi perluasaan ini
nantinya  dibuat  partisi  logical  untuk  mendapatkan  partisi  yang  lebih  banyak.  Partisi
extended  tidak  dapat  digunakan  menyimpan  data.  Partisi  jenis  ini  selalu  menempati
nomor partisi +1 dari partisi primer. Misalnya ada 2 jenis partisi primer di harddisk sda1
dan sda2, maka posisi partisi extended adalah sda3. 
Partisi Logical

Jenis  partisi  logical  selalu  dibuat  didalam partisi  extended  /perluasan.  Jika  kita  lihat
sepintas maka nomor partisi akan akan lompat 1 nomor. Misalnya kita membuat 5 jenis
partisi logical di sda3 maka masing-masing akan terbaca sebagai sda4, sda5 dan sda7,
sda8 dan seterusnya. 
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2.5 Memasang Asril OS Melalui Live DVD

Untuk pemasangan melalui Live DVD, anda harus mempersiapkan Live DVD Asril OS. Masukkan
DVD tersebut ke dalam CD/DVD-ROM drive pada komputer anda.  Restart komputer anda dan
anda akan melihat menu awal dari Live DVD Asril OS, tekan tombol Enter untuk masuk ke modus
Live DVD atau tunggu 10 detik, maka Distro Asril OS akan mulai dijalankan melalui DVD.

Tunggu sebentar sampai proses booting selesai. (Apabila diminta nama pengguna gunakan nama
pengguna  live tanpa password). Setelah proses booting selesai, maka anda akan melihat desktop
Asril OS. Anda bisa mencobanya terlebih dahulu sebelum memasangnya ke harddisk.
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Untuk melakukan pemasangan Asril OS, klik ganda ikon Pasang Asril 6.0 yang ada di desktop atau
klik  Menu Utama > Preferensi  > Pasang Asril  6.0.  Dan kemudian sebuah wahana pandu akan
membantu  Anda  dalam  pemasangan  Asril  OS.  Jika  berjalan  dengan  baik,  maka  anda  akan
mendapatkan tampilan selamat datang seperti gambar berikut ini.

Pilih  bahasa yang akan digunakan dalam PengInstalan (Standar Bahasa Indonesia).  Setelah itu,
lanjutkan dengan menekan tombol "Lanjutkan",  maka anda akan mendapatkan tampilan bersiap
memasang seperti tampak pada gambar berikut ini.

Disini, anda akan diberi pilihan apakah akan menyambung ke Jaringan Nirkabel (jika ada) atau
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tidak. Abaikan saja, langsung tekan tombol “Lanjutkan” lagi untuk melanjutkan, maka anda akan
mendapatkan tampilan seperti gambar berikut.

Untuk melanjutkan, langsung tekan aja tombol "Lanjutkan" untuk ke tahap berikutnya, maka anda
akan mendapatkan tampilan seperti pada gambar berikut ini.

Pada  tahap  ini,  anda  akan  diberi  pilihan  untuk  Jenis  Instalasi.  Catatan* Komputer  yang  saya
gunakan untuk Instal memiliki Sistem Operasi Asril OS 3.0 Serri yang terInstall, jika anda memiliki
hal yang beda, mungkin anda akan mendapatkan tampilan yang berbeda pula. Pada panduan ini
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Jenis Instalasi yang dipilih yakni "Hapus diska dan pasang Asril OS" karena kita akan memasang
Sistem Operasi Asril OS secara otomatis. Jika sudah yakin, silahkan lanjutkan dengan tekan tombol
“Pasang Sekarang” maka anda akan mendapatkan peringatan seperti tampak pada gambar berikut.

Disini  anda  mendapatkan  peringatan,  apakah  akan  menghapus  seluruh  harddisk  beserta  semua
datanya  kemudian  membuat  partisi  baru  secara  otomatis.  Catatan* dengan  cara  ini,  pastikan
komputer  anda sudah tidak  ada data,  karena  semuanya akan  terhapus.  Jika  anda tidak  yakin
dengan cara ini,  anda dapat menggunakan cara yang terakhir “Sesuatu yang lain” kemudian
membuat partisi anda secara manual. Jika sudah yakin, silahkan tekan lanjutan, untuk melanjutkan
ke tahap selanjutnya, maka anda akan mendapatkan tampilan seperti gambar berikut.

Silahkan pilih lokasi anda (atau biarkan saja secara default)  dan lanjutkan ke tahap selanjutnya
dengan menekan tombol "Lanjutkan", maka anda akan mendapatkan tampilan konfigurasi keyboard
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seperti tampak pada gambar berikut.

Silahkan pilih  konfigurasi  KeyBoard yang anda gunakan (atau biarkan saja  secara default)  dan
lanjutkan ke tahap selanjutnya dengan menekan tombol "Lanjutkan", maka anda akan mendapatkan
tampilan konfigurasi Pengguna seperti tampak pada gambar berikut ini.

Silahkan masukkan Nama Anda, Nama Komputer Anda, Tentukan Nama Pengguna dan kata sandi
anda, serta pilihan untuk LogIn,  ini sebagai Profil  Pengguna anda. Setelah selesai, lanjutkan ke
tahap selanjutnya dengan menekan tombol "Lanjutkan",  maka anda akan mendapatkan tampilan
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Slide Show (ubiquity) dari Sistem Operasi Asril OS, seperti tampak pada gambar berikut ini.

Dan apabila Proses Instalasi  telah selesai,  maka akan ada pemberitahuan bahwa Instalasi  sudah
selesai, seperti tampak pada gambar berikut ini. Anda dapat terus menggunakannya secara Live atau
merestar  komputer  anda  dan  mencoba  menggunakan  hasil  Instalasi  anda,  seperti  tampak  pada
gambar berikut ini.

Selamat. Instalasi Asril OS ke dalam HardDisk anda telah berhasil. Anda dapat menggunakannya
seperti biasanya anda menggunakan komputer anda.

Untuk mencoba hasil Instalasi anda apakah berhasil atau tidak? Restart komputer anda dan pada
pilihan Boot pertama pilih HardDisk yang sudah anda Install Asril OS 6.0 Loka didalamnya tadi.
Jika berhasil, anda akan mendapatkan tampilan Desktop Asril OS, seperti tampak pada gambar 3.1.

Note : Pada Pemilihan Jenis Isntalasi anda bisa memilih sesuai dengan kebiasaan anda atau sesuai
dengan yang anda ketahui, ini untuk menghindari hal-hal yang tidak diinginkan. Kami tidak

bertanggungjawab apabila anda mengalami kehilangan data atau kerugian lainnya sehubungan
dengan buku panduan ini. Selalu BackUp data penting anda untuk keamanan.
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BAB 3 Desktop Asril OS 6.0 Loka

Asril OS menyediakan lingkungan kerja atau desktop environment yang sangat mudah digunakan
bernama Cinnamon. Desktop ini juga sangat sederhana, namun sangat lengkap dari sisi fitur. Pada
bab ini, dijelaskan mengenai pengenalan bagian serta pengaturan pada desktop Cinnamon yang ada
di Asril OS untuk keperluan bekerja sehari-hari. 

3.1 Bagian-bagian Desktop

Saat komputer dinyalakan, Anda akan masuk ke dalam sistem Asril OS. 

Desktop Asril OS terdiri dari dua bagian utama, yaitu Area Kerja dan Panel. Area kerja merupakan
tempat  dimana  jendela-jendela  program  ditempatkan  serta  ikon-ikon  desktop  ditampilkan.
Sedangkan panel berisikan menu utama, ikon-ikon dan objek yang membantu Anda dalam bekerja.

3.2 Tombol Menu Utama

Menu Utama dari desktop Asril  OS terdiri dari beberapa menu Panel yang siap Anda gunakan,
menu  Panel  ini  terdiri  dari  berbagai  kategori,  seperti  Perangkat  Lunak  Islami,  Aksesoris,
Pendidikan,  Grafik,  Internet,  Perkantoran,  Suara  &  Video,  Preferensi,  dan  Administrasi.  Untuk
membuka suatu program, silahkan pilih pada menu yang anda kehendaki, kemudian klik program
yang akan dibuka. Menu Administrasi untuk membuka beberapa peralatan yang digunakan untuk
mengatur  sistem yang berhubungan dengan perangkat  keras,  menu Preferensi  untuk melakukan
pengaturan desktop maupun pengaturan sistem. Program Favorit di panel sebelah kiri. Menu Utama
ini ditandai dengan ikon logo Asril OS yang terletak di pojok kiri bawah desktop Asril OS.
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3.3 Jam dan Tanggal

Kadang kala Jam dan tanggal di notifikasi tidak sesuai dengan dengan keadaan yang ada, untuk
melakukan pengaturan Jam dan tanggal tersebut, lakukan langakh berikut ; klik Notifikasi jam dan
tanggal tersebut lalu pilih Pengaturan Tanggal dan Waktu atau bisa juga melalui  Menu Utama >
Preferensi > Pengaturan Sistem pada sub menu Preferensi pilih “Date & Time”, pada jendela yang
ada.  Silahkan  pilih  mau  “Gunakan  waktu  jaringan”  atau  mengaturnya  secara  manual  <untuk
mengatur secara manual, silahkan buka kunci-nya dan masukkan password anda kemudian sesuai
dengan keinginan anda.
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3.4 Daftar Jendela dan Notifikasi

Bilah  ini  berisi  daftar  program yang terbuka pada  suatu area  kerja  terletak  di  sebelah  kiri  dan
menampilkan notifkasi program yang sedang aktif terletak di sebelah kanan.

3.5 Pojok Interaktif

Asril OS secara default menyediakan dua buah area kerja yang bisa Anda gunakan. Jika sebuah area
kerja penuh, Anda bisa berpindah ke area kerja lainnya dengan memanfaatkan “pojok interaktif”
dengan mengarahkan mouse pointer anda ke pojok kiri atas desktop. Anda dapat menggeser suatu
jendela dari suatu area kerja ke area kerja lainnya dengan cara klik dan tahan program tersebut
kemudian seret ke tujuan area kerja lainnya.

3.6 Bekerja dengan Program

Untuk membuka suatu program pada Asril OS, Anda bisa membukanya dengan klik Menu Utama.
Program  yang  berada  di  dalam  menu  tersebut  dikelompokkan  berdasarkan  jenisnya,  yaitu  :
Perangkat  Lunak  Islami,  Aksesoris,  Pendidikan,  Grafik,  Internet,  Perkantoran,  Suara  &  Video,
Preferensi, Administrasi, Tempat dan Berkas Terkini. Jadi, Anda bisa lebih mudah mencari program
yang  ingin  Anda  buka.  Untuk  membuka  Menu  Utama,  anda  bisa  menggunakan  Tombol  WIN
(jendela) yang ada di keyboard anda.

3.7 Menambahkan Menu Program pada Panel

Anda dapat menambah atau mengurangi Program yang sering dipakai pada panel bagian bawah
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sesuai dengan keinginan. Anda bisa  melakukannya dengan meng-klik kanan program yang akan
anda  masukan  ke  dalam  Panel  bawah,  kemudian  pilih  opsi  tambahkan  ke  panel,  untuk
menghapusnya klik kanan pada program tersebut menggunakan Tetikus  kemudian pilih “Buang”.

3.8 Mengunci Layar

Jika Anda hendak meninggalkan komputer dalam keadaan hidup dan Anda tidak ingin komputer
diutak-atik oleh orang lain, Anda bisa mengunci layar komputer Anda. Sehingga, jika ingin kembali
bekerja  dengan  desktop,  Anda  harus  kembali  memasukkan  sandi  Anda  terlebih  dahulu.  Untuk
melakukan  hal  ini,  Anda  bisa  mengaktifkan  fitur  kunci  layar  dengan  memilih  Menu  Utama
kemudian  pada  panel  sebelah  kanan  pilih  “Kunci  Layar”  (lihat  pada  gambar  3.2)  atau
menggunakan tombol pintas dengan menekan tombol Ctrl+Alt+L pada papan ketik Anda.

Pada  kondisi  terkunci  monitor  komputer  akan  menampilkan  tanggal  dan  waktu  dengan  latar
belakang desktop, kalau sudah lama menjadi hitam (blank). Jika ingin mengaktifkan desktop, geser
mouse atau tekan sembarang tombol di keyboard, lalu masukkan sandi Anda kembali.

3.9 Pengaturan Latar Belakang

Anda bisa melakukan pengaturan penampilan melalui fitur yang sudah disediakan melalui Menu 
Utama  > Preferensi > Pengaturan Sistem pada sub Penampilan pilih “Latar Belakang”

 Halaman 18  

3.6 Layar Terkunci



 Desktop Asril OS  

Pada edisi kali ini, ada dua jenis pemilihan Latar Belakang yang dapat anda gunakan. Anda dapat
menggunakan walpaper tunggal atau live walpaper (walpaper berganti-ganti sesuai dengan waktu
yang  telah  ditentukan).  Untuk  walpaper  tunggal,  silahkan  pilih  gambar  yang  sesuai  dengan
keinginan anda, dengan meng-klik langsung gambar yang anda inginkan, sedangkan live walpaper,
silahkan  pilih  folder  gambar  sesuai  dengan  keinginan  anda  dan  jangan  lupa  aktifkan  “Play
backgrounds  as  a  slideshow”  pada  bagian  “Pengaturan”,  silahkan  tentukan  waktu  yang  anda
inginkan. Jika anda merasa kurang puas dengan gambar yang ada, anda dapat menambahkannya
dengan mudah, dengan klik tombol “+” yang ada di pojok kiri bawah. Segera setelah pengaturan
selesai, Anda bisa melihat langsung perubahannya. Pengaturan lebih lanjut dengan klik “Pilihan
Lanjutan” yang ada di sebelah kiri bawah, silahkan pilih “Aspek Gambar” dan “Gradasi” yang anda
inginkan.

3.10 Pengaturan Informasi Pribadi

Untuk melakukan pengaturan informasi pribadi seperti nama, foto, kata sandi dan sebagainya untuk
disimpan oleh sistem, Anda bisa membuka pengaturannya melalui  Menu Utama > Administrasi >
Pengguna dan Grup. Silahkan masukkan password anda.
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Pada jendela akun pengguna, Anda bisa memberi informasi pribadi Anda yaitu : 
✔ Gambar

✔ Jenis Akun

✔ Nama

✔ Kata Sandi

✔ Grup

Untuk mengganti informasi tersebut klik pada nilai saat ini dan selanjutnya bantuan petunjuk 
panduan akan dimunculkan. 

3.11 Mengakhiri Sesi

Untuk mengakhiri sesi bekerja Anda di Asril OS tanpa mematikan komputer, Anda bisa klik Menu 
Utama pada panel sebelah kiri pilih “Keluar” (lihat pada gambar 3.2). Terdapat lima perintah yang 
bisa Anda jalankan, yaitu : 

3.12 Mematikan Komputer

Untuk mematikan komputer, Anda bisa klik Menu Utama pada panel sebelah kiri pilih “Berhenti” 
(lihat pada gambar 3.2). Terdapat lima perintah yang bisa Anda jalankan, yaitu : 
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✔ Suspensi

✔ Hibernasi > Untuk mematikan komputer tanpa perlu mengakhiri sesi Anda. Sesi di memori 
akan disimpan ke Harddisk dan akan dikembalikan jika komputer kembali dihidupkan.

✔ Hidupkan Ulang > Untuk mengakhiri sesi, mematikan komputer dan menghidupkannya lagi.

✔ Batal > Untuk membatalkan

✔ Matikan > Untuk mengakhiri sesi dan mematikan komputer.
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BAB 4 Menggunakan Perambah Berkas

Untuk melakukan manajemen berkas pada komputer, Anda dapat menggunakan aplikasi perambah
berkas  yang  bernama  Nemo.  Bab  ini  menjelaskan  mengenai  cara  menggunakan  Nemo  untuk
keperluan manajemen berkas sekaligus mengenalkan konsep manajemen berkas yang ada di Asril
OS. 

➢ TIP:  Bagi  Anda yang familiar  dengan produk  Microsoft Windows,  Nemo ini  memiliki
fungsi yang sama dengan Windows Explorer. 

4.1 Menggunakan Nemo

Untuk melakukan pengelolaan berkas menggunakan Nemo sangatlah mudah. Bagi Anda yang sudah
biasa  menggunakan  Microsoft  Windows  tidak  akan  mengalami  kesulitan  karena  yang  berbeda
hanyalah penampakannya saja (menu dan bahasa saja yang berbeda). Cara menyalin dan menempel
berkas  dan  atau  direktori,  menyeleksi  direktori  atau  berkas  tidak  berbeda  antara  Asril  OS dan
Windows. Demikian pula membuat direktori,  mengganti nama direktori atau berkas, menghapus
direktori atau berkas juga sama dengan Windows. Membuka  berkas atau direktori yang ada di
Nemo pun sama dengan Windows yaitu  dengan klik  ganda.   Misalkan kita  hendak menghapus
direktori atau berkas, kalau menggunakan tombol  Delete berkas atau direktori akan dipindah ke
direktori tempat Sampah (Recycle Bin kalau di Windows) tetapi jika menggunakan menggunakan
tombol  Shift+Delete berkas  atau  direktori  akan  benar  –  benar  dihapus.  Untuk  membuka  File
Manager Nemo, pilih Menu Utama > Aksesoris > Files. Anda juga bisa menggunakan menu pintas
dengan  menakan  tombol  WIN  (Jendela)  +  E,  seperti  yang  biasa  anda  lakukan  di  Microsoft
Windows.

 Halaman 23  

4.1 Nemo



 Menggunakan Perambah Berkas  

Berikut adalah folder yang ada Home Direktori Anda :
✔ [  Dokumen  ] merupakan direktori di dalam direktori  beranda yang diperuntukkan untuk

menyimpan dokumen. 
✔ [  Musik  ]  merupakan  direktori  di  dalam  direktori  beranda  yang  diperuntukkan  untuk

menyimpan musik. 
✔ [  Gambar  ]  merupakan direktori  di  dalam direktori  beranda  yang diperuntukkan untuk

menyimpan gambar atau foto. 
✔ [  Video  ]  merupakan  direktori  di  dalam  direktori  beranda  yang  diperuntukkan  untuk

menaruh video. 
✔ [  Unduhan  ]  merupakan direktori  di  dalam direktori  beranda yang diperuntukkan untuk

menaruh berkas unduhan. 

Direktori-direktori tersebut tidaklah mutlak. Direktori tersebut sudah disediakan demi kenyamanan
Anda. Pada kenyataannya Anda (sebagai pengguna biasa) dapat membuat direktori sebanyak yang
Anda inginkan dan di mana saja asal di dalam direktori beranda.

4.2 Hirarki Partisi

Di Asril OS, Anda tidak akan mengenal istilah  drive seperti pada Microsoft Windows. Direktori
paling atas yang ada di sistem adalah direktori  /  atau  root  yang merupakan isi partisi sistem. Di
dalam direktori / terdapat berbagai subdirektori yang memiliki fungsi masing-masing, yaitu : 

✔ [ /bin ] menyimpan binari atau program yang sangat penting untuk sistem. 

✔ [ /boot ] menyimpan data-data yang diperlukan untuk melakukan booting sistem 
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✔ [ /cdrom ] merupakan titik kait/mount point jika Anda memasukkan CD/DVD-ROM. 

✔ [ /dev ] menyimpan informasi yang bertautan dengan piranti keras yang terpasang ke sistem.
Biasanya diperlukan untuk merujuk suatu lokasi piranti keras yang ada di sistem. 

✔ [ /etc ] menyimpan konfigurasi sistem berbentuk berkas teks. 

✔ [ /home ] menyimpan data-data yang dimiliki oleh pengguna non-administratif. 

✔ [ /lib ] menyimpan pustaka sistem yang sangat penting. 

✔ [ /media ] tempat untuk mengaitkan perangkat penyimpanan eksternal. 

✔ [  /opt  ] tempat untuk menyimpan berkas-berkas piranti lunak pihak ketiga misal xampp,
adobe reader. 

✔ [ /sbin ] menyimpan binari atau program yang penting untuk melakukan administrasi sistem.

✔ [  /tmp ]  menyimpan berkas-berkas  yang bersifat  sementara.  Bila  Anda sedang memutar
video streaming (youtube, dan lain-lain), berkas video yang dilihat tersimpan disini. Jadi
jika film yang Anda lihat sudah selesai, tinggal salin berkas ke direktori pilihan Anda. Ini
merupakan keuntungan menggunakan Asril OS melihat youtube sekaligus mengunduhnya
tanpa bantuan piranti lunak lain. 

✔ [  /usr ]  menyimpan  berkas-berkas  pendukung  piranti  lunak  yang  terpasang  di  sistem.
Gambar latar (Wallpaper), ikon,  atau berkas suara yang digunakan sistem tersimpan disini. 

✔ [ /var ] menyimpan berkas-berkas yang selalu berubah atau variabel, seperti catatan sistem,
surel pengguna, dan sebagainya. 

4.3 Hak Akses Berkas dan atau direktori

Setiap berkas dan direktori memiliki pemilik serta izin masing-masing. Tidak semua direktori bisa
diakses dan diubah oleh semua pengguna. Hal ini untuk menjaga kestabilan sistem dan menghindari
pengguna yang ceroboh atau sengaja untuk merusak sistem. Pengguna biasa hanya bisa mengelola
berkas  di  dalam  direktori  /home/akunpengguna yang  memang  dimiliki  oleh  pengguna
bersangkutan. Anda bisa membukanya melalui Menu Utama > Tempat pada destop Asril OS. Selain
direktori  tersebut,  pengguna harus  mempunyai  izin khusus  dari  administrator  sistem. Penamaan
berkas  di  Asril  OS  juga  sangat  berbeda  dengan  Windows.  Di  Asril  OS,  penamaan  berkas
memperhatikan huruf besar dan huruf kecil (case sensitive).  Jadi, Anda bisa membuat berbagai
berkas dengan nama yang sama, tetapi dengan derajat huruf yang berbeda. Contohnya, Anda bisa
membuat berkas “Dataku”, “dataKU”, “dataku”, “daTAku”, dan sebagainya dalam satu direktori
tanpa ada konflik. 
Untuk membuka isi partisi selain partisi sistem atau suatu media penyimpanan, partisi yang ingin
Anda buka harus dikaitkan (mounting) ke suatu direktori (umumnya di bawah direktori  /media)
sehingga isi dari partisi atau media penyimpanan tersebut bisa dilihat dan dikelola hanya dengan
membuka  direktori  tersebut.  Jika  sedang  menggunakan  desktop,  Anda  tidak  perlu  melakukan
pengaitan  secara  manual  setiap  ingin  membuka  isi  media  peyimpanan  karena  Asril  OS  sudah
melakukannya untuk  Anda.  Anda bisa  melihat  isi  media  penyimpanan melalui  Menu Utama >
Tempat pada  desktop  Asril  OS.  Hal  unik  lainnya  pada  manajemen  berkas  di  Asril  OS  adalah
pengaturan hak aksesnya yang sangat detail  dan ketat.  Setiap berkas atau direktori  yang ada di
partisi Asril OS memiliki beberapa parameter mengenai hak akses, yaitu: 

 Halaman 25  



 Menggunakan Perambah Berkas  

✔ [  Pengguna  pemilik  berkas/direktori ]  berisi  identitas  pengguna  dari  pemilik  suatu
berkas/direktori. 

✔ [  Kelompok pemilik berkas/direktori  ] berisi  identitas kelompok yang memiliki suatu
berkas/direktori. 

✔ [ Hak akses untuk pemilik ] berisikan hak apa saja yang boleh dilakukan oleh pengguna
pemilik berkas/direktori terhadap suatu berkas/direktori. 

✔ [  Hak  akses  untuk  kelompok  ]  berisikan  hak  apa  saja  yang  boleh  dilakukan  oleh
kelompok pemilik berkas/direktori terhadap suatu berkas/direktori. 

Hak akses untuk yang lainnya, berisikan hak apa  saja yang boleh dilakukan oleh pengguna selain
pemilik dan kelompok selain kelompok pemilik terhadap  suatu berkas / direktori. Setiap objek hak
akses  yang  ada  di  atas  memiliki  tugas  hak,  yaitu:  Baca  (Read),  Tulis  (Write,  dan  Eksekusi
(eXecution). Setiap objek hak akses juga bisa memiliki perpaduan hak yang berbeda, ada yang bisa
dibaca saja,  ada yang bisa dibaca dan dieksekusi saja,  dan ada juga yang memiliki hak mutlak
(baca, tulis dan eksekusi). 

Untuk mengatur hak akses dari berkas / direktori, klik kanan pada berkas / direktori yang ingin
diubah hak aksesnya, lalu klik pada menu Properti. Pada jendela Properti, klik pada tab Izin. 

Berikut adalah penjelasan dari masing-masing pengaturan: 

✔ [ Mengatur pemilik dari berkas / direktori ] Yang hanya bisa mengatur pemilik dari suatu
berkas / direktori adalah administrator. 

✔ [ Mengatur kelompok yang memiliki berkas / direktori ] Yang bisa mengatur bagian ini
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adalah pemilik berkas/direktori tersebut. 
✔ Mengatur hak apa saja yang bisa dilakukan oleh pemilik berkas. 

✔ Mengatur hak apa saja  yang bisa dilakukan oleh pengguna/kelompok pemilik berkas. 

✔ Mengatur hak apa saja yang bisa dilakukan oleh pengguna selain pemilik atau anggota 
kelompok. 

Jika  Anda  mengatur  hak  akses  pada  direktori  beserta  berkas  yang  terdapat  di  dalam direktori
tersebut, Anda dapat mengklik [>Terapkan Hak ke Berkas yang Disertakan<].  Bila sudah selesai,
klik tombol [>Tutup<]. 

4.4 Mengakses Media Penyimpanan Lain

Bila  Anda  memasang  flashdisk  atau  harddisk  eksternal,  isi  flashdisk/harddisk  eksternal  akan
langsung terbuka. Demikian pula bila Anda memasukkan CD atau DVD yang berisi berkas non-
multimedia, isi CD atau DVD akan langsung terbuka. Tetapi jika tidak, Anda dapat membuka media
penyimpanan (flashdisk, CD atau DVD atau eksternal harddisk) dengan mengklik Menu Utama >
Tempat lalu pilih media penyimpanan yang ingin Anda buka isinya.

Jika Anda sudah selesai menggunakan suatu media penyimpanan, Anda dapat melepasnya dengan
mengklik  ikon  di  sebelah  kanan  nama media  penyimpanan  pada  bagian  kiri  peramban  berkas.
Alternatifnya,  klik  kanan  pada  media  penyimpanan  yang  ingin  dilepas  dan  klik  menu
[>Keluarkan<].

4.5 Memampatkan Berkas/direktori

Berkas  termampatkan  berfungsi  untuk  mengelompokkan  bebeberapa  berkas/direktori  menjadi
sebuah berkas  untuk memudahkan proses  backup.  Tidak hanya dikelompokkan,  data  juga  akan
diperkecil ukurannya sehingga sangat cocok untuk pertukaran data. Untuk melakukan arsip pada
Nemo, klik  pada folder  atau  berkas  (bisa juga memilih  beberapa berkas  sekaligus)  yang ingin
dimampatkan, lalu klik kanan dan pilih menu [>Kompres<]. 

Kemudian,  tentukan  nama  berkas  hasil  pemampatan,  lokasi  serta  format  pemampatan.  Format
pemampatan  yang  didukung  antara  lain:  7z,  RAR,  ZIP,  TAR,  TAR.GZ,  dan  lain-lain.  Untuk
melakukan  pengaturan  tambahan  seperti  untuk  menambahkan  kata  sandi,  Anda  bisa  klik  pada
[>Opsi lain<]. Setelah semua pengaturan selesai, klik pada tombol [>Buat<].
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4.6 Format Perangkat USB

Di Linux anda juga dapat melakukan Format Perangkat USB dengan mudah. Tinggal klik kanan
pada FlashDisk / Memori yang akan di Format dan pilih “Format”. Anda juga dapat memberikan
label pada FlashDisk anda tersebut. Tipe yang didukung yakni FAT32, NTFS dan EXT4. Anda juga
dapat melakukannya melalui Menu Utama > Aksesoris > Pemormat Perangkat USB.

4.7 Mencari berkas/direktori

Untuk mencari berkas/direktori yang tidak Anda ketahui tempatnya, Anda bisa menggunakan fitur
pencarian yang sudah terintegrasi  dengan peramban berkas Nemo. Untuk melakukan pencarian,
Anda bisa klik tombol cari pada bagian toolbar Nemo. Kemudian, ketik nama berkas yang ingin
dicari pada kotak yang disediakan, lalu tekan tombol Enter.

Jika menginginkan pencarian yang lain, silahkan  ketik nama berkas yang ingin dicari pada kotak
[>Cari<], dan pilih lokasi pencarian pada [>Lokasi<]. Setelah semua selesai, klik tombol [>Muat
Ulang<] untuk melakukan pencarian lagi.
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4.8 Berbagi direktori melalui Jaringan

Sebelum berbagi suatu direktori ke jaringan, Anda harus memasang paket Samba terlebih dahulu.
Samba merupakan server berbagi berkas yang bisa digunakan antar platform antara lain: Windows,
Asril  OS, Mac OS X,  Solaris,  dan sebagainya.  Cara memasang samba tergolong mudah.  Buka
Nemo lalu pilih direktori yang hendak dibagi. Klik kanan direktori tersebut pilih menu Opsi Bagi-
Pakai. 

Beri centang pada [>Pakai bersama folder ini<] untuk mengaktifkan fitur berbagi direktori dan beri
nama sharing direktori yang akan dimunculkan pada saat mengakses direktori pada kotak teks yang
tersedia. Agar pengakses bisa menulis isi direktori yang terbagi, beri centang pada [>Izinkan orang
lain membuat dan menghapus berkas dalam folder ini<] dan beri centang [>Akses Tamu<] agar
direktori bisa diakses tanpa perlu autentifikasi identitas pengguna dan kata sandi. Setelah semua
selesai, klik tombol [>Buat Bagi-Pakai<]. Pilih [>Tambahkan perizinan secara otomatis<]. Akan
muncul emblem tangan di direktori yang kita bagi pakai. Sekarang, komputer lain di jaringan sudah
bisa mengakses direktori yang Anda bagi.

4.9 Salin File ke FlashDisk

Kalau di Windows anda mengenal istilah “Send to” untuk menyalin file ke FlashDisk. Di Asril OS
ini juga ada fungsi yang sama. Anda dapat melakukannya dengan mudah. Anda tinggal klik kanan
pada file yang akan di salin dan pilih “Salin ke” silahkan pilih direktori tujuan, FlashDisk yang
terpasang akan otomatis akan ditampilkan, sehingga kita dapat menyalin langsung ke FlashDisk
kita.  Mudah kan.  Jika  menyalin  kedalam folder  tertentu,  anda  dapat  memilih “Telusur”.  Selain
untuk menyalin  file,  anda juga  dapat  memindahkan file  dengan cara yang sama,  tetapi  dengan
memilih menu “Pindah ke”.
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Jika  fitur  ini  belum  aktif  di  pilihan  menu,  anda  dapat  mengaktifkannya  dengan  mengetikkan
perintah berikut di Terminal :

gsettings set org.nemo.preferences context-menus-show-all-actions true ↵
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BAB 5 Pasang, Hapus dan Perawatan Perangkat Lunak
Asril  OS  sudah  menyertakan  berbagai  perangkat  lunak  untuk  keperluan  dasar  seperti  Program
Perkantoran, Desain Grafis, Multimedia, Pendidikan, Islami, Internet dll. Namun, jika Anda merasa
kurang dengan perangkat lunak yang sudah terpasang, Anda bisa melakukan pemasangan perangkat
lunak yang Anda inginkan sesuai dengan keperluan. 

➢ INGAT! Pemasangan dan penghapusan perangkat  lunak membutuhkan hak administratif
karena dapat merubah sistem. Untuk itu, yang hanya bisa melakukan hal tersebut hanyalah
pengguna yang memiliki kewenangan administratif. 

5.1 Pengaturan Perangkat Lunak pada Asril OS

Cara pemasangan dan penghapusan perangkat lunak pada Asril OS  sangat berbeda dengan cara
yang ada di sistem operasi  Microsoft  Windows.  Jika pemasangan perangkat  lunak di  Windows
menggunakan sebuah installer atau program pemasang dari masing-masing perangkat lunak, maka
pada  Asril  OS  pemasangan  perangkat  lunak  dilakukan  menggunakan  sistem  manajemen  paket
perangkat lunak seperti pada Distro Linux lainnya. Manajemen paket yang ada di Asril OS bernama
APT. 

Di Asril OS, hampir semua perangkat lunak berasal dari suatu tempat yang bernama lumbung paket
(package repository). APT adalah program yang berfungsi untuk mengunduh (download) paket
yang Anda pilih dari lumbung dan memasangnya di komputer. 
Dengan kata lain,  Anda tidak perlu mengunduh sendiri paket perangkat lunak yang ingin Anda
pasang. Anda hanya perlu menentukan sumber paket atau lumbung paket perangkat lunak tersebut
melalui APT, dan meminta perangkat lunak yang ingin dipasang atau dihapus. Maka APT akan
melakukan  apa  yang  Anda  inginkan  termasuk  mengunduh  paket,  memasang,  pemasangan
konfigurasi, melakukan konfigurasi sistem, pemutakhiran (update) serta penghapusan. 

Lumbung paket bisa berada dari empat sumber, yaitu: 
✔ Server Web 

✔ Jaringan Lokal, misalnya dari server NFS, 

✔ CD/DVD-ROM, 

✔ Folder lokal. 

Asril OS secara bawaan menggunakan lumbung paket dari Ubuntu dan Linux Mint yang berada di
situs masing-masing penyedia lumbung paket tersebut. Lumbung paket ini sudah berisikan berbagai
koleksi perangkat lunak yang lengkap dan siap untuk digunakan. 
Selain lumbung paket tersebut, anda juga dapat menambahkan lumbung paket-lumbung paket yang
lainnya sesuai dengan keinginan anda.

5.2 Pengaturan Lumbung Paket

Untuk melakukan pengaturan lumbung paket APT, Anda bisa klik  Menu Utama > Administrasi >
Synaptic Manajer Paket. Masukkan password anda, setelah Synaptic Manajer Paket terbuka, anda
bisa klik  Pengaturan > Repositori. Berikut adalah cara-cara pengaturan lumbung paket dari setiap
jenis sumber. 
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5.2.1 Lumbung Paket (Internet) 

Jika  Anda  ingin  melakukan  pengaturan  sumber  perangkat  lunak  dari  mirror  resmi
Ubuntu  atau  Linux  Mint, Anda  bisa  klik  Pengaturan  >  Repositori. Pilih  sumber
perangkat  lunak yang  akan diaktifkan,  anda  juga  bisa  menambahkan  repositori  baru
dengan  menggunakan  tombol  “Baru”  yang  ada  disebelah  kiri  bawah.  Kalau  sudah
selesai, silahkan klik “Muat Ulang” untuk memuat ulang sumber lumbung paket.

5.2.2 Lumbung Paket Jaringan Lokal (Intranet)

Beberapa institusi pendidikan dan kantor menyediakan lumbung paket secara lokal yang
bisa  Anda  manfaatkan  untuk  menekan  biaya  penggunaan  bandwidth  internet.  Untuk
memanfaatkannya, silahkan tanya kepada administrator jaringan Anda tentang baris APT
dari  lumbung  paket  termasuk  lumbung  paket  untuk  pemutakhiran  (jika  ada).  Lalu
tambahkan baris APT baru sesuai dengan cara yang dijelaskan diatas. 

Setelah  semua  pengaturan  lumbung  paket  selesai  dilakukan,  klik  tombol  Tutup.
Kemudian  APT akan  meminta  Anda  untuk  mengunduh  informasi  paket  dari  setiap
lumbung paket,  klik  pada tombol [>Muat  Ulang<].  Sekarang,  Anda siap melakukan
penambahan perangkat lunak untuk Asril OS. 

5.3 Memasang dan Menghapus Perangkat Lunak 

Terdapat dua cara untuk melakukan pemasangan dan penghapusan perangkat lunak. Yaitu melalui
fitur manajer paket Synaptic dan melalui antarmuka teks dengan perintah apt-get. 

5.3.1 Manajer Paket Synaptic 

Jika Anda ingin memasang atau menghapus perangkat lunak secara detail,  Anda bisa
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menggunakan  program  Synaptic  yang  bisa  Anda  buka  melalui  Menu  Utama  >
Administrasi > Synaptic Manajer Paket. 

Ketikkan nama program pada kotak pencarian cepat. program ini menampilkan daftar
paket  perangkat  lunak  secara  detail.  Selain  Anda  bisa  menambah  dan  menghapus
program, Anda juga bisa melakukan hal yang sama untuk pustaka sistem yang tersedia.
Untuk menandai paket perangkat lunak yang ingin dipasang, klik kanan pada program
yang hendak dipasang lalu  pilih  menu [>Tandai  untuk Dipasang<].  Sedangkan jika
ingin  menghapus  paket  perangkat  lunak,  klik  kanan  pada  program  lalu  pilih  menu
[>Tandai untuk Dicabut<]. Kadangkala, suatu paket perangkat lunak akan meminta satu
atau  beberapa  paket  perangkat  lunak  untuk  dipasang  (ketergantungan).  Jika  muncul
jendela  yang  menanyakan  hal  tersebut,  Anda  harus  setuju  untuk  menandai  paket
perangkat lunak yang dibutuhkan agar Anda bisa memasang paket perangkat lunak yang
Anda inginkan. 

Untuk  menerapkannya,  Anda  bisa  klik  tombol  [>Terapkan<]  pada  toolbar  dan  klik
tombol [>Terapkan<] pada jendela konfirmasi. Maka APT akan memasang / menghapus
perangkat lunak yang Anda minta. 

5.3.2 Melalui Perintah apt-get 

Menggunakan  perintah  apt-get  sangat  sederhana  sekali.  Anda  cukup  ketikkan  nama
paket perangkat lunak yang ingin dipasang / dihapus, maka APT akan melakukan hal
yang Anda inginkan. Untuk menggunakan fitur ini,  bukalah antarmuka teks misalnya
melalui Terminal dengan Menu Utama > Aksesoris > Terminal.

Pada terminal ketikkan perintah berikut, lalu tekan tombol Enter untuk memasang paket
perangkat lunak (Ubah “namapaket” sesuai dengan nama paket perangkat lunak yang
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hendak Anda pasang). 

asrilmarhamah@PICO-DJH-Model:~$ sudo apt-get install namapaket  ↵

Sedangkan untuk menghapus suatu perangkat lunak, ketik perintah berikut dan tekan
tombol  Enter  (Ingat!  Ubah  “namapaket”  sesuai  dengan  perangkat  lunak  yang  ingin
Anda hapus). 

asrilmarhamah@PICO-DJH-Model:~$ sudo apt-get remove namapaket  ↵

Jika APT meminta pemasangan / penghapusan perangkat lunak yang dibutuhkan oleh
perangkat  lunak yang Anda akan pasang /  hapus,  Anda harus menyetujuinya dengan
menekan tombol Y, lalu tekan tombol Enter. 

➢ TIP: Untuk memasang / menghapus lebih dari satu paket perangkat lunak, Anda
bisa sebutkan lebih dari satu nama paket pada perintah APT yang masing-masing
nama paket dipisahkan dengan spasi. Contohnya, jika ingin memasang perangkat
lunak program Kino dan Audacity sekaligus, Anda bisa ketik perintah berikut. 

asrilmarhamah@PICO-DJH-Model:~$ sudo apt-get install kino audacity  ↵

5.4 Pemasangan melalui Berkas DEB

Selain  melalui  lumbung  paket,  Anda  juga  bisa  memasang  suatu  perangkat  lunak  yang
didistribusikan dalam format berkas DEB. Untuk melakukan instalasi dari berkas paket DEB, Anda
bisa klik ganda pada berkas DEB tersebut melalui peramban berkas, maka akan muncul jendela
yang akan menuntun Anda dalam melakukan pemasangan.
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Pada jendela tersebut, Anda bisa klik tombol [>Instal Paket<]. Maka paket tersebut akan diinstal ke
komputer  bersamaan dengan paket  ketergantungannya,  pastikan anda terhubung dengan internet
untuk memasang paket ketergantungannya. 

5.5 Merawat Sistem

Secara  berkala  setiap  Tim  Pengembang  dari  masing-masing  lumbung  paket  akan  menerbitkan
paket-paket perangkat lunak dengan versi yang lebih baru ke dalam lumbung. Jika komputer Anda
terhubung ke  Internet,  maka keberadaan  paket-paket  baru  tersebut  akan diinformasikan kepada
Anda. Jika Anda mau menerima paket-paket baru tersebut, maka sistem akan dimutakhirkan oleh
APT dengan mengunduh dan memasang paket-paket itu. 

Dengan melakukan pemutakhiran berkala menjadikan sistem Anda terawat karena pada versi baru,
biasanya  telah  dilakukan  pemeriksaan  dan  perbaikan  cacat  yang  telah  diketahui  sebelumnya.
Kadangkala versi baru diterbitkan untuk menutup celah-celah keamanan yang ditemui pada suatu
paket.  Untuk  melakukan  pemutakhiran  sistem,  pastikan  Anda  sudah  mengaktifkan  informasi
pemutakhiran dari lumbung paket pada APT seperti yang sudah dijelaskan sebelumnya. Kemudian,
klik Menu Utama > Administrasi > Pengaturan Pembaruan untuk melakukan pemutakhiran sistem. 

Klik tombol [>Penyegaran<] untuk memeriksa ketersediaan  pemutakhiran.  Jika terdapat  paket-
paket perangkat lunak dengan versi baru, Anda bisa memberi centang paket perangkat lunak yang
hendak  Anda  perbarui.  Untuk  mengunduh  dan  memasang  update,  klik  tombol  [>Instal
Perbaruan<]. Maka APT akan melakukan pemutakhiran pada paket perangkat lunak yang Anda
pilih. 

Selain  cara  yang  dibahas  di  atas,  Anda bisa  melakukan  pemutakhiran  sistem melalui  terminal.
Untuk melakukan hal ini, buka terminal melalui  Menu Utama > Aksesoris > Terminal. Lakukan

 Halaman 35  

5.4 Manajer Pembaruan



 Pasang, Hapus dan Perawatan Perangkat Lunak  

pemeriksaan ketersediaan pemutakhiran dengan mengetik perintah seperti berikut, lalu tekan Enter :

asrilmarhamah@PICO-DJH-Model:~$ sudo apt-get update  ↵

Kemudian, ketik perintah seperti berikut untuk melakukan pemutakhiran paket perangkat lunak,
lalu tekan tombol Enter: 

asrilmarhamah@PICO-DJH-Model:~$ sudo apt-get upgrade  ↵

➢ INGAT! Pastikan Anda terhubung dengan lumbung paket update agar proses pemutakhiran
bisa berjalan dengan lancar.
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BAB 6 Program Perkantoran
Untuk kebutuhan perkantoran, Asril OS menyediakan berbagai program yang siap pakai. Adapun
program Perkantoran yang disertakan pada Asril OS ini yaitu LibreOffice, PDF Chain, xCHM dan
Adobe Reader.

6.1 LibreOffice

LibreOffice merupakan program perkantoran open source yang dapat digunakan dengan bebas dan
didapatkan secara  gratis.  Penggunaan  program ini  sangat  mirip  dengan Microsoft  Office  2003,
sehingga ramah terhadap pengguna yang sudah terbiasa menggunakan program tersebut. 
Pada subbab ini, dijelaskan mengenai penggunaan paket program perkantoran LibreOffice untuk
keperluan pengolahan kata, pengolahan sheet dan presentasi. Diharapkan dengan membaca subbab
ini,  Anda  mampu  menggunakan  program-program  tersebut  untuk  berproduktivitas,  LibreOffice
sudah  berbahasa Indonesia. 

6.1.1 LibreOffice Writer

LibreOffice Writer merupakan program pengolah kata yang merupakan bagian dari paket
program perkantoran LibreOffice. Fitur dan penggunaan program ini sangat mirip dan
setara dengan Microsoft Word. Dalam subbab ini, dijelaskan mengenai pengenalan dan
sedikit penjelasan mengenai LibreOffice Writer. 

Untuk membuka program ini,  klik  Menu Utama > Perkantoran > LibreOffice Writer.
Pada saat pertama kali dibuka, Anda akan melihat sebuah kertas kosong yang siap Anda
gunakan untuk keperluan pengolahan kata.  Jika Anda ingin membuka dokumen yang
telah tersimpan, Anda bisa klik menu File > Open.
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Berikut adalah format dokumen yang didukung oleh LibreOffice Writer :

Open Document Text (Format default yang telah menjadi standar ISO) 
✔ OpenOffice.org 1.x 

✔ Microsoft Word 97/2000/XP/2003 

✔ Microsoft Word 2007 

✔ Rich Text Format 

✔ HTML Document 

✔ Docbook XML 

Pengenalan Antarmuka
Seperti yang dijelaskan sebelumnya, antarmuka dari LibreOffice Writer sangat mirip 
dengan program Microsoft Office Word 2003. Berikut adalah penjelasan dari masing-
masing bagian di dalam program ini : 
1. Baris Menu, menampilkan daftar perintah yang bisa digunakan berupa menu. 

2. Baris   alat  standar,  menampilkan ikon-ikon yang merupakan perintah utama dan
esensial dalam bekerja di LibreOffice Writer, seperti perintah membuat dokumen
baru, membuka , menyimpan, mencetak, membatalkan perintah terakhir, menyalin
dsb.

3. Baris alat pemformatan, menampilkan ikon-ikon serta pengaturan untuk melakukan
format dokumen, seperti pengaturan fonta, jenis huruf, perataan teks, penomoran,
dsb. 

4. Penggaris/ruler, merupakan alat bantu untuk mengukur panjang kertas, margin, serta
jarak tabulasi. 

5. Baris status, menampilkan status dalam bekerja. 

6. Berfungsi menggulung tampilan turun atau naik (vertikal) dan ke kiri atau ke kanan
(horisontal). 
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Selain baris alat  yang ada,  Anda juga bisa menambahkan beberapa baris alat  lainnya
melalui menu Tampilan  > Bilah alat > Baris alat yang ingin ditambahkan. Setiap baris
alat  memiliki  fungsi masing-masing dan sangat  membantu mempercepat Anda dalam
bekerja.  Walaupun  fiturnya  setara  dan  antarmukanya  mirip  dengan  Microsoft  Word.
Namun ada  beberapa  perintah  di  LibreOffice  yang letaknya berbeda.  Berikut  adalah
perbedaan letak menu antara Word 2003 dengan Writer: 

Microsoft Word LibreOffice Writer

File > Page Setup Format > Halaman

Format Font Format > Karakter

Format > Border and Shading Format > Halaman > Bingkai

Format > Tabs Format > Paragraf > Tab

Format > Drop Cap Format > Paragraf > Alur Teks

Insert > Picture > Wordart Baris alat Menggambar > Galeri Fontwork

Insert > Picture > Chart Sisip > Objek > Bagan

Perlu  sedikit  pembiasaan  diri  dan  kesabaran  untuk  melatih  diri  agar  terbiasa
menggunakan LibreOffice jika Anda belum terbiasa. Hal ini bisa Anda lakukan dengan
mencoba - coba mengerjakan suatu naskah dengan LibreOffice jika tidak dalam keadaan
sangat penting. 
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Mengubah Inch menjadi Sentimeter
Biasanya pada komputer  yang  memakai  Antarmuka berbahasa Inggris  untuk ukuran
Penggaris, ukuran Halaman (kertas), ukuran kotak pada table, dll, menggunakan ukuran
Inchi, maka dengan tetap mepertahankan penggunakan ukuran Inchi akan mempersulit
penyutingan  dokumen  yang  dibuat  karena  kita  sudah  terbiasa  menggunakan  ukuran
Sentimeter, untuk merubah ukuran “Inchi” ke “Sentimeter“ lakukan langkah berikut : 

Klik  Perkakas  >  Opsi,  karena  dalam contoh  ini  program perkantoran  yang  sedang
dipakai “LibreOffice Writer” maka arahkan tetikus pada menu LibreOffice Writer klik
tombol panah yang mengarah ke bawah untuk membuka sub menu yang disediakan, klik
“Umum” ubah ukuran Inch menjadi “Sentimeter” kemudian klik “Ok” 

Bekerja dengan Writer
Sebelum mengetik isi dokumen, Anda perlu mengatur terlebih dahulu pengaturan 
halaman pada dokumen meliputi pengaturan ukuran kertas dan margin. Untuk 
melakukan hal ini, klik menu Format > Halaman. 
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Kemudian,  klik  tab [>Halaman<] dan aturlah ukuran kertas  serta  orientasi  dokumen
yang  diinginkan  pada  pengaturan  [>Format  kertas<],  sedangkan  untuk  pengaturan
margin (jarak batas), aturlah pada pengaturan [>Margin<]. Setelah pengaturan selesai,
Anda bisa klik tombol Oke. Sekarang, Anda bisa mengetik dan mengedit isi dokumen
Anda.  Untuk  mempercepat  waktu,  Anda  bisa  gunakan  keyboard  shortcut  berikut  ini
untuk  melakukan  penyuntingan.  Penggunaan  keyboard  shortcut  akan  meminimalisasi
penggunaan mouse. 

Fungsi Keyboard Shortcut

Memblok (memilih) teks 
Copy (menyalin) 

Cut (memotong) 
Paste (menempel apa yang disalin/dipotong) 

Blok semua 
Undo (batalkan) 

Redo (kembalikan apa yang dibatalkan 
dengan perintah Undo) 

Shift+tanda panah kiri/kanan 
Ctrl+C 

Ctrl+X 
Ctrl+V

Ctrl+A 
Ctrl+Z 

Ctrl+Y

Agar dokumen Anda lebih menarik,  tentunya Anda perlu melakukan formatting pada
dokumen sehingga membuat dokumen Anda lebih cantik, elegan dan profesional. Untuk
melakukan hal  ini,  Anda bisa memblok teks  yang ingin diformat  lalu memanfaatkan
toolbar formatting yang terdapat di  bagian atas penggaris.  Selain itu,  Anda juga bisa
memanfaatkan berbagai keyboard shortcut berikut ini :

Fungsi Keyboard Shortcut

Bold (menebalkan) 

Italic (miring) 
Underline (bergaris bawah) 

Double underline (garis bawah ganda)
Hilangkan format 

Heading 1-5 
Rata kiri 

Rata kanan 
Rata kiri-kanan 

Subscript 
Superscript 

Ctrl+B 

Ctrl+I 
Ctrl+U 

Ctrl+D
Ctrl+0

Ctrl+1-5
Ctrl+L 

Ctrl+R
Ctrl+J 

Ctrl+Shift+B
Ctrl+Shift+P

Untuk mengelola berbagai jenis gaya pemformatan, Anda bisa memanfaatkan fitur Gaya
dan pemformatan yang bisa Anda akses melalui menu Format > Gaya dan pemformatan
(F11).  Melalui  fitur  ini,  Anda bisa  mengatur  berbagai  gaya  formatting  untuk  format
paragraf, karakter, halaman, bingkai dan daftar. 
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Jika Anda ingin menggambar bentuk atau objek lainnya, Anda bisa memanfaatkan baris 
alat menggambar yang bisa Anda buka melalui menu Tampilan > Bilah alat > 
Menggambar. Sama seperti toolbar drawing di Microsoft Word, di sini Anda bisa 
menggambar suatu bentuk, menyisipkan gambar, mengatur bayangan dan 3D pada objek.

Untuk menyimpan hasil  pekerjaan anda,  klik menu Berkas > Simpan. Lalu,  tentukan
lokasi penyimpanan berkas serta format berkas yang diinginkan. Kemudian, klik tombol
[>Simpan<]. Anda juga bisa menyimpan hasil pekerjaan Anda dengan menekan tombol
Ctrl+S pada keyboard.

Membuat Tabel
Untuk membuat tabel, Anda bisa klik menu Tabel > Sisip > Tabel atau tombol Ctrl+F12
pada keyboard. Kemudian, tentukan jumlah baris pada pengaturan [>Baris<] dan jumlah
kolom  pada  pengaturan  [>Kolom<].  Jika  ingin  membuat  judul  kolom  berulang  saat
berganti halaman, Anda bisa beri centang pada [>Tajuk<] dan [>Ulangi baris tajuk pada
halaman baru<]. Setelah itu, klik tombol Sisip.
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Jika ingin membuat baris / kolom baru pada tabel, Anda bisa klik kanan pada baris /
kolom yang ingin disisipi, lalu klik menu Baris / Kolom > Sisip. Kemudian, tentukan
jumlah baris / kolom yang ingin ditambahkan serta posisi disisipinya baris / kolom baru
tersebut.  Selain  klik  kanan,  Anda  bisa  lewat  menu  Tabel  >  Sisip  >  Baris  /  Kolom.
Kemudian,  tentukan  jumlah  baris  /  kolom  yang  ingin  ditambahkan  serta  posisi
disisipinya baris / kolom baru tersebut. Setelah itu, klik tombol Oke.
Mungkin Anda perlu menggabungkan beberapa bagian sel pada tabel, untuk melakukan
hal ini, blok pada sel yang ingin digabung lalu klik kanan dan pilih menu Sel > Gabung.
Atau dapat menggunakan menu Tabel > Gabung sel. Sedangkan untuk memecah sel, klik
kanan pada sel  yang ingin dipecah lalu pilih menu Sel > Pisah.  Kemudian,  tentukan
jumlah baris / kolom hasil pisahan sel tersebut, dan terakhir klik tombol Oke. Atau dapat
menggunakan menu Tabel > Bagi sel.   Kemudian,  tentukan jumlah baris/kolom hasil
pisahan sel tersebut, dan terakhir klik tombol Oke. Bagi yang ingin menulis tugas akhir
dengan LibreOffice Writer, kami juga sudah menyertakan buku panduannya yang dapat
anda akses melalui  Menu Utama > Panduan > Panduan LibreOffice Writer.

6.1.2 LibreOffice Calc

Untuk membuat suatu lembar kerja, Anda bisa menggunakan program LibreOffice Calc.
program ini sangat mirip dan memiliki fitur yang setara dengan padanannya, Microsoft
Excel. program ini juga sangat kompatibel dengan berkas yang dibuat dengan Microsoft
Excel.

Memulai Bekerja

Untuk membuka LibreOffice Calc, klik Menu Utama > Perkantoran > LibreOffice Calc.
Beberapa detik kemudian, Anda akan melihat jendela program LibreOffice Calc yang
sangat  mirip  dengan  program Microsoft  Excel  2003.  Untuk  membuka  suatu  lembar
kerja,  klik  menu  Berkas  >  Buka.  Berikut  adalah  format  file  yang  didukung  oleh
LibreOffice Calc : 
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✔ Open Document Spreadsheet (format Default yang telah menjadi standar ISO) 

✔ Microsoft Excel 97/2000/XP, 

✔ Microsoft Excel 2007

 Antarmuka LibreOffice memiliki beberapa bagian, yaitu (dari atas ke bawah) : 
1. Baris Nama, Merupakan Nama dan jenis Berkas yang sedang Aktif. 

2. Baris Menu, menampilkan daftar perintah untuk bekerja berupa menu. 
3. Baris alat standar, berisikan ikon-ikon perintah utama untuk LibreOffice Calc. 

4. Baris alat pemformatan, berisikan ikon-ikon serta pengaturan untuk melakukan 
formatting pada lembar kerja. 

5. Baris formula, berfungsi untuk mengatur formula/rumus pada setiap sel. 

6. Bagian utama, disinilah Anda bekerja untuk membuat lembaran kerja/worksheet.
7. Navigasi lembar kerja, berfungsi untuk berpindah dari suatu sheet ke sheet yang 

lainnya dalam satu buku kerja. 

8. Baris Status,berisi kolom-kolom yang menampilkan berbagai status dari area 
kerja 

Selain baris alat tersebut, Anda juga bisa menambahkan baris alat lainnya melalui menu
Tampilan > Bilah alat > Baris alat yang ingin ditambahkan. Setiap baris alat memiliki
fungsi masing-masing dan berguna sekali untuk mempercepat pengerjaan lembar kerja. 

Bekerja dengan Calc 
Pertama kali dalam membuat lembar kerja, Anda harus membuat terlebih dahulu judul
kolom data pada baris pertama. Jika dibutuhkan, Anda bisa menggabungkan beberapa sel
dengan cara membloknya, lalu memilih menu Format > Gabung Sel. Agar judul kolom /
baris selalu muncul pada setiap halaman yang akan dicetak, Anda bisa mengatur area
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pencetakan  melalui  menu  Format  >  Jangkauan  Cetak  >  Sunting.  Kemudian,  isi
jangkauan dari judul kolom / baris pada bagian [>Kolom / Baris untuk diulang<]. Anda
bisa klik tombol di sebelah kanan kotak teks untuk membantu memilih jangkauan yang
diinginkan. 

Setelah pembuatan judul kolom selesai, Anda bisa mengisi  setiap kolom dengan data
yang ingin Anda buat. Anda bisa tekan tombol F2 untuk mengisi sel yang dipilih. Untuk
membuat suatu data lebih dinamis, Anda bisa memanfaatkan rumus-rumus atau formula
yang  tersedia  sangat  banyak  di  Calc.  Jika  Anda  belum terbiasa  mengetikkan  rumus
secara langsung, Anda bisa klik ikon [>f(x)<] pada baris input (formula) dan mengikuti
arahan  yang  diberikan.  Rumus-rumus  yang  dapat  Anda  gunakan  antara  lain  rumus
perhitungan, statistika, finansial, tanggal dan waktu, logika, matematika, dsb. 

 

Untuk memformat sel agar lebih menarik, Anda bisa blok sel yang ingin diformat, lalu
manfaatkan berbagai perintah pemformatan yang terdapat di baris alat pemformatan (di
atas baris formula). Selain itu, Anda bisa memanfaatkan pengaturan sel yang bisa Anda
akses melalui menu Format > Sel. Keyboard shorcut untuk pemformatan yang dijelaskan
pada penjelasan tentang LibreOffice Writer juga bisa Anda manfaatkan. Jika Anda ingin
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menyisipkan suatu baris/kolom di antara baris/kolom yang sudah diisi, Anda bisa klik
kanan  pada  nomor  baris/kolom,  lalu  klik  menu  Sisip  Baris  /  Kolom.  Anda  bisa
memanfaatkan  seluas-luasnya  jumlah  sel  yang  sangat  banyak  untuk  keperluan
pembuatan data. 

Untuk memisahkan setiap lembar kerja, Anda bisa memanfaatkan fitur lembar kerja pada
Calc. Secara baku, terdapat satu lembar kerja yang bisa Anda gunakan untuk membuat
buku kerja dan bisa Anda ganti melalui navigasi lembar kerja yang terdapat di bagian kiri
scrollbar samping. Untuk menambah lembar baru, Anda bisa klik tanda “+” yang ada
disamping lembar kerja. Sebaliknya, jika Anda ingin menghapus suatu lembar, klik pada
lembar yang ingin Anda hapus, lalu klik menu [>Hapus lembar kerja<].

Salah satu fitur menarik yang terdapat di Calc untuk membantu pengolahan data adalah
fitur pengurutan.  Dengan fitur  ini,  Anda bisa mengurutkan data Anda sehingga lebih
runtun dan berurut. Untuk menggunakan fitur ini, blok pada data yang ingin diurut dan
klik menu Data > Urutkan. Lalu atur skema pengurutan sesuai dengan keinginan Anda. 

Untuk  menyimpan  buku  kerja  yang  Anda  buat,  klik  menu  Berkas  >  Simpan.  Lalu,
tentukan lokasi  penyimpanan berkas serta  format  berkas yang diinginkan. Kemudian,
klik  tombol  [>Simpan<].  Anda  juga  bisa  menyimpan  hasil  pekerjaan  Anda  dengan
menekan tombol Ctrl+S pada keyboard. 

Membuat Bagan
LibreOffice Calc memudahkan Anda membuat bagan, karena telah tersedia wahana 
pandu bagan. Misalkan data yang dibuat telah selesai. 
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Untuk membuat bagan, klik menu Sisip > Bagan pada baris menu. Setelah data yang
dibuat selesai, langkah pertama, pilih jenis dari bagan yang Anda inginkan. 

Pilihlah jenis bagan pada bagian kiri serta kanan. Centang penampilan 3D jika tampilan 
diagram 3 dimensi. Kemudian, klik tombol tombol [>Lanjut<].
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Pada kotak teks [>Jangkauan data<],  tentukan sel  data yang akan dijadikan sumber
data. Anda bisa klik ikon di sebelah kanan kotak teks, lalu memblok sel yang diinginkan.
Setelah itu, tentukan urutan data dengan memilih opsi [>Rangkaian data pada baris<]
jika  data  ada  di  setiap  baris  (memanjang  ke  kanan),  atau  [>Rangkaian  data  pada
kolom<] jika data ada di setiap kolom (memanjang ke bawah). Selain itu,  Anda bisa
memberi tanda centang pada [>Baris pertama sebagai label<] jika ingin baris pertama
dijadikan label data dan/atau memberi tanda centang pada [>Kolom pertama sebagai
label<]  jika  ingin  kolom  pertama  dijadikan  label  data.  Setelah  selesai,  klik  tombol
[>Lanjut<]. 

Langkah ketiga, Anda bisa mengkustomisasi data yang akan ditampilkan pada bagan. 
Jika tidak perlu kustomisasi, klik saja tombol [>Lanjut<].

Langkah terakhir, tentukan judul grafik beserta opsi-opsi lainnya yang diberikan. Bila
Anda  rasa  ada  yang  kurang  pada  pengaturan  bagan,  Anda  bisa  meng-klik  tombol
[>Kembali<]. Kemudian, bila sudah cukup, klik tombol [>Selesai<]. 
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6.1.3 LibreOffice Impress

Untuk  keperluan  membuat  presentasi  professional,  Asril  OS  menyediakan  program
bernama LibreOffice Impress. Program ini memiliki fitur yang lengkap untuk keperluan
membuat  presentasi  dan  tampilannya  pun mirip  dengan  Microsoft  PowerPoint  2003.
Pada  subbab  ini,  dijelaskan  mengenai  pengenalan  program  presentasi  LibreOffice
Impress serta penjelasan singkat mengenai program ini. 

Mulai bekerja

Untuk membuka LibreOffice Impress, klik  Menu Utama > Perkantoran > LibreOffice
Impress. Anda akan melihat tampilan LibreOffice Impress yang mirip dengan Microsoft
Office PowerPoint 2003. LibreOffice Impress mendukung berbagai format, antara lain : 

✔ Open Document Presentation (format default)

✔ Microsoft PowerPoint 97/2000/XP/2003 

✔ Microsoft PowerPoint 2007 

✔ LibreOffice Impress 1.0

Pengenalan antarmuka 
Bagi yang sudah pernah membuat presentasi, antarmuka Impress tidak akan sangat 
asing. Berikut adalah bagian-bagian dari antarmuka LibreOffice Impress: 

1. Baris Nama, Merupakan Nama dan jenis Berkas yang sedang Aktif. 

2. Baris menu, menampilkan daftar perintah Impress berupa menu. 
3. Baris alat standar, menampilkan ikon-ikon perintah esensial untuk dokumen

Anda. 
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4. Baris   alat  pemformatan,  menampilkan  ikon-ikon  atau  pengaturan  untuk
melakukan pemformatan objek yang Anda pilih dalam presentasi. 

5. Daftar slide, menampilkan slide yang terdapat dalam presentasi yang Anda
buat. 

6. Bagian utama, menampilkan dan mengedit isi suatu slide. 
7. Panel tugas, berisi berbagai macam pengaturan yang membantu Anda dalam

mengatur presentasi. Seperti pengaturan tata letak (layout ), palet (template),
animasi, dsb. 

8. Baris alat menggambar, menampilkan ikon-ikon untuk menambah berbagai
objek baru pada suatu slide. 

9. Baris alat Status, berisi kolom-kolom yang menampilkan berbagai status dari
area kerja. 

Anda bisa menambahkan berbagai baris alat tambahan sesuai keperluan dengan cara klik
menu Tampilan > Bilah alat > baris alat yang ingin ditambahkan. 

Bekerja dengan Impress 
Membuat suatu slide presentasi dengan LibreOffice Impress bisa dilakukan langkah per
langkah,  sehingga  Anda  bisa  sangat  mudah  membuat  suatu  presentasi.  Sebelum
mengerjakan isi slide, Anda terlebih dahulu dapat memilih tema dari slide Anda melalui
pengaturan Halaman Induk (master  page)  pada bagian panel tugas.  Jika palet  terasa
kurang, Anda bisa memasang berbagai palet tambahan melalui add-ons yang tersedia di
situs http://www.Libre  o  ffice.  org/ 
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Tata letak atau layout pada suatu slide bisa Anda buat sendiri  dengan memanfaatkan
baris  alat  menggambar,  atau  dengan  menggunakan  layout  yang  sudah  ada  melalui
pengaturan [>Tata Letak<] pada panel tugas. Tentukan tata letak sesuai keinginan, dan
isilah slide Anda. 

Untuk membuat presentasi lebih menarik, Anda bisa menambahkan animasi pada setiap
objek melalui pengaturan [>Animasi Ubahan<] pada panel tugas. Selain itu, Anda juga
bisa memberi animasi pada saat transisi antar slidemelalui pengaturan [>Transisi Slide<]
pada panel tugas.  

Setelah sebuah slide selesai dibuat, Anda bisa membuat slide baru melalui menu Sisip >
Slide. Kemudian, Anda bisa mengerjakan slide baru Anda. Untuk berpindah dari suatu
slide ke slide lain,  klik  pada slide yang diinginkan pada daftar  slide yang terlihat di
bagian  kiri  jendela  program.  Untuk  menampilkan  presentasi,  klik  menu  Pertunjukan
Slide > Pertunjukan slide atau tekan tombol F5 pada keyboard. Jika ingin menyimpan
hasil pekerjaan anda, klik menu Berkas > Simpan. Lalu, tentukan lokasi penyimpanan
berkas serta format berkas yang diinginkan. Kemudian, klik tombol [>Simpan<]. Anda
juga  bisa  menyimpan  hasil  pekerjaan  Anda  dengan  menekan  tombol  Ctrl+S  pada
keyboard. 

6.1.4 LibreOffice Draw

LibreOffice Draw adalah program menggambar yang disertakan dalam paket program
LibreOffice,  jika kita  kurang mahir  menggunakan program Penyunting bitmap/raster
GIMP atau Penyunting vektor Inkscape kita dapat menggunakan program LibreOffice
Draw  untuk  menciptakan  sebuah  karya  gambar  sederhana.  Pada  dasarnya  program
LibreOffice  Draw  adalah  turunan  dari  program  OpenOffice  Drawing  karena
menggunakan  sumber  kode  yang  sama  sehingga  tampilan,  penggunaan  menu  dan
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kurang  lebih  sama seperti  pada  OpenOffice  Drawing.  Untuk  memulai  menggambar
cukup sederhana yaitu dengan meng klik menu-menu jenis objek seperti yang ada di
menu toolbar.

 
Ada banyak pilihan mulai menggambar garis, elips, oval, teks, kurva,konektor, garis
dan panah dan beberapa menu lainnya. setelah memilih salah satu menu tersebut (mis :
oval), klik dan tahan tetikus (mouse) pada lembar kerja dan gerakkan sampai ukuran
yang dirasa cukup dan lepaskan tetikus. anda dapat menyimpan hasil karya anda dengan
format  odg,  atau  langsung  mencetak  menjadi  dokumen  pdf  dengan  memilih  menu
ekspor sebagai pdf. Untuk membuka LibreOffice Draw klik Menu Utama > Perkantoran
> LibreOffice Draw.

Beberapa dokumentasi LibreOffice belum ada di dalam Buku Panduan ini, seperti LibreOffice Base
dan LibreOffice Math.

6.2 PDF Chain

PDF  Chain  merupakan  perkakas  sederhana  untuk  melakukan  manipulasi  sederhana  terhadap
dokumen  PDF.  Dengan  program ini,  Anda  bisa  memutar,  memisah,  menggabungkan,  memberi
background halaman dari dokumen PDF. Anda juga dapat menambahkan halaman dari dokumen
lainnya.  Seperti  aplikasi  penyunting  normal  lainnya,  Anda  harus  menyimpan  perubahan  yang
dilakukan.  Jika  Anda  ingin  menjaga  dokumen  asli  dan  menyimpan  perubahan  menjadi  sebuah
berkas baru, gunakan Simpan Sebagai.  Untuk membukanya klik  Menu Utama > Perkantoran >
PDF Chain masukkan password anda bila diperlukan. Berikut tampilan dari PDF Chain.
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Untuk menambahkan dokumen ke dalam PDF Chain, gunakan tombol “+” yang ada di sebelah kiri
bawah, untuk menghapusnya gunakan “X” dan mengubah urutan dokumen dengan tanda panah atas
bawah. Anda dapat menentukan Concatenate,  Burst, Background / Stamp, Attachment atau Tools
yang  akan  digunakan  pada  dokumen.  Setiap  dokumen  yang  dimasukkan,  akan  menampilkan
halaman,  judul  dan  jumlah  halaman.  Anda  dapat  menentukan  halaman  yang  mana  yang  akan
digunakan.

Setelah semuanya selesai,  anda dapat  mengatur  Permissions dari  dokumen yang akan disimpan
tersebut,  anda  dapat  menentukan  hal  apa  saja  yang  bisa  pembaca  lakukan  terhadap  dokumen
tersebut. Jika sudah selesai, silahkan simpan dengan tombol “Simpan Sebagai”, silahkan disimpan
sesuai dengan lokasi penyimpanan anda. Dikolom nama jangan lupa menggunakan menggunakan
format .pdf dibelakang nama dokumen yang digunakan, kemudian “Simpan”
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6.3 xCHM

xCHM merupakan perkakas sederhana untuk membuka file CHM.Tampilannya cukup sederhana,
untuk membukanya klik  Menu Utama > Perkantoran > xCHM atau bisa juga dengan membuka
langsung file CHM yang ingin anda buka.

6.4 Adobe Reader

Adobe Reader merupakan aplikasi alternatif untuk membuka berkas PDF, karena secara default di
Asril  OS di  atur  ke  program “Xreader (Penampil  Dokumen)”.  Dengan adanya program Adobe
Reader ini,  anda dapat membuka file PDF yang anda miliki  dan mencetaknya dengan berbagai
macam hasil output. Untuk  membukanya klik Menu Utama > Perkantoran > Adobe Reader 9 atau
bisa juga dengan klik kanan pada berkas PDF yang akan anda buka kemudian pilih menu “Buka
Dengan” kemudian pilih program “Adobe Reader 9”, berikut tampilannya.
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BAB 7 Program Multimedia dan Hiburan

Asril OS menyediakan berbagai Program Multimedia dan Hiburan yang bisa menghibur Anda di
saat sibuk bekerja untuk berproduktivitas. Selain itu, ada juga beberapa program multimedia yang
memang didedikasikan untuk mereka yang bekerja di studio musik atau video. 
Asril OS secara default sudah menyertakan codec atau pustaka pemutar format multimedia yang
tertutup seperti  MP3, DVD, WMA, dll.  Jadi,  Anda tidak perlu lagi memasang codec tambahan
untuk memutar format tersebut.

Pengatur volume suara untuk mengatur volume suara secara umum, Anda bisa klik ikon speaker
yang ada di bagian notification area, kemudian mengatur seberapa besar volume suara pada slider
yang disediakan. 

7.1 Brasero

Program ini  mendukung pembakaran CD/DVD dengan berbagai format, yaitu Data, Audio dan
Video. Untuk membuka program ini Klik  Menu Utama > Suara & Video >Brasero.  Pada jendela
utama program Brasero, Anda akan diminta untuk memilih salah satu proyek yang ingin dibuat,
antara lain : Proyek Audio, Proyek Data, Proyek Video, Salin Diska, dan Bakar Salinan.

✔ Proyek audio, membuat CD Audio/Musik tradisional (menggunakan batas waktu 79 menit)
yang bisa diputar di semua pemutar CD/DVD. 

✔ Proyek video, membuat SVCD/DVD untuk keperluan video. 

✔ Proyek data, membuat CD/DVD untuk penyimpanan data. 

✔ Salin diska, untuk menyalin/menggandakan CD/DVD. 

✔ Bakar salinan, untuk membakar berkas cetakan/image CD/DVD ke dalam kepingan 
CD/DVD.
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7.2 VLC Media Player

VLC  Media  Player  merupakan  perangkat  lunak  (software)  pemutar  beragam  berkas  (file)
multimedia, baik video maupun audio dalam berbagai format, seperti MPEG, DivX, Ogg, dan lain-
lain. VLC Media Player juga dapat digunakan untuk memutar DVD,VCD, maupunCD. VLC Media
Player bersifat sumber terbuka (open source) dan tersedia untuk berbagai sistem operasi. Mulai dari
Microsoft Windows, beragam distro Linux, Mac OS, dan beberapa sistem operasi lainnya. 

Salah satu kelebihan yang paling menonjol dari VLC Media Player adalah kelengkapan codec yang
dimiliki. Dengan kata lain, VLC dapat memutar hampir seluruh jenis berkas audio maupun video
yang ada. VLC Media Player adalah program multimedia player yang sangat portabel. Singkatnya,
program ini bisa dipakai untuk memutar berkas multimedia, baik yang ada di komputer, keping CD
atau DVD, hingga untuk streaming di internet. 

Di balik tampilan programnya yang sederhana, pemutar berkas multimedia ini dilengkapi dengan
beragam  fitur  tambahan,  seperti  kemampuan  subtitle,  tag  format,  konversi,  filter,  skin,  dapat
dioperasikan melalui berbagai interface, tersedia dalam bahasa Indonesia, dan masih banyak lagi.
Bahkan, program ini juga bisa dijadikan sebagai server untuk kebutuhan streaming di jaringan lokal
dan internet. Untuk membuka program ini, klik Menu Utama > Suara & Video > VLC media palyer.

Untuk membuka berkas video pada VLC media player, klik menu Media kemudian pilih sumber
file yang akan di putar. Ada beberapa pilihan sumber media yang dapat kita pilih, diantaranya Open
File, Buka Direktori,  Buka Disk, Buka Stream Jaringan dan lain-lain. Ditampilkan juga Tombol
Pintas yang bisa digunakan.
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Sebagai  contoh,  kita  memilih  “Open  File”,  kemudian  pilih  berkas  video  yang  ingin  diputar,
kemudian klik tombol Buka.

Maka file yang ada pilih akan langsung diputar. Sedangkan jika Anda ingin membuka video dari
kepingan CD/DVD, pilih menu Media > Buka Disk. Untuk memulai memutar berkas video yang
dibuka,  klik  tombol  Play.  Sedangkan  jika  anda  ingin  memutar  semua  file  yang  ada  di  suatu
direktori, silahkan pilih menu Media > Buka Direktori.

7.3 Audacity

Audacity  adalah  program yang  memanipulasi  bentuk  gelombang  audio  digital.  Selain  rekaman
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suara langsung dari dalam program, ini impor banyak format file suara, termasuk WAV, AIFF, MP3,
dan Ogg Vorbis. Format PCM dari 8,16,24 dan 32-bit dapat diimpor dan diekspor. Hal yang dapat
dilakukan dengan Audacity yaitu :

1. Potong, Salin, Tempel, Hapus, Diam, Duplikat, Split 

2. berlaku plug-in efek untuk bagian suara 
3. built-in editor amplop volume 

4. spektrogram disesuaikan trek modus tampilan 
5. analisis frekuensi window untuk aplikasi audio analisis 

6. Tingkat pemutaran kustom untuk melacak setiap, yang hidup-resampled dengan tingkat 
Sampel proyek 

7. sederhana untuk operasi menyelaraskan kompleks untuk trek dan kelompok trek

Meskipun Audacity adalah audio editor yang sangat kuat yang bekerja dengan trek jumlah yang
tidak terbatas ukuran hampir tak terbatas, tidak dapat melakukan semuanya. Audacity tidak bisa : 

1. Audacity tidak dapat merekam lebih dari dua saluran sekaligus pada banyak sistem. 
Beberapa dukungan untuk rekaman multitrack termasuk dalam versi 1.2.3, tetapi tidak 
mendukung sistem sangat banyak belum. 

2. Audacity membuka file MIDI, tetapi bukan editor MIDI, MIDI serta fitur yang sangat 
terbatas.

Untuk menjalankan Audacity, klik  Menu Utama > Sound & Video > Audacity. Untuk panduan 
lebih lanjut anda bisa baca buku panduan yang sudah kami sertakan, untuk membukanya klik  Menu
Utama > Panduan > Panduan Audacity

7.4 Cheesee

Cheese  adalah  aplikasi  webcam  yang  terinspirasi  dari  aplikasi  GNOME  Photobooth  untuk
mengambil  gambar dan video dari  webcam. Cheese juga disertai  efek grafis  fancy berdasarkan
gstreamer-backend. Untuk menjalankan Cheese,  klik  Menu Utama > Sound & Video > Cheese.
Berikut tampilan Cheese :
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Untuk  mengambil  foto  tinggal  klik  pada  Ambil  Foto  dan  hasil  foto  akan  tersimpan  di  folder
Gambar. Sedangkan jika kita ingin melakukan rekam video, klik menu Cheese yang ada di pojok
kiri  atas,  kemudian pilih video, bisa juga dengan klik icon foto,  video dan foto banyak. Untuk
pengaturan pilih Cheese > Preferences. Anda juga dapat menambahkan efek dengan klik tombol
Efek.

7.5 Mobile Media Converter

Saat ini menggunakan linux bukan lagi merupakan suatu yang asing atau sulit, linux itu enak dan
menyenangkan dan semua bisa dipelajari dan di dapatkan di linux, termasuk salah satunya adalah
dalam hal  converter  video  atau  audio.  Mobile  Media  Converter  yang memungkinkan kita  bisa
melakukan konversi berbagai jenis format audio video. 
Mobile Media Converter adalah audio gratis dan video converter untuk mengkonversi antara audio
desktop populer dan format video seperti MP3, Windows Media Audio (wma), Ogg Vorbis Audio
(ogg),  Wave Audio (wav),  MPEG video,  AVI, Windows Media Video(wmv),  Flash Video (flv),
QuickTime Video (mov) dan umum digunakan perangkat mobile / ponsel seperti format audio AMR
(amr) dan video 3GP. Ipod / iPhone dan video MP4 PSP kompatibel yang didukung. Selain itu,
Anda dapat menghapus dan menambahkan format baru atau perangkat melalui internet. 

Sudah terintegrasi YouTube downloader yang tersedia untuk di-download langsung dan konversi ke
salah satu format. Anda dapa tmemotong klip Anda untuk pembuatan ringtone atau tujuan lain dan
memotong video Anda untuk menghapus atas / bawah bar hitam atau bagian yang tidak diinginkan
dari gambar. Selain itu, sub judul tertanam dapat dikodekan ke video untuk menonton film atau
acara dengan teks pada perangkat yang tidak mendukung mereka. Akhirnya, built-in DVD ripper
tersedia untuk mengubah DVD Anda sendiri untuk salah satu format yang didukung. Program ini
memiliki  GUI  yang  sangat  mudah  digunakan  dan  sederhana  (Graphical  User  Interface)  yang
membantu bahkan pengguna yang paling amatir.  Anda hanya perlu memasukkan file input atau
hanya drag n drop input file .
Untuk menjalankan Mobile Media Converter klik Menu Utama > Sound & Video > Mobile Media
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Converter. Selanjutnya tampilan awalnya adalah sebagai berikut :

Untuk menambahkan file anda bisa drag n drop atau melalui tombol “+ File” kemudian pilih tempat
penyimpanan  file  yang  akan  di  convert  kemudian  klik  buka,  maka  file  yang  anda  pilih  akan
langsung masuk ke daftar file.

Selanjutnya silahkan pilih tempat penyimpanan output file nya dan menentukan format output nya.
Anda juga dapat menentukan kualitas output nya.
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Setelah semuanya selesai, silahkan konvert dengan klik tombol “Convert”, proses convert berjalan.
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7.6 Radio Tray

Radio  Tray  merupakan  program  untuk  mendengarkan  siaran  radio  dari  seluruh  dunia.  Untuk
membukanya klik  Menu Utama > Sound & Video > Radio Tray, maka radio tray akan terbuka
dengan menampilan icon di Tray Icon.  Untuk memutar radio silahkan klik icon Radio Tray dan
pilih jenis musik kesayangan anda beserta nama stasiun radio nya. Untuk mengatur stasiun radio,
baik menambah atau mengurangi stasiun radio, silahkan pilih Preferensi > Atur Radio. Untuk dapat
mendengarkan radio dengan lancar, pastikan koneksi internet anda lancar, karena ini menggunakan
streaming radio.

7.7 Media Player

Untuk memutar  video selain VLC media player,  Asril  OS juga menyediakan program bernama
Media  Player  yang  tampilannya  mirip  dengan  Windows  Media  Player  yang  ada  di  Microsoft
Windows. Untuk membuka program ini, klik Menu Utama > Suara & Video > Media Player. Untuk
membuka berkas video pada Pemutar Film, klik menu Film > Buka, kemudian pilih berkas video
yang ingin diputar, kemudian klik tombol Tambah. Sedangkan jika Anda ingin membuka video dari
kepingan CD/DVD, klik menu Film > Putar  Disc.  Untuk memulai memutar  berkas video yang
dibuka, klik tombol Putar.
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7.8 OpenShot Video Editor

Menyunting video yang dibuat dengan kreasi sendiri tentu menjadi hal yang sangat menyenangkan 
utamanya ketika kita ingin mengabadikan foto-foto atau video suatu acara. OpenShot Video Editor 
adalah jawaban tepat untuk Anda.
OpenShot  Video Editor  adalah program yang dirancang untuk membuat dan mengedit  video di
GNU/Linux.  Anda  dapat  dengan  mudah  menggabungkan  beberapa  klip  video,  klip  audio,  dan
gambar ke dalam satu proyek, dan kemudian mengekspor video ke berbagai format video umum.
OpenShot adalah penyunting video non-linear, yang berarti setiap frame video dapat diakses setiap
saat, dan dengan demikian klip video dapat berlapis, dicampur, dan diatur dengan cara yang sangat
kreatif. Semua klip video suntingan (pemangkasan, pemotongan, dll ..) bersifat non destruktif, yang
berarti bahwa klip video asli tidak pernah dimodifikasi. Anda dapat menggunakan OpenShot untuk
membuat tampilan foto slide, menyunting home video, membuat iklan televisi dan film daring, atau
apa pun yang bisa Anda impikan. 

Fitur-fitur OpenShot : 
✔ Dukungan untuk banyak format video, audio, dan gambar (berdasarkan FFmpeg)

✔ Integrasi dengan GNOME (dukungan drag dan drop)

✔ Multi trek

✔ Mengubah ukuran klip, pemangkasan, gertakan, dan pemotongan

✔ Transisi video dengan pratinjau real- time (real time preview)

✔ Pencampuran, pelapisan gambar, watermark

✔ Judul palet, pembuatan judul, judul animasi 3D

✔ Ramah terhadap SVG, untuk menciptakan dan memasukan judul dan kredit

✔ Kredit film bergulir

✔ Drag dan drop timeline

✔ Loncatan bingkai, kunci-pemetaan, kunci J, K, dan L

✔ Encoding video (berdasarkan FFmpeg) 

✔ Animasi Bingkai Kunci (Key Frame)

✔ Pembesaran digital zoom klip video

✔ Mengubah kecepatan pada klip (gerak lambat, dll)

✔ Menyeka, lap, lumas, dan menopengi transisi sendiri

✔ Mengubah ukuran dari klip (ukuran frame)

✔ Pencampuran dan pengeditan audio

✔ preset untuk animasi dan tata letak bingkai kunci

✔ Efek Ken Burns (membuat dengan mendulang gambar)

✔ Klip padat warna (termasuk composite alfa)

✔ Dukungan untuk Rotoscoping /  gambar  berurut  Efek  video digital,  termasuk kecerahan,
gamma, warna, abu-abu, kroma kunci (bluescreen / greenscreen), dan lebih dari 40 video
lainnya dan efek audio

Untuk membukanya klik Menu Utama > Suara & Video > OpenShot Video Editor.
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7.9 TV-MAXE

TV-MAXE merupakan inovasi baru untuk menikmati siaran televisi secara streaming. Selain siaran
TV, disertakan juga untuk siaran Radio. Secara default TV-MAXE hanya menyediakan beberapa
siaran internasional dan Romania. TV-MAXE ini cukup mudah untuk digunakan, anda tinggal klik
saluran TV yang ingin anda saksikan. Anda juga dapat menambahkan saluran TV sendiri melalaui
menu TV-maxe > List > Add a TV channel. Untuk mengaksesnya  klik  Menu Utama > Suara &
Video > TV-MAXE. Berikut tampilan utama dari TV-MAXE ini.

Pada bab Multimedia dan Hiburan ini, kami belum menyertakan dokumentasi tentang
pemutar musik Rhythmbox. 
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BAB 8 Program Desain Grafis

Untuk menunjang kebutuhan Desain Grafis, Asril OS telah menyertakan program grafis diantaranya
Inkscape, GIMP, Penampil gambar, Pengelola fotografi Pix, Pemindai Berkas, dan Scribus untuk
desain publishing. Semua program grafis yang ada berfungsi untuk menggantikan program grafis
komersial yang ada di sistem operasi Microsoft Windows Dengan program Legal. Walaupun ada
kemiripan,  ada  beberapa  perbedaan  yang  harus  Anda  ketahui  dan  dikuasai.  Namun  dengan
pembiasaan diri, tidak akan sulit untuk menggunakan program grafis yang ada di Asril OS untuk
berproduktivitas dan berkreatifias. 

8.1 Penampil Gambar

Asril  OS  mendukung  berbagai  format  gambar/fotografi  yang  bisa  Anda  buka  menggunakan
program  Penampil  Gambar.  Untuk  membuka  suatu  gambar/foto,  Anda  bisa  klik  ganda  berkas
gambar/foto yang ingin dibuka pada perambah berkas Nemo. Penampil Gambar dapat digunakan
untuk melihat gambar/foto yang ada di suatu folder. Anda bisa manfaatkan tombol [>Sebelumnya<]
atau [>Selanjutnya<]. Jika ingin melakukan slide show pada gambar/foto, Anda bisa tekan tombol
F5 pada  papan  tik  atau  klik  menu Tampilan  >  Pertunjukan Slide.  Penampil  Gambar  juga  bisa
dimanfaatkan  untuk  memutar  atau  membalikkan  foto.  Untuk  melakukan  hal  ini,  Anda  bisa
manfaatkan tombol putar yang ada di sebelah kanan atas. 

8.2 Pix

Pix adalah program album foto yang mampu mengorganisasi rangkaian foto yang diambil disaat
bersamaan secara otomatis. Selain itu juga terdapat fasilitas penajaman, pemutaran, penghilangan
efek  mata  merah,  pemotongan  gambar,  juga  pengaturan  seperti  bukaan,  saturasi,  tinta,  dan
temperatur.  Dalam pengklasifikasian rangkaian,  Pix  mampu mendeteksi  foto  hingga pertanggal.
Kalau kurang nyaman dengan pengklasifikasian per tanggal,  bisa kita ubah menjadi nama yang
sesuai dengan kejadian saat itu. Terdapat pula fitur slideshow di bagian bawah jendela utama. 
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8.3 GIMP Editor Gambar

Untuk  keperluan  editing  gambar/foto  yang  berbasis  bitmap,  Asril  OS  menyediakan  program
bernama GIMP (www.gimp.org).  Program ini  merupakan salah  satu bagian  dari  paket  program
Grafik. Program ini merupakan program padanan dari penyunting foto terkenal di sistem operasi
Microsoft Windows, yaitu Adobe Photoshop. Jika Anda sudah ahli menggunakan Adobe Photoshop,
menggunakan GIMP tidaklah hal yang sulit yang penting adalah Anda membiasakan menggunakan
program ini.

8.3.1 Memulai program GIMP 

Untuk membuka GIMP, klik  Menu Utama > Grafik > GIMP Editor Gambar. Tunggu
sebentar hingga jendela utama program GIMP muncul. Tidak seperti Photoshop, jendela
GIMP terpisah-pisah  menjadi  tiga  bagian,  yaitu  bagian  toolbox  (kiri),  bagian  utama
(tengah) dan jendela bantu (kanan).  Berbeda dengan Photoshop yang menggabungkan
semua jendela tersebut menjadi sebuah jendela.
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Untuk membuat kanvas baru, klik menu File > New. Kemudian, tentukan ukuran kanvas
serta pengaturan lainnya. Sedangkan untuk membuka suatu gambar/kanvas, klik menu
File > Open dan pilih berkas gambar/kanvas yang ingin dibuka. Format kanvas default
yang  digunakan  oleh  GIMP adalah  XCF.  Untuk  format  lainnya,  GIMP mendukung
format:  GIF,  JPEG,  PNG,  PSD,EPS,  BMP,  dan  ada  puluhan  format  lainnya  yang
didukung. 

Bekerja  dengan GIMP Seperti  yang dijelaskan sebelumnya,  jika  Anda sudah terbiasa
menggunakan program Adobe Photoshop, Anda hanya memerlukan sedikit pembiasaan
untuk menggunakan GIMP karena penampilannya memang di desain semirip mungkin
dengan Adobe Photoshop.
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8.3.2 Manipulasi Foto Dengan GIMP 

Karena jendelanya yang terpisah- pisah, Anda bisa mengatur sedemikian rupa sehingga
semua bagian jendela yang dibutuhkan bisa Anda lihat dan langsung digunakan tanpa
perlu lagi memperlihatkan jendela tersebut. GIMP menyediakan berbagai toolbox yang
berfungsi  untuk  melakukan  pemotongan,  pemindahan  dan  menggambar.  Untuk
mempermudah mengakses toolbox tersebut, Anda bisa menggunakan papan tik shorcut
yang tampil saat ikon di sorot seperti pada gambar.

8.3.3 Keyboard Shortcut

Pada gambar tampak, untuk mengaktifkan Selection Tool  dapat digunakan tombol R.
Dengan pembiasaan, papan tik shortcut ini akan teringat dengan sendirinya. Pengaturan
dari tiap-tiap tool terdapat di bagian bawah ikon-ikon tool. Sebelum membahas fungsi
setiap tool, sebaiknya anda memahami dulu konsep layer dan image. Untuk lebih jelas,
Image : adalah Image adalah gambar, atau dapat juga disebut file tunggal, sedangkan
Layer  :  Jika  Anda membayangkan image  adalah  sebuah kue  lapis,  layer  adalah  tiap
lapisannya  sehingga  jika  layer  diatasnya  berlubang,  maka  akan  kelihatan  layer  di
belakangnya. Image juga dapat dijadikan layer dengan memindahkannya ke image lain.
Jika di photoshop sebuah image dapat di drag ke gambar lain untuk dijadikan layer, di
GIMP haruslah  di  copy  terlebih  dahulu.  Inilah  perbedaan  mendasar  yang  seringkali
membingungkan  pengguna  photoshop.  Beberapa  tools  yang  sering  digunakan  para
desainer akan ditampilkan pada tabel berikut : 
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Fungsi Tombol Keyboard

Rectangle selection tool 
Elipse selection tool 

Free/Glasso? select tool 
Fuzzy/Magic? select tool 

Select by color
Scissors select tool 

Foreground select tool 
Paths tool 

Color picker 
Zoom tool 

Measurement tool 
Move tool 

Allignment tool 
Crop tool 

Rotate tool 
Scale tool 

Shear tool 
Perspective tool 

Flip tool 
Text tool 

Bucket fill tool 
Blend/Gradient? tool 

Pencil tool 
Paintbrush tool 

Erase tool 
Airbrush Tool 

Ink tool 
Clone tool 

Healing tool 
Perspective clone tool 

Burn/Sharpen? Tool 
Smudge tool 

Dodge/Burn? tool 

R
E 

F 
U 

Shift+O 
I 

<tidak ada>
B 

O
Z

Shift+M
M

Q
Shift+C 

Shift+R
Shift+T

Shift+S
Shift+T 

Shift+F 
T 

Shift+B 
L

N 
P 

Shift+E 
A

K 
C 

H
<tidak ada> 

Shift+U
S 

Shift+D 

Ada 33 Tool  dalam toolbox utama ini.  Cukup banyak untuk penggunaan sehari-hari.
Setiap tool akan diikuti dengan beberapa opsi yang otomatis muncul di bagian bawahnya
atau Tool option. Untuk menampilkan jendela dialog layer/lapisan lainnya, klik menu
Windows > Dockable Dialog > pilih sesuai keinginan anda. Silahkan anda menempatkan
dan mengaturnya senyaman mungkin. 

 Halaman 69   



 Program Desain Grafis  

Untuk mempermudah editing,  Anda bisa memanfaatkan fitur  layer/lapisan yang akan
memisahkan setiap objek yang ada di kanvas Anda. Pengaturan layer/lapisan bisa Anda
lakukan melalui toolbox bantu di bagian kanan layar. Dengan membedakan layer/lapisan
dari  setiap  objek,  Anda  bisa  lebih  mudah  memanipulasi  suatu  objek  tanpa  perlu
menganggu objek lainnya. Berbagai menu untuk keperluan manipulasi  gambar secara
keseluruhan dapat ditemukan pada menu Image. Sedangkan untuk memanipulasi suatu
layer/lapisan atau objek yang dipilih, Anda bisa manfaatkan menu Layer. 
Bagi yang ingin bermain-main dengan warna, silahkan manfaatkan menu Colours untuk
melakukan manipulasi warna pada objek. GIMP menyediakan berbagai efek-efek yang
bisa Anda buka melalui menu Filters. Untuk memberi efek pada bagian tertentu, Anda
bisa memilih bagian yang ingin diberi efek dengan menggunakan toolbox untuk memilih
(selection tool atau menekan tombol R pada papan tik), lalu pilih efek yang diinginkan
pada menu Filters. Kemudian, atur pengaturan efek agar sesuai dengan keinginan Anda. 

8.3.4 Lebih Lanjut Dengan GIMP 

Untuk  mempelajari  lebih  lanjut  mengenai  GIMP,  Andabisa  membuka  layar  bantuan
melalui  menu Help > Help.  Jika  ingin membaca bantuan GIMP tanpa perlu  koneksi
internet,  Anda  bisa  menginstal  paket  "gimp-help-en"  (Bahasa  Inggris)  melalui  APT
dengan kata kain melalui perintah di terminal dengan mengetikkan sudo apt-get install
gimp-help-en.  Jika  Anda baru  pertama kali  mempelajari  editing  fotografi,  Anda bisa
mempelajari  dari  banyak  tutorial  GIMP yang  terdapat  di  internet.  Kami  juga  sudah
menyertakan panduan GIMP,  klik Menu Utama > Panduan > Panduan GIMP

8.4 Inkscape 

Inkscape merupakan program penyunting grafis vektor yang secara default sudah terinstal di Asril
OS. program ini adalah padanan dari program penyunting grafis vektor komersial Corel Draw yang
ada di Microsoft Windows.

8.4.1 Memulai Inkscape 

Untuk membuka program Inkscape, klik Menu Utama > Grafik > Inkscape. Tidak lama
kemudian,  jendela  program  Inkscape  akan  dibuka.  Penampilan  dan  tata  letak  dari
Inkscape sangat mirip dengan Corel Draw. Jika Anda sudah terbiasa menggunakan Corel
Draw, menggunakan Inkscape tidaklah menjadi hal yang sulit. 
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Berikut adalah bagian dari program Inkscape :

1. Menu dan command bar, berisi perintah-perintah untuk program Inkscape. 
2. Tool control bar, berisi pengaturan dari objek yang Anda pilih pada kanvas. 

3. Kanvas, disinilah tempat untuk melihat dan mengedit objek-objek pada gambar. 
4. Toolbox, berisi berbagai alat-alat menggambar objek serta alat-alat bantu. 

5. Pallete, berisi pilihan warna yang bisa Anda gunakan untuk mewarnai suatu 
objek. 

6. Status bar, menampilkan status dari program, layer, lokasi kursor serta besaran 
zooming. 

Untuk  membuka  berkas  yang  sudah  tersimpan,  Anda  bisa  klik  menu  File  >  Open.
Kemudian, pilih berkas yang ingin dibuka. Hampir semua jenis berkas grafis didukung
oleh Inkscape, termasuk format dari Corel Draw (*.cdr). 

8.4.2 Bekerja Dengan Inkscape 

Pertama kali bekerja dengan Inkscape, Anda perlu mengatur besar dari ukuran kanvas
yang akan digunakan. Untuk melakukan hal ini, Anda bisa membuka Properti Dokumen
melalui menu Berkas > Properti Dokumen, atau Anda bisa tekan tombol Shift+Ctrl+D.
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Kemudian, tentukan ukuran dari kanvas serta orientasinya yang diinginkan. Jika ingin
menggunakan ukuran Anda sendiri,  Anda bisa melakukan pengaturan pada [>Ukuran
sendiri<].  Sekarang,  Anda  bisa  menggambar  objek  yang  diinginkan  dengan
memanfaatkan toolbox yang berada dikiri jendela program. Anda bisa mengatur bentuk-
bentuk  pada  objek  yang  Anda  buat  sedemikian  rupa  sesuai  dengan  keinginan  Anda.
Untuk mengatur bentuk garis pada objek, Anda bisa klik kanan pada objek dan memilih
menu [>Isi dan Sapuan<]. Maka akan muncul sebuah sidepane di bagian kanan jendela
program yang berisikan pengaturan garis objek. Untuk menyimpan hasil kerja anda, klik
menu Berkas > Simpan. Kemudian, tentukan nama dan letak berkas serta format berkas
yang  akan  digunakan.  Format  berkas  default  yang  digunakan  adalah  SVG  yang
merupakan format universal untuk grafis berbasis vektor.

8.4.3 Mempelajari Inkscape Lebih Lanjut 

Untuk menggunakan Inkscape lebih lanjut, Anda bisa membuka tutorial- tutorial yang
bisa Anda akses melalui menu Help > Tutorial. Tutorial tersebut sangat cocok bagi para
pemula  baik  yang  baru  menggunakan  Inkscape  atau  sama  sekali  belum  pernah
melakukan editing grafis. Jika menginginkan yang lebih referensif, Anda bisa klik menu
Help > Inkscape Manual. Anda memerlukan koneksi internet untuk membuka manual
ini. Kami juga sudah menyertakan panduan Inkscape yang dapat anda akses dengan  klik
Menu Utama > Panduan > Panduan Inkscape
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8.5 Scribus

Scribus adalah sebuah software open source yang digunakan untuk mengatur tata letak atau istilah
kerennya melayout. Software ini awalnya dikembangkan di linux. Bahkan sejak awal musim semi
2001, Scribus menjadi salah satu program desktop utama di lunux. Namun, karena sifatnya yang
open source, jangan kaget jika anda menemukan Scribus untuk Windows, Mac dan lain-lain. Itulah
salah  satu  kehebatan  dari  Software  Open Source.  Selain  itu,  Scribus  juga  sudah diterjemahkan
kedalam lebih dari 25 bahasa.
Pada umumnya Scribus digunakan untuk melayout majalah, koran, newsletter, dan poster. Namun
selain itu Scribus juga bisa digunakan untuk menyusun majalah digital bahkan sampai presentasi
interaktif yang memanfaatkan javascript.

Dengan tampilan Scribus yang user friendly kita bisa menggunakan fitur-fitur seperti yang dimiliki
oleh software publishing profesional lainnya seperti Warna CMYK, Manajemen warna ICC dan
Pembuatan PDF. Untuk membuka program Scribus klik Menu Utama > Grafik > Scribus.

Pada saat  kita  membuka  Scribus,  sebelum memulai  layout,  tentukan terlebih  dahulu  parameter
dokumen yang akan dibuat seperti dokumen layout, size dan lain-lain. Setelah semua parameter
telah selesai di atur, silahkan klik tombol “Ok”, maka anda akan mendapatkan tampilan Scribus
yang sudah siap untuk memulai layout. Kami juga sudah menyertakan panduan Scribus yang dapat
anda akses melalui Menu Utama > Panduan > Panduan Scribus
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8.6 Pemindai Ringkas

Pemindai  Ringkas  merupakan  program  pemindai  berkas  yang  sukup  mudah  untuk  digunakan.
Pemindai  Ringkas  secara  otomatis  mendeteksi  apabila  ada  Scanner  yang  terhubung  dengan
komputer atau laptop kita. Sehingga kita dapat menggunakan Scanner kita dengan mudah. Untuk
menggunakannya klik Menu Utama > Grafik > Pemindai Ringkas.

Untuk menggunakannya, tinggal klik “Scan” maka secara otomatis berkas yang ada di Scanner akan
di  scan  dan  kita  dapat  melihat  tampilannya.  Kita  dapat  melakukan  pengaturan  melalui  menu
“Dokumen” dan kita  bisa memotong hasil  yang didapatkan dari  Scanner,  dengan menggunakan
menu  “Potong”  atau  menyimpannya  dengan  menu  “Simpan”,  dokumen  yang  didukung  hanya
gambar dan pdf.
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8.7 Pinta

Di Sistem Operasi Windows, kita mengenal MS. Paint, sebuah aplikasi sederhana yang digunakan
untuk keperluan mengedit gambar/foto. Di Linux Ubuntu pun kita dapat menggunakan Pinta sebuah
aplikasi  sederhana untuk mengedit  foto/gambar yang boleh dibilang padanan apliklasi  dari  MS.
Paint untuk Linux Ubuntu.
Pinta  adalah  editor  foto  sederhana untuk  Linux dan  lebih  mudah digunakan jika  dibandingkan
dengan Gimp,  namun tetap memiliki  beragam alat  dan fitur  yang dapat  digunakan.  Pinta dapat
digunakan untuk pengeditan yang cepat seperti mengubah ukuran gambar atau menyesuaikan warna
foto,  dan  bisa  juga  untuk  kegiatan  profesional  yang  berhubungan  dengan  layer.  Pinta  adalah
campuran yang baik antara MS Paint dan alat editior gambar profesional lainnya, dalam pengeditan
gambar  sehari-hari  direkomendasikan  untuk  menggunakan  Pinta.  Untuk  menggunakannya  klik
Menu Utama > Grafik > Pinta.
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BAB 9 Program Pendidikan

Asril OS menyediakan beberapa program pendidikan yang sangat cocok untuk anak-anak. Antara
lain Tux Paint, Tux Math, Tux Typing, gCompris, Otodidak, GNU PSPP, Stellarium dan lain-lain.
Dengan adanya program-program pendidikan ini diharapkan distro Asril OS bisa menjadi distro
linux yang disukai dan diminati oleh semua kalangan baik orang dewasa maupun anak-anak. 

9.1 Tux Paint 

Tux Paint adalah program menggambar sederhana yang didesain untuk anak mulai usia tiga tahun
ke atas. Tux Paint adalah program Open Source alias gratis yang dirilis dengan lisensi GNU General
Public License, yang bisa diunduh dan digunakan oleh siapa saja. Untuk mengaksesnya klik Menu
Utama > Pendidikan > Tux Paint.

Dibandingkan  dengan  Paint  bawaan  Windows,  Tux  Paint  memiliki  beberapa  keunggulan
diantaranya tampilan yang menarik, tool gambar dengan banyak pilihan, stempel gambar unik, efek
suara lucu yang menyertai  saat menggambar di kanvas, gambar yang bisa dicerminkan maupun
dibalik, dan cara menyimpan gambar yang sangat mudah dengan sekali klik mouse. 

Disamping itu sudah diterjemahkan ke dalam bahasa Indonesia meskipun belum sempurna. Tidak
hanya anak-anak yang senang bermain Tux Paint bahkan banyak orang dewasa yang menggunakan
karena  kelebihannya  dibandingkan  program Paint  sejenis.  Tux  Paint  bisa  dijalankan  di  sistem
operasi Windows, Linux, Apple Mac OS, bahkan program ini bisa dimainkan pada beberapa seri
handphone. 
Kelebihan dari Tux Paint ini antara lain: 

✔ Sudah tersedia koleksi stempel lengkap dengan penjelasannya, serta beberapa di antaranya
sudah dilengkapi dengan efek suara. 
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✔ Sudah di-internasionalisasi, sehingga menu ikon bisa ditampilkan dengan bahasa indonesia.
sayang paket stempel yang tersedia penjelasannya hanya dalam bahasa inggris, dan belum
dalam bahasa indonesia, meskipun sepertinya bisa dengan mudah kita ubah sendiri. 

Kami juga sudah menyertakan panduan Tux Paint yang dapat anda akses melalui  Menu Utama >
Panduan > Panduan Tux Paint 

9.2 Tux Math 

TuxMath adalah sebuah game arcade yang membantu anak-anak berlatih matematika. Tujuan utama
software ini adalah untuk membuat belajar matematika menjadi efektif dan menyenangkan. Selain
itu pada software ini membantu guru dalam pembelajaran. Siswa lebih mudah memahami tentang
pelajaran matematika. Software yang menarik dan mendorong minat siswa untuk lebih mengetahui
tentang pelajaran matematika. Untuk mengaksesnya klik Menu Utama > Pendidikan > Tux Math.

9.3 Tux Typing 

Tux Typing adalah sebuah game yang dirancang untuk memandu kita bagaimana menggunakan 10
jari kita dengan benar ketika berada di atas keyboard. Bagi yang masih terbiasa menggunakan 11
jari. Untuk mengaksesnya klik Menu Utama > Pendidikan > Tux Typing.
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9.4 GCompris 

GCompris adalah perangkat lunak pendidikan yang berisi berbagai macam kegiatan untuk anak usia
2 sampai 10 tahun. Beberapa kegiatan berorientasi permainan tapi tetap mendidik. Di bawah ini
anda dapat melihat daftar kategori yang berisi berbagai macam kegiatan. Untuk mengaksesnya klik
Menu Utama > Pendidikan > GCompris.

✔ pengenalan komputer: papan ketik (keyboard), tetikus (mouse), berbagai macam penampilan
tetikus, 

✔ aljabar : tabel memori, urutan, tabel pemasukan ganda, mencerminkan gambar, 

✔ ilmu pengetahuan alam: pintu kanal, siklus air, kapal selam, rangkaian listrik 

✔ geografi: menempatkan negara pada peta 

✔ permainan: catur, memori, sambung 4, oware, sudoku 

✔ membaca: latihan membaca 

✔ lain-lain: mengenali jam, teka-teki gambar, menggambar vektor, membuat animasi. 
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Saat ini GCompris berisi lebih dari 100 kegiatan dan masih terus dikembangkan. GCompris adalah
perangkat  lunak  bebas,  yang  berarti  anda  dapat  menyesuaikan  dengan  kebutuhan  anda,
mengembangkannya, dan yang paling penting, berbagi dengan anak-anak di seluruh dunia. 

9.5 Otodidak

Otodidak merupakan program untuk belajar linux mandiri  yang didesain untuk pemula maupun
lanjutan. Program ini didesain dengan tampilan GUI untuk mempermudah bagi yang ingin belajar
linux, tetapi tidak ingin mencobanya secara langsung. Dengan adanya program Otodidak ini, kita
dapat belajar linux dengan mudah dan disertai dengan gambar yang menarik. Program ini didesain
satu untuk semua, yaitu satu program untuk semua pengetahuan dasar linux. Setelah mempelajari
program Otodidak ini, diharapkan anda sudah bisa menggunakan linux dengan baik dan tidak ragu
lagi. Adapun yang ada bisa pelajari dari program Otodidak ini yaitu :

1. Simulator Terminal (Anda bisa belajar Terminal tanpa Terminal). 

2. Kumpulan tutorial instalasi modem di Ubuntu. 
3. Kumpulan penjelasan mengenai Ubuntu semisal kelebihan/kekurangan. 

4. Tabel perbandingan aplikasi Windows dan Ubuntu. 
5. Semua kumpulan pengetahuan Linux bergambar. 

6. Tutorial instalasi aplikasi di Ubuntu. 
7. Tutorial instalasi kodek MP3 di Ubuntu.

8. Kumpulan penjelasan mengenai 5 desktop environment di Linux. 
9. Kumpulan perintah Terminal yang sering digunakan. 

10. Kumpulan trik cepat menggunakan Terminal. 
11. Kumpulan pengetahuan dasar Linux, GNU, Free Software, Open Source, Repositori, dan

cara belajar Linux dalam Bahasa Indonesia dan disertai ilustrasi (didesain dengan Inkscape).

Untuk membuka program Otodidak ini, klik  Menu Utama > Pendidikan > Otodidak. Maka anda
akan melihat tampilan awal Otodidak.
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Menu yang disediakan program Otodidak ini ada dua, yaitu untuk Pemula dan Lanjutan. Kita dapat
memilih sesuai dengan kebutuhan kita. Berikut ini tampilan dari menu Pemula dan Lanjutan.
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9.6 GNU PSPP

PSPP adalah program statistika digunakan untuk menganalisa sampel data dan merupakan sebuah
AOSA (Aplikasi  Open  Source  Alternatif)  untuk  menggantikan  SPSS.  Lebih  dari  itu,  program
sumber terbuka PSPP yang menerapkan lisensi GNU/GPLv3 ini tidak membatasi penggunaan fitur
dan tidak memaksa mendapatkan versi khusus guna mengakses fungsi advance.
Seperti pada SPSS, PSPP dapat digunakan untuk pengujian non-parametric, descriptive statistics
dan  lainnya.  Pemrosesan  yang  dilakukan  PSPP diklaim sangat  cepat  dan  tidak  tergantung  dari
volume data yang di-input. PSPP didukung dengan antarmuka grafis, namun dapat juga dijalankan
via syntax commands. Kecuali itu, penting bagi pengguna yang akan beralih adalah kompatibilitas
data dan berkas PSPP maupun syntax-nya adalah kompatibel dengan SPSS dan PSPP mendukung
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lebih dari  satu miliar  variable  dan kasus.  PSPP juga bisa bertukar  data  dengan aplikasi  seperti
OpenOffice.org, Gnumeric dan software sumber tebuka lainnya. Seperti pada SPSS, sangat mudah
mengimpor data berasal dari sumber lain seperti berkas teks atau berkas spreadsheets.
PSPP mampu mengekspor data ke format berkas atau sistem portable termasuk format ASCII. PSPP
dapat dijalankan dan mendukung sistem operasi Linux, Windows dan Mac OSX. Sebagai format
output data dan grafik tersedia pilihan termasuk PDF, HTML dan ASCII. PSPP juga memproduksi
histograms  dan  aneka  charts  agar  bisa  diragakan  dengan  tampilan  yang  mudah  dimengerti.
Sejatinya PSPP tampil, disamping sangat sedikit perkecualian adalah serupa dengan SPSS. Untuk
membukanya klik Menu Utama > Pendidikan > GNU PSPP. Berikut tampilan utamanya.

9.7 Stellarium

Stellarium  adalah  planetarium  open  source  gratis  untuk  komputer  Anda.  Perangkat  lunak  ini
menunjukkan langit secara realistis dalam 3D, seperti apa yang Anda lihat dengan mata telanjang,
teropong atau teleskop. Program ini telah digunakan di berbagai planetarium. Tinggal set koordinat
anda  dan  mulalah  mengeksplorasi.  Untuk  mengaksesnya  klik  Menu  Utama  >  Pendidikan  >
Stellarium.

9.7.1 Fitur 

Langit 

1. katalog default dengan lebih dari 600.000 bintang 

2. katalog tambahan dengan lebih dari 210 juta bintang 

3. asterisma dan ilustrasi konstelasi-konstelasi 

4. constellations for 15 different cultures 

5. gambar-gambar nebula (katalog Messier lengkap) 
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6. Bima Sakti yang tampak nyata 

7. tampilan atmosfer, Matahari terbit dan Matahari terbenam yang realistis 

8. planet-planet dan satelit-satelitnya 

Antarmuka 

1. zoom 

2. pengendalian waktu 

3. antarmuka dalam berbagai bahasa 

4. proyeksi mata-ikan untuk kubah planetarium 

5. proyeksi cermin sferis untuk kubah ekonomis anda 

6. antarmuka grafis dan kontrol keyboard yang lengkap 

7. kontrol teleskop 

Visualisasi 

1. petak-petak ekuatorial dan altazimuth 

2. kelipan bintang 

3. meteor 

4. simulasi gerhana 

5. simulasi supernova 

6. lansekap yang dapat diganti-ganti,  sekarang dengan proyeksi panorama berbentuk
sferis 

Dapat dikustomisasi 

1. sistem plugin menambahkan satelit buatan, simulasi okular, konfigurasi teleskop dan
lain-lain

2. kemampuan untuk menambahkan objek tata surya dari sumber daring

3. tambahkan objek angkasa anda, lansekap, gambar konstelasi, skrip
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BAB 10 Program Islami

Asril OS sudah menyertakan Program Islami didalamnya, sehingga anda dapat menggunakannya
secara  langsung  dan  aplikasi  islami  yang  ada  diantaranya  Minbar  Prayer  Times,  Hijr  Applet,
Alfanous, Elforkane, Ayat, SalafiDB, Zekr, Hadist Web, Zakat Kalkulator dll 

10.1 Waktu Shalat Minbar

Waktu Shalat Minbar merupakan program yang dapat memberikan informasi tentang waktu sholat
dan peringatan jika telah masuk waktu sholat.  Program ini juga dilengkapi dengan adzan waktu
masuk sholat dan waktu sholat dapat diatur sesuai dengan daerah yang diinginkan. Pada dasarnya
Waktu Shalat Minbar akan berjalan pada saat masuk ke desktop Asril OS, kalau belum silahkan
menjalankan Waktu Shalat Minbar dengan klik  Menu Utama > Perangkat Lunak Islami > Waktu
Shalat Minbar. Berikut tampilan Program Waktu Shalat Minbar.

10.1.1 Mengatur Waktu Sholat di Waktu Shalat Minbar

Agar jadwal waktu sholat sesuai dengan daerah setempat, perlu diadakan pengaturan.
Langkah - langkahnya sebagai berikut : 

1. Buka aplikasi Minbar Prayer Times, klik tombol Preferensi 
2. Akan muncul jendela yang berisi pengaturan Sunting Detil Kota, klik tombol

Cari Kota

3. Pada  kotak  pencarian  ketik  nama  negara  atau  daerah  setempat,  jika
menemukan pilih nama negara atau daerah setempat, klik tombol Terapkan 

4. Jika tidak menemukan daerah yang diinginkan, lanjutkan ke langkah berikut.

5. Cari tahu mengenai lokasi anda, letak Bujur, Lintang, dan Zona Waktu.
6. Jika  sudah ketemu,  masukkan koordinat  tersebut  pada  jendela  seperti  pada

gambar langkah nomor 2.
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10.1.2 Mengatur pengingat Adzan di Waktu Shalat Minbar

Minbar Prayer Times dilengkapi alarm suara adzan untuk menunjukkan telah masuk
waktu sholat, untuk mengaktifkan dan merubah suara adzan dapat dilakukan sebagi
berikut : 

1. Buka aplikasi Minbar Prayer Times, beri tanda pada “Bunyikan Adzan” 

2. Jika ingin merubah suara adzan, pada langkah nomor 2, klik tombol Preferensi,
pilih tab Adzan, arahkan dimana file adzan berada /  tersimpan di komputer
(ingat : file adzan harus berjenis .ogg)

3. Untuk mengatur  pengingat  waktu sholat  akan muncul  pada  waktu  sebelum
waktu sebenarnya, atur di tab Lanjut dengan cara memberi tanda pada “Ya,
beritahukan sebelumnya” 

10.1.3 Melihat Kalender Jadwal Waktu Sholat

Dengan aplikasi Minbar Prayer Times juga bisa melihat jadwal waktu sholat, untuk 
melihatnya ikuti langkah berikut : 
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1. Buka aplikasi Minbar Prayer Times, klik tombol Prayer Calendar 
2. Muncul kalender waktu sholat

10.2 Hijra Applet

Hijra Applet merupakan program kalender Hijriyah yang menampilkan penanggalan Islam yaitu
penanggalan hijriyah. Untuk menampilkannya anda bisa membukanya dengan klik Menu Utama >
Perangkat Lunak Islami > Hijra Applet atau dengan meng-klik icon Hijra Applet yang ada di Tray
Icon di panel.

10.3 Zekr

Mendengar dan melihat tulisannya Zekr seperti kata Dzikir, sedang dzikir kalau yang saya tahu
adalah bacaan yang diucapkan sehabis sholat. Seperti Subhaanallah, Alhamdulillah, Allahu Akbar,
dan Laailaahaillah. 
Yang penting disini fungsinya bukan namanya, Zekr adalah satu aplikasi Mushaf Alquran yang bisa
di sandingkan dengan Murottal.  Sehingga selain kita bisa membaca dan menterjemahkan dalam
bahasa Indonesia kita juga bisa sambil mendengarkan suara para Hafidz sesuai pilihan kita. Aplikasi
yang sangat bermanfaat bagi para pengguna komputer baik dikantor, di rumah, di perjalanan dan di
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mana saja. Zekr sudah dilengkapi dengan suara (reciter) serta terjemahan Bahasa Indonesia. Untuk
membukanya klik Menu Utama > Perangkat Lunak Islami > Zekr.

10.4 Zakat Kalkulator

Kalkulator Zakat merupakan aplikasi sederhana yang dibuat oleh Para Pengembang BlankOn untuk
membantu kita dalam menghitung zakat. Program ini sangat mudah untuk digunakan, anda tinggal
memasukkan nilai-nilai yang diperlukan, setelah selesai tinggal klik tombol “Hitung Zakat” maka
secara otomatis jumlah zakat yang harus anda bayarkan ditampilkan. Hasil yang ditampilkan disini,
hanya sebagai referensi saja, jika anda memiliki cara perhitungan sendiri, silahkan gunakan cara
yang anda yakini. Untuk menggunakannya klik  Menu Utama > Peragkat Lunak Islami > Zakat
Kalkulator.
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10.5 Monajat

Monajat  Applet  adalah program untuk menampilkan Do'a dan Dzikir  yang akan ditampilkan di
Desktop secara berkala.  Selain itu,  Monajat  Applet  juga dilengkapi  dengan jadwal  Shalat  yang
dapat kita atur sesuai dengan daerah tempat tinggal kita. Monajat Applet ini secara otomatis aktif
ditandai dengan adanya icon monajat  applet  di  area notofikasi.  Jika belum ada,  anda juga bisa
membukanya melalui Menu Utama > Perangkat Lunak Islami > Monajat Applet for supplications.

Untuk  melakukan  pengaturan  jadwal  shalat,  klik  kanan icon Monajat  Applet  yang  ada  di  area
Notifikasi dan pilih “Configure”. Anda dapat menentukan auto start, manfaat serta waktu muncul di
tab “Generic”, daerah kita di tab “Location” dan Notifikasi Adzan di tab “Notification”, jika sudah
selesai semua simpan dengan klik tombol “Save”.
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10.6 SalafiDB

SalafiDB adalah perangkat lunak yang berisikan Al-Qur'an, ribuan Hadits dan artikel-artikel salafi.
Dengan dilengkapi fasilitas telusur (search) dan jelajah (browse) seluruh dokumen, SalafiDB insya
Allah akan membantu anda dalam memahami Al-Qur'an dan Assunnah.  Untuk menggunakannya
klik Menu Utama > Peragkat Lunak Islami > SalafiDB.

10.6.1 Fitur-Fitur yang Disediakan

1. Tidak perlu koneksi Internet (indeks disimpan di hardisk anda). 
2. Telusur Al-Qur'an, Hadits dan artikel terpadu.
3. Hasil telusur diurut berdasarkan skor kedekatan (mirip Google). 
4. Telusur Al-Qur'an dengan transliterasi. 
5. Tayangan visual hubungan antar dokumen. 
6. Analisa secara tata-bahasa ayat-ayat Al-Qur'an. 
7. Editor cetak 
8. Jelajah (browse) seluruh isi dokumen (mirip tampilan e-book) 
9. Preferensi tema tampilan tema.
10. Index dan tema update

10.6.2 Isi Indeks (Februari 2011)

1. 6236  ayat  Al-Quran  dalam  versi  Arabic,  transliterasi,  terjemahan  bahasa
Indonesia  dan bahasa Inggris (Dr. M. Taqiud-Din & Dr. M. Khan dan Yusuf Ali).

2. Tafsir Ibnu Katsir (bahasa Inggris)
3. Lebih  dari  5350  (terjemahan  bahasa  Indonesia)  hadits-hadits  dari  Shahih

Bukhari,  Shahih  Muslim,  Bulughul  Maram,  An-Nawawiyyah  dan  Riyadhus
Shalihin. 

4. Lebih dari 3000 artikel dari situs almanhaj.or.id dan situs fatwa-ulama 
5. 20 salafi E-Book dari situs Vila Baitullah dan Maktabah Abu Salma
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10.7 Alfanous

Alfanous (yang berarti Lentera) adalah sebuah perangkat penelusuran ayat Al Qur’an yang maju
lagi canggih. Tidak hanya sekedar menawarkan kecepatan dan ketelitian dalam pencarian teks dari
sebuah ayat. Akan tetapi sekaligus memaparkan berbagai detail informasi yang berkenaan dengan
kata yang dicari dan keterkaitannya dengan ayat lainnya. 
Singkatnya Alfanous bisa disebut “google”nya penelusuran ayat Al Qur’an. Tahun 2012 Alfanous
memenangi Algeria Web Awards kategori religion. Dan pada Mei kemarin kembali meraih predikat
The  Best  Religious  website  dalam Algeria  Web  Awards  2013.  Untuk membukanya  klik  Menu
Utama > Perangkat Lunak Islami > Alfanous.

10.7.1 Keistimewaan Al Fanous

1. Alfanous  adalah  Search  Engine  ,  mesin  penelusur  yang  mengedepankan
kecepatan, ketelitian dan kestabilan, bukan hanya sekedar perangkat pencari ayat
Al Quran .

2. Alfanous adalah Proyek Free Libre Open Source siapapun dapat menggunakan
dan memberikan kontribusinya dalam perbaikan dan pengembangan kode, desain
tampilan, penerjemahan dan kontribusi lainnya.

3. Alfanous dikembangkan menggunakan Bahasa Python, hingga secara independen
dapat dibuat dalam tampilan antarmuka web ataupun desktop Android / Iphone /
Windows phone, ataupun aplikasi facebook / tweeter / G+ dan lainnya

4. Alfanous  adalah  proyek  riset  yang  terus  dikembangkan  dengan  tujuan
terwujudnya kecepatan, keunggulan, dan kestabilan dalam penggunaannya

5. Alfanous adalah aplikasi kaya fitur
6. Alfanous  memiliki  beragam  Interface  dan  mendukung  banyak  platform

(windows, linux, web, smartphone)
7. Alfanous 100% Free alias Gratis untuk digunakan, tidak dikenakan biaya atau

iklan apapun
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10.8 Elforkane

Elforkane merupakan salah satu program Perambah Al-Qur'an yang indah nan elegan. Bagaimana
tidak,  tampilannya  mirip  dengan  Al-Qur'an  cetak,  lebih  simpel  dan  lebih  lengkap  tentunya.
Elforkane sudah dilengkapi dengan tafsir / terjemahan serta memilih suara tartil Al Quran. Dengan
program yang satu ini,  kita  bisa lebih dekat  dalam belajar  Al-Qur'an.  Untuk membukanya klik
Menu Utama > Perangkat Lunak Islami > Elforkane. Berikut ini tampilan utamanya.

10.9 Hadist Web

HaditsWeb adalah Program yang berisi  hadits-hadits,  yang Insya Allah senantiasa diupdate atau
ditambah setiap beberapa waktu tertentu. Sumber yang digunakan sebagai bahan penulisan program
ini berasal dari kitab-kitab hadits yang Insya Allah dapat dipercaya, dan juga dari website-website
Islam lainnya yang didalamnya terdapat pembahasan mengenai hadits.
Bagi  Anda  yang  telah  menggunakan,  mengunjungi  ataupun  mendownload  program  ini,  maka
dimohon dengan sangat agar menyebarkan program ini kepada rekan-rekan muslim dan muslimah
yang  lain.  Semoga  program  ini  akan  lebih  banyak  memberikan  manfaat  kepada  sebanyak-
banyaknya kaum muslimin dan muslimah yang hendak belajar hadits.

Developer HadisWeb menyadari dalam program ini mungkin masih banyak kekurangannya, oleh
karena itu mudah-mudahan masukan yang sifatnya membangun dan positif dari seluruh pengguna
program ini akan semakin menambah penyempurnaan program ini ke arah yang semakin baik serta
informasi yang semakin lengkap. Untuk membukanya klik Menu Utama > Perangkat Lunak Islami
> HadisWeb.
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10.10 Folder Islami

Folder Islami merupakan folder yang berisi beberapa ebook islami yang bisa anda pelajari. Ebook
ini bisa langsung anda buka dengan dobel klik saja. Ebook ini diharapkan bisa menambah wawasan
dan pengetahuan kita tentang islami. Untuk membukanya klik  Menu Utama > Perangkat Lunak
Islami > Folder Islami. Berikut tampilan dari Folder Islami yang berisi beberapa ebook.

10.11 Ayat

Program Ayat merupakan aplikasi islami yang berisi Al-Qur'an yang terintegrasi dengan beberapa
fitur  yang dapat  membantu  kita  dalam mempelajari  Al-Qur'an.  Dalam Program Ayat  ini  sudah
disertakan Terjemahan untuk beberapa bahasa dan disertai juga dengan Tafsir dari beberapa bahasa,
selain  itu,  sudah  disertakan  pula  pilihan  tampilan  seperti  Tampilan  Penuh,  Tampilan  Baca  dan
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Latihan Hafalan.  Anda juga bisa melakukan pencarian dengan menggunakan fasilitas  pencarian
yang sudah disertakan. Anda juga dapat menambahkan Murottal dari berbagai Qori International
untuk mendengarkan lantunan Al-Qur'an dibacakan. Anda dapat menambahkannya baik langsung
dari  aplilasi  atau  mendowloadnya secara  manual  terlebih  dahulu.  Semua sudah disertai  dengan
beberapa pilihan, seperti untuk tampilan anda dapat memilih menggunakan Surat, Ayat, Halaman,
dan Juz. Untuk membukanya klik Menu Utama > Perangkat Lunak Islami > Ayat. Berikut tampilan
dari Program Ayat ini.
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BAB 11 Program Internet

Saat  ini  internet  tidaklah  lagi  termasuk ke dalam kebutuhan tersier  atau  mewah.  Kini,  Internet
menjadi  kebutuhan  yang  sangat  penting  bagi  setiap  orang  untuk  mengakses  informasi  atau
berkomunikasi dengan orang lain di seluruh penjuru dunia. Biaya untuk jaringan Internet sudah
tidak  semahal  seperti  pada  saat  pertama  kali  diperkenalkan.  Bahkan,  beberapa  tempat  umum
menyediakan jaringan hotspot yang kebanyakan bersifat gratis agar Anda bisa mengakses internet
melalui  notebook atau perangkat  lain yang memiliki  fitur  Wi-Fi.  Untuk memanfaatkan jaringan
Internet, Asril OS menyediakan berbagai program yang siap dipakai untuk keperluan Anda internet
seperti peramban web, klien e-mail atau surat elektronik dan pesan instan. 

11.1 Koneksi ke Jaringan Internet

Sebelum berselancar di dunia maya menggunakan Asril OS, tentunya Anda harus menyambungkan
komputer ke jaringan Internet melalui LAN, Wi-Fi, Modem 3G/HSDPA, atau Modem ADSL. 

11.1.1 Melalui kabel LAN

Pada umumnya, tempat-tempat kerja menyediakan jaringan Internet melalui jaringan
kabel (wired). Untuk melakukan koneksi internet melalui kabel, cukup sambungkan
kabel RJ-45 dari jaringan LAN Anda ke LANCard atau NIC yang ada di komputer
atau  laptop  Anda.  Jika  muncul  pesan  bahwa  sambungan  sudah  terjalin  pada  area
notifikasi, berarti komputer telah sukses bergabung dengan jaringan tanpa masalah.
Jika  koneksi  ternyata  gagal,  berarti  tempat  Anda  menerapkan  pengaturan  jaringan
secara manual. Untuk itu, Anda perlu menyetel pengaturan jaringan pada komputer
Anda terlebih dahulu. Untuk melakukan hal ini, klik kanan pada ikon koneksi jaringan
pada  area  notifikasi,  kemudian  klik  menu  [>Pengaturan  Jaringan<].  Pada  tab
[>Kabel<],  klik  tombol  [>Opsi<]  untuk  menambahkan  pengaturan  jaringan  baru.
Maka akan muncul jendela baru untuk membuat pengaturan jaringan baru. Pada kotak
teks [>Nama Sambungan<], ketik nama pengaturan jaringan Anda. Misalnya, nama
jaringan anda : ''Sambunga kabel 1''.
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Anda bisa memberi centang pada [>Menyambung otomatis<] agar pengaturan 
jaringan tersebut langsung diterapkan jika Anda bergabung dengan jaringan kabel ini. 
Kemudian buka tab [>Tatanan IPv4<]. Pada tab ini, pilih opsi [>Atur sendiri<] pada 
metode, kemudian klik tombol [>Tambah<] untuk menambah setting IP jaringan. 
Isilah[>Alamat<], [>Netmask<], dan [>Gateway<] sesuai dengan pengaturan jaringan
di tempat Anda.
Kemudian,  isi  kotak  teks  [>Server  DNS<]  dengan  nomor  IP dari  DNS Server  di
Internet,  apabila  ada  lebih  dari  satu  DNS  Server  bisa  menambahkannya  dengan
dipisah tanda koma (“,”). Anda bisa menanyakan bagaimana pengaturan jaringan di
tempat Anda kepada administrator jaringan di tempat Anda. 

Beri  tanda  centang  pada  Tersedia  untuk  semua  pengguna  jika  Anda  menghendaki
pengguna  lain  dapat  menyambung  dengan  jaringan  ini.  Anda  akan  ditanyakan
password root. Masukkan saja password root  lalu klik Otentikasikan. Setelah semua
pengaturan selesai, klik tombol [>Terapkan<]. 

Untuk melakukan koneksi dengan jaringan kabel dengan pengaturan jaringan yang
baru  dibuat,  klik  pada  ikon  koneksi  jaringan  pada  area  notifikasi.  Pada  bagian
[>Jaringan  Kabel<],  pilih  nama  pengaturan  jaringan  Anda.  Maka  tidak  lama
kemudian akan muncul pesan bahwa jaringan telah berhasil terjalin. 

11.1.2 Melalui hotspot atau Wireless LAN

Saat  ini,  banyak  sekali  terdapat  tempat-tempat  umum  atau  perkantoran  yang
menerapkan jaringan melalui teknologi wireless LAN atau yang sering dikenal dengan
istilah  hotspot.  Dengan  jaringan  seperti  ini,  tidak  perlu  lagi  direpotkan  dengan
penggunaan kabel  karena jaringan ini  menggunakan gelombang microwave seperti
jaringan GSM Handphone. Untuk melakukan koneksi Internet melalui hotspot, sangat
mudah sekali. Jika kartu jaringan tanpa kabel sudah terdeteksi dengan baik oleh Asril
OS, cukup klik pada ikon koneksi jaringan pada area notifikasi, kemudian pada bagian
[>Jaringan Nirkabel<], pilih nama jaringan hotspot yang akan dikoneksikan. Tidak
beberapa lama kemudian, koneksi akan langsung terjalin. 

Jika  ternyata  koneksi  tidak  terjalin,  mungkin  Anda  perlu  melakukan  penyetelan
konfigurasi jaringan secara manual. Untuk melakukan hal ini, klik kanan pada ikon
koneksi jaringan pada area notifikasi, lalu klik menu [>Pengaturan Jaringan<]. Buka
tab [>Nirkabel<]. Pada tab ini, klik pada nama jaringan yang ingin Anda atur yang
diawali  dengan  teks  [>Auto<],  lalu  klik  pada  tombol  [>Ubah<].  Lalu  buka  tab
[>Pengaturan IPv4<]. Pada tab ini, pilih opsi [>Atur Sendiri<] pada bagian method.
Kemudian,  klik  tombol  [>Tambah<]  dan  isikan  [>Address<],  [>Netmask<],  dan
[>Gateway<]  sesuai  dengan  pengaturan  jaringan  hotspot  tersebut.  Setelahsemua
pengaturan  selesai,  klik  tombol  [>Terapkan<].  Sekarang,  Anda  bisa  mengulangi
melakukan koneksi kejaringan hotspot yang sudah Anda atur. Maka tidak akan lama,
koneksi akan terjalin.

>Catatan: Jika kartu jaringan wireless tidak terdeteksi dengan baik, Anda bisa menuju
ke Bab 15 pada subbab tentang konfigurasi kartu WLAN.
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11.1.3 Melalui modem ADSL 

Saat ini, modem ADSL banyak digunakan untuk keperluan Internet melalui jaringan
telepon PSTN. Penggunaan modem ADSL tidak serepot menggunakan ISP berbasis
radio  yang  menjamur  saat  ini,  karena  tidak  perlu  membangun  tower  yang  tinggi.
Cukup mengandalkan jaringan telpon PSTN yang sudah terpasang. Biasanya, modem
ADSL yang  ada  saat  ini  sekaligus  berfungsi  sebagai  router  untuk  jaringan.  Anda
cukup menyambungkan kabel  LAN RJ-45 dari  modem ADSL ke LAN Card pada
komputer,  maka  komputer  akan  langsung  melakukan  koneksi  terhadap  modem
tersebut. Tidak akan lama, koneksi akan terjalin dan Anda bisa mulai ber-internet ria.

11.1.4 Melalui Mobile Broadband

Setelah  Modem Anda  dikenali  oleh  Asril  OS,  sekarang  lakukan  setting  parameter
kartu  sesuai  provider  yang  Anda  pakai.  Pertama-tama,  klik  kanan  ikon  koneksi
jaringan pada area notifikasi, kemudian pilih [>Pengaturan Jaringan<] jika tidak ada
bisa   Klik  Menu  Utama  >  Preferensi  >  Pengaturan  Sistem kemudian  pada  sub
Perangkat keras pilih Jaringan, maka akan keluar tampilan seperti dibawah ini : 
 

Klik tab [>Data Seluler<] pada Jaringan pilih “Tambah Sambungan Baru” maka akan 
keluar Sambungan Data Seluler Baru (pada contoh ini saya memakai HP Extrem 
EVDO)
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Silahkan lanjutkan dengan klik [>Lanjutkan<].

Silahkan pilih Negara atau Wilayah tempat Anda berada karena kita berada di 
Indonesia maka pilih Indonesia (untuk memudahkan pencarian pada Keyboard /Papan 
Ketik tekan huruf I), kemudian klik [>Lanjutkan<].

Selanjutnya pilih nama Operator selular yang Anda pakai, pilih sesuai dengan kartu
yang terpasang pada modem, Jika modem anda GSM maka yang ditampilkan adalah
operator  GSM,  jika  modem anda  CDMA maka  yang  ditampilkan  adalah  operator
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CDMA (jika  tidak  ada  dalam  pilihan  ini  klik  Tak  menemukan  operatorku  dan
masukkan secara manual, tulis nama Provider yang Anda pakai dengan cara manual)
klik [>Lanjutkan<]. 

Maka akan keluar ringkasan dari  seting dial-up sesuai  dengan operator  Anda,  klik
[>Terapkan<] untuk menerapkan pengaturan modem anda. Ini hanya perlu dilakukan
sekali, selanjutnya tinggal klik icon koneksi jaringan dari area notifikasi.

Sekarang  Anda  sudah  bisa  Online  dimanapun  selama  Provider  yang  Anda  pakai
mendapatkan sinyal bagus. Langkah ini bisa anda lakukan apabila modem anda sudah
dikenali dengan baik oleh Asril OS. Tetapi jika modem anda belum dikenali oleh Asril
OS, seperti  modem yang saya pakai ini  (HP Extrem EVDO) anda bisa melakukan
langkah berikut ini.

Silahkan buka Terminal (Menu Utama > Aksesoris > Terminal atau klik icon Terminal
di Laucher bar). Untuk identifikasi USB Modem anda, sebaiknya modem anda tidak
sambungkan  terlebih  dahulu,  kemudian  di  terminal  ketik  lsusb,  silahkan  colokkan
USB Modem anda,  kemudian  ketik  lagi  lsusb.  Perhatikan  hasil  yang  ditampilkan
antara yang pertama dan yang kedua. Dari Device yang ada mestinya USB Modem
anda sudah terdaftar. Apabila USB Modem dikenali sebagai CD-ROM (cek dengan
ketik ls /dev kalau ada sr0 atau sr1 bagi yang memiliki Drive CD-ROM, berarti USB
Modem anda dikenali  sebagai CD-ROM),  agar  USB Modem anda dikenal sebagai
USB Modem, keluarkan terlebih dahulu CD-ROM dengan ketik eject sr0 (bagi yang
memiliki Drive CD-ROM gunakan  eject sr1). Untuk memastikan USB Modem anda
sudah  dikenali  sebagai  USB  Modem  ketik  lagi  lsusb.  Perhatikan  hasil  yang
ditampilkan. Ingat vendor dan product dari USB Modem anda tersebut, seperti pada
contoh ini adalah 1bbb:0106 (1bbb adalah vendor nya dan 0106 adalah product nya).
Perhatikan gambar berikut untuk lebih jelasnya.
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Selanjutnya, memasang driver USB Modem anda, agar bisa dikenali oleh Asril OS.
Ketik  di  Terminal  sudo  modprobe  usbserial  vendor=0x1bbb  product=0x0106.
Perhatikan pada bagian vendor=0x1bbb ganti sesuai dengan vendor dari USB Modem
anda dan pada product=0x0106 ganti sesuai dengan product dari USB Modem anda.
Masukkan password anda. Untuk mengecek apakah USB Modem anda sudah dikenali
oleh Asril  OS, ketik  dmesg |  tail  kemudian lihat hasil  yang ditampilkan. Mestinya
sudah dikenali sebagai ttyUSB1, ttyUSB2 dan ttyUSB3 seperti yang ditampilkan pada
gambar berikut ini. 
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Apabila  hasil  yang ditampilkan tidak  sesuai  dengan gambar atau  ada tulisan yang
tidak jelas begitu,  untuk mengeceknya bisa juga dengan mengetikkan  ls  /dev lihat
hasil  yang  ditampilkan,  apakah  sudah  ada  ttyUSB0,  ttyUSB1,  ttyUSB2,  ttyUSB3.
Apabila sudah ada, berarti USB Modem anda sudah dikenali oleh Asril OS. Langkah
ini  biasanya  diperlukan  setiap  kali  kita  ingin  menyembungkan  USB Modem kita.
Langkah selanjutnya bisa anda lakukan seperti yang sudah dituliskan diatas.

11.2 Web Browser

Kebanyakan  orang  memanfaatkan  jaringan  internet  dengan  melakukan  browsing  atau
meramban  halaman  web  untuk  keperluan  mencari  suatu  informasi  atau  keperluan  lainnya.
Untuk melakukan browsing pada Asril OS, Anda bisa memanfaatkan program bernama Firefox
Web Browser dan Perambah Web Chromium.

11.2.1 Perambah Web Firefox

Mozilla  Firefox  merupakan  peramban  web  yang  paling  familiar.  Untuk
menggunakannya kita bisa melalui icon Mozilla yang ada di Laucher ataupun melalui
Menu Utama > Internet > Firefox Web Browser.

Sewaktu pertama kali membuka Firefox, anda akan mendapatkan tampilan 

Untuk beranda Firefox di Asril OS ini secara default blank, kita dapat merubahnya
sendiri  sesuai  keinginan  melalui  Edit  >  Pengaturan.  Untuk  memudahkan  dalam
membuka situs-situs yang sering kita kunjungi alangkah baiknya kita mem-markah-
nya. Kita bisa menambahkannya pada Menu Markah dengan cara membuka situs yang
akan kita markah, kemudian dari menu Markah > Markahi Laman ini. Jika kita ingin
menambahkan markah yang lain caranya adalah klik kanan pada baris markah dan
pilihlah Markah Baru.
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11.2.2 Perambah Web Chromium

Chromium  adalah  sebuah  proyek  browser  open-source  yang  bertujuan  untuk
membangun browser agar pengalaman berselancar bagi pengguna Internet lebih aman,
lebih cepat dan lebih stabil. Untuk membuka aplikasi ini, klik Menu Utama > Internet
> Perambah Web Chromium.

Secara default,  beranda chromium adalah blank. Untuk membuka suatu situs, ketik
alamat situs yang Anda buka pada bar alamat. Misalnya, untuk membuka situs resmi
Asril OS, ketik  https://www.asrilos.or.id/. Setelah alamat diketik, tekan tombol Enter
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untuk memulai membukanya. Tunggu sebentar sampai halaman situs dibuka.

Chromium juga bisa Anda gunakan untuk membuka berbagai macam situs dalam satu
waktu. Untuk melakukan hal ini, Anda bisa menambahkan tab baru pada kotak sebelah
kanan tab yang ada. Semakin banyak tab yang Anda buka maka akan semakin banyak
memori  RAM  komputer  yang  akan  dibuka.  Jika  komputer  terasa  agak  lambat,
sebaiknya mengurangi tab yang sudah Anda buka.

Untuk mencatat  situs favorit,  Anda bisa memanfaatkan fitur  Bookmark.  Jika Anda
mengunjungi beberapa laman web secara rutin Anda dapat membuat bookmark untuk
laman itu, yaitu tombol-tombol pada bilah bookmark yang memberikan akses sekali
klik ke laman yang diinginkan. 

Cara  termudah  untuk  membuat  bookmark  laman  adalah  dengan  mengeklik  ikon
bintang  [[☆]]  disamping  bilah  alamat.  Balon  yang  mengonfirmasi  penambahan
bookmark akan ditampilkan. 

1. Ubah nama bookmark pada bidang [>Nama<].
2. Jika tidak diubah, bookmark disimpan dalam folder bookmark yang terakhir 

digunakan.

Gunakan menu [>Folder<] untuk memilih lokasi penyimpanan bookmark. Jika tidak 
diubah, lima folder bookmark yang terakhir digunakan akan muncul dalam menu. Jika
folder yang diinginkan tidak tercantum, gunakan [>Pilih folder lain<] untuk 
membuka kotak dialog [>Edit Bookmark<]. Bookmark akan ditempatkan dalam 
folder yang terakhir digunakan secara bawaan, kecuali jika Anda memilih folder lain 
dalam menu. 

1. Klik [>Cancel<] untuk mengurungkan penambahan bookmark. 

2. Jika Anda ingin mengubah URL bookmark, klik [>Edit<]. Lainnya, klik 
[>Tutup<] untuk menambahkan bookmark.
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11.3 Xtreme Download Manager

Untuk  keperluan  Download  Manager,  Asril  OS  sudah  menyertakan  Download  Manager  yang
bernama Xtreme Download Manager (XDM). XDM ini sangat mirip dengan Internet Download
Manager yang ada di Windows, bagi yang sering menggunakan IDM, tidak akan kesulitan untuk
menggunakan XDM. Program ini dibuat oleh Subhro Dasgupta. Untuk membukanya klik  Menu
Utama > Internet >  XDM. Berikut tampilannya.
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11.4 Pesan Internet Pidgin

Untuk  keperluan  komunikasi  berbasis  teks  secara  langsung  atau  chatting  menggunakan  fitur
perpesanan instan (Instant Messanging), Asril OS menyediakan aplikasi bernama Pidgin. Aplikasi
ini mendukung IM dari berbagai protokol, antara lain Yahoo! Messenger, AIM, Gtalk, ICQ, IRC,
MSN, Facebook, MySpace dan berbagai protokol lainnya. Untuk membuka aplikasi ini, klik Menu
Utama > Internet  >  Pesan Internet  Pidgin.  Jika baru pertama kali  menggunakan,  maka jendela
ucapan  selamat  datang  ke  Pidgin  akan muncul  beserta  pendaftaran  Akun.  Untuk mendaftarkan
identitas akun IM Anda pada Pidgin pilih [>Add<].

Maka pilihan untuk menambahkan Akun pada Pidgin. Silahkan pilih Protokol yang anda gunakan 
dan lengkapi form yang ada. Jika sudah selesai klik [>Tambah<].
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Maka anda akan mendapatkan daftar akun yang ditambahkan ke Pidgin.  Anda bisa menambah,
memodifikasi atau menghapus akun, jika sudah selasai dalam menambahkan akun klik [>Tutup>].
Maka anda akan mendapatkan daftar teman anda yang sedang online di tampilan utama.

Untuk mulai menggunakannya alias Chatting dengan teman anda, silahkan pilih teman yang akan di
ajak chat, klik double, maka jendela untuk mengirim pesan akan muncul. Silahkan lakukan chat
seperti biasanya.
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Anda  akan  mendapatkan  informasi  di  Desktop  setiap  kali  ada  yang  Online  ataupun
Offline dari teman chat anda. Selamat menikmati layanan Chat dari Pidgin.

Pada bab Internet ini, kami belum menyertakan dokumentasi untuk semua program yang
kami sertakan. 
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BAB 12 Program Utility

Asril OS sudah menyediakan beberapa program utility yang dapat anda gunakan seperti Program
APTonCD,  GParted,  MultiSystem,  UNetbootin  dan  Pembuat  Diska  Pemulaian  (Startup  Disk
Creator).

12.1 APTonCD

APTonCD merupakan tools yang dapat kita gunakan untuk membackup paket software (.deb file)
yang sudah kita pasang di distro linux kita. Dengan program yang satu ini, kita dapat dengan mudah
membuat repository yang dapat kita gunakan untuk mengInstall program tanpa terhubung dengan
Internet. Program ini dapat kita gunakan dengan mudah. Untuk membukanya klik Menu Utama >
Administrasi > APTonCD. Berikut tampilan utamanya.

Untuk membuat backup program yang sudah anda install pada distro anda, klik tombol [>Buat<].
Maka anda akan mendapatkan daftar program yang dapat di backup dengan APTonCD ini. Silahkan
cek list  daftar  paket yang akan di  backup,  anda juga bisa mengatur dependensinya melalui tab
[>Edit<].
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Jika sudah menentukan program yang akan di backup, klik tombol [>Burn<] untuk menyimpan
berkas program tersebut. Maka anda akan mendapatkan tampilan untuk mengatur Properties dari
backup tersebut. Jika sudah yakin semuanya, klik [>Terapkan<].

Jika anda ingin mengembalikan paket program yang sudah di backup. Silahkan pilih [>Resktore<].
Pastikan anda sudah memasukkan CD /DVD yang berisi hasil backup tersebut.

12.2 Gparted

GParted merupakan program editor partisi yang bisa digunakan untuk mengatur manajemen partisi
di harddisk anda. Dengan GParted anda dapat mengubah, mengcopy dan memindahkan partisi tanpa
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kehilangan  data  anda.  Untuk  menggunakannya  klik  Menu  Utama  >  Administrasi  >  Gparted,
masukkan password anda. Anda akan mendapatkan tampilan haeddisk anda beserta partisi yang ada
didalamnya.

12.3 Startup Disk Creator

Satu lagi program yang disertakan pada Asril OS yang dapat digunakan untuk membuat Live USB
yaitu Startup Disk Creator (Pembuat Diska Pemulaian). Program ini hanya mendukung Ubuntu dan
turunannya. Program ini sangat sederhana untuk digunakan. Untuk menggunakannya, klik  Menu
Utama > Administasi > Startup Disk Creator. Berikut tampilan utamanya.
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Untuk memilih file ISO yang akan anda gunakan, jika belum ada klik [>Lainnya<] kemudian pilih
file ISO yang akan anda gunakan. Setelah terpilih, maka akan muncul informasinya di kotak dialog
diatas. Kemudian pilih FlashDisk anda yang akan digunakan sebagai Live USB, jika sudah selesai
semuanya klik [>Buat Disket Startup<]. Tunggu prosesnya sampai selesai, jika diminta password,
silahkan masukkan password anda.

12.4 MultiSystem

MultiSystem merupakan program yang dapat kita gunakan untuk membuat FlashDisk kita menjadi
Multiboot Live USB. FlashDisk anda bisa digunakan menjadi live USB dengan beberapa distro
linux. Dengan bantuan program ini, kita dapat menyimpan banyak distro linux dalam FlashDisk kita
(sampai penuh) yang semuanya bisa berjalan secara live. Untuk menggunakannya klik Menu Utama
> Aksesoris > MultiSystem.

Sebelum  masuk  ke  tampilan  utama,  anda  diperkenankan  untuk  memilih  FlashDisk  yang  akan
digunakan.  Setelah  anda menentukan FlashDisk  yang akan anda gunakan,  silahkan Konfirmasi
dengan  memasukkan  password anda.  Maka  MultiSystem akan  mengatur  FlashDisk  anda  untuk
dapat digunakan. Pertama kali, biasanya ada peringata Galat eror, ini terjadi karena nama FlashDisk
anda bukan MULTISYSTEM, tetapi ini tidak jadi masalah, karena program MultiSystem secara
otomatis  akan merubah sesuai  yang diperlukan.  Anda hanya perlu  mengulanginya  lagi,  dengan
terlebih  dahulu  mencabut  FlashDisk  anda  dan  memasangnya  kembali  dan  menyetujui  untuk
pemasangan grub. Jika tidak ada masalah,  maka anda akan mendapatkan tampilan MultiSystem
seperti gambar berikut.

Untuk menambahkan distro linux, silahkan menggunakan menu Drag & Drop yang ada dibawah
pada  bagian  [>Pilih  .iso  atau  .img<].  Setiap  memasukkan  file  ISO,  anda  akan  diminta  untuk
konfirmasi password. Anda dapat memasukkan sebanyak-banyaknya file ISO dalam FlashDisk anda
tersebut (sesuai dengan batas kapasitas FlashDisk anda).
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12.5 UNetbootin

UNetbootin  (Universal  Netboot  Installer)  adalah  perangkat  untuk  membuat  sistem  Live  USB.
Perangkat yang cross-platform ini (dapat digunakan dalam berbagai sistem operasi) dapat memuat
berbagai macam perangkat sistem (system utilities) atau meng-install berbagai distro Linux maupun
sistem operasi lain meski tanpa CD.
Kelebihan UNetbootin

UNetbootin memiliki kelebihan tersendiri  dibandingkan dengan dengan Program pembuat Live-
USB yang lain, karena :

1. Cross-platform (tersedia untuk Windows dan Linux) 

2. Instalasi  tidak  merusak  (tidak  mem-format  perangkat  yang  digunakan)  menggunakan
Syslinux. 

3. Mendukung distro-distro Linux utama, termasuk namun tak terbatas atas, Ubuntu, Fedora,
openSUSE, CentOS, Debian, Linux Mint, Arch Linux, Mandriva, Slackware juga FreeDOS,
FreeBSD dan NetBSD. 

4. Dapat  memuat  berbagai  system  utilities,  termasuk,  tapi  tak  terbatas  atas,  Ophcrack,
BackTrack, dan Gujin. 

5. Sistem operasi lain dapat dimuat melalui ISO image atau kernel, initrd dan floppy/hard drive
disk image. 

6. Secara  otomatis  mengenali  semua  perangkat  keras  yang  dapat  dipisahkan  (removable
devices).

Asril OS sudah menyertakan program ini, sehingga bisa langsung anda gunakan. Sekarang kita akan
belajar untuk membuat LiveUSB Asril OS, pastikan Anda telah mendapatkan berkas image-nya dan
memiliki flashdisk setidaknya berukuran 4 GB dan telah dikosongkan. 

1. Buka UNetbootin, klik Menu Utama > Administrasi > UNetbootin (dalam beberapa kasus 
akan meminta sandi, masukkan sandi Anda), berikut tampilan utama dari Unetbootin.
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2. Pilih Diskimage >ISO. 
3. Telusuri lokasi tempat Anda menyimpan berkas image Asril OS di tombol [>...<] paling 

kanan 

4. Pada bagian Type, pastikan terpilih USB Drive dan Drive FlashDisk Anda (pada 
GNU/Linux biasanya /dev/sdb1 kalau cuma satu FlashDisk yang terpasang) .

5. Klik OK, tunggu beberapa lama, biasanya di tengah-tengah seperti berhenti, tunggu saja 
sampai proses selesai .

6. Setelah  pembuatan  Live-USB  selesai,  maka  akan  muncul  pemberitahuan,  jika  ingin
langsung mencobanya Klik [>Reboot Now<] atau klik [>Exit<] mencobanya nanti atau di
komputer lain.
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12.6 apt-id

Apt-id bukanlah sebuah program yang berfungsi menggantikan peran apt-get, tetapi hanya sebuah
bash script yang mengatur penggunaan apt-get agar sesuai dengan kondisi komputer yang tidak
memiliki koneksi internet. Apt-id saya buat berdasarkan metode apt-get print-uris yang sudah lama
dikenal. Saya hanya menambahkan kemampuan untuk memfasilitasi update database APT (sudo
apt- get update) dan eksekusi otomatis untuk file-file hasil download. 
Meskipun tujuan utamanya adalah untuk pengguna Ubuntu yang tidak memiliki koneksi internet,
apt- id juga dapat digunakan oleh pengguna Ubuntu yang memiliki koneksi internet. Terutama yang
koneksi internetnya masih terbatas. Apt-id dapat digunakan bergantian dengan metode online tanpa
menimbulkan masalah. 

Untuk memahami cara kerja apt-id,  kita perlu memahami dulu bagaimana cara apt-get  bekerja.
Berikut ini adalah penggambaran cara kerja apt-get, di komputer yang memiliki koneksi internet.
Ketika kita memberikan perintah sudo apt-get install aplikasi_X, maka proses yang akan terjadi
adalah sebagai berikut : 

1. Apt-get akan membaca database APT, lalu membuat daftar berisi paket-paket apa saja yang
diperlukan untuk menginstall aplikasi_X, serta di mana masing-masing file paket tersebut
(dalam bentuk file .deb) dapat di-download. 

2. Apt-get akan men-download semua file .deb sesuai daftar yang telah dibuatnya. 
3. Eksekusi  →  Apt-get  akan  menginstall  semua  file  .deb  tersebut  untuk  membentuk

aplikasi_X.

Bagaimana dengan perintah sudo apt-get update ? Sangat mirip, proses yang terjadi kurang lebih
sebagai berikut : 

1. Apt-get akan membaca daftar Software Sources, lalu membuat daftar berisi file-file apa saja
yang diperlukan untuk melakukan update APT, serta di mana masing-masing file tersebut
dapat di-download. 

2. Apt-get akan men-download semua file sesuai daftar yang telah dibuatnya. 
3. Eksekusi → Apt-get memproses semua file tersebut untuk memperbaharui database APT.

Untuk menggunakannya,  anda  dapat  memanggil  apt-id  dari  mana pun di  terminal  dengan cara
mengetikkan apt-id. Kami juga sudah menyertakan panduan apt-id yang dapat diakses dengan klik
Menu Utama > Panduan > Panduan apt-id
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12.7 AllDeb

Alldeb adalah  program shell  script  sederhana buatan  Nifa Dwi Kurniawan dari  Forum Ubuntu
Indonesia  untuk  membantu  instalasi  aplikasi  Ubuntu  tanpa  koneksi  internet  langsung.  Konsep
alldeb sama dengan exe di Windows atau dmg di Mac OS X. Konsep itu adalah single offline
installer. Pengguna cukup mengunduh 1 file untuk 1 aplikasi. Tidak dibutuhkan koneksi internet
langsung dari komputer pengguna untuk menginstal aplikasi. Dan instaler aplikasi bisa disimpan
untuk diinstal kembali kapan saja. Baik di komputer sendiri dan komputer orang lain. 
Alldeb membuat sama pengalaman komputer Anda di Linux dengan di Windows. Instalasi aplikasi
di Ubuntu kini semudah di Windows. 

Alldeb  terbagi  menjadi  2  bagian.  Satu  AllDeb  Webmaker,  dan  satu  AllDeb  Manager.  AllDeb
Webmaker ditujukan untuk membuat aplikasi alldeb. AllDeb Manager ditujukan untuk memasang
paket aplikasi yang telah dibuat. Jadi ada 2 aplikasi di sini, 1 aplikasi bertugas membuat paket-paket
yang dibutuhkan dan 1 aplikasi yang memasang dan memakai aplikasi.

12.7.1 Keuntungan AllDeb

Keuntungan menggunakan AllDeb yaitu :

1. Anda jadi lebih mudah menginstal aplikasi. 

2. Anda  tidak  perlu  menginstal  aplikasi  sembari  memikirkan  dependensi-
dependensinya. Anda cukup mengunduh 1 paket untuk 1 aplikasi termasuk dengan
seluruh dependensinya. Manfaatnya adalah hemat waktu yang sangat banyak dan
hemat daya otak. Prinsip instalasi normal Ubuntu tidak bisa melakukan ini. 

3. Anda bisa mengunduh paket alldeb di komputer lain tanpa requirement apa pun
dan menginstalnya di komputer Anda dengan sukes. Ini berkebalikan dari prinsip
instalasi aplikasi normal di Ubuntu, yang mempersulit hal ini. Kalaupun Ubuntu
bisa,  itu  pun  harus  dilakukan  dengan  requirement  yang  banyak  macam  dan
umumnya panjang-panjang. Anda bisa menyimpan instaler aplikasi (dalam hal ini
paket-paket  alldeb)  untuk digunakan ulang di  masa depan.  Hal  ini  menghemat
bandwidth internet karena Anda tidak usah mengunduh lagi aplikasinya jika Anda
instal ulang Ubuntu. Prinsip instalasi normal Ubuntu tidak bisa melakukan hal ini. 

4. Anda bisa menginstal instaler yang telah disimpan pada Ubuntu di komputer lain.
Ini menghemat bandwidth internet berkali-kali lipat apalagi jika dibutuhkan pada
komputer kolektif (misalnya di lab sekolah dll.). Prinsip instalasi normal Ubuntu
tidak bisa melakukan hal ini. 

5. Anda bisa membagikan instaler yang telah disimpan kepada orang lain. Ini sama
dengan kebiasaan Anda umumnya di Windows atau Mac OS X. Metode berbagi
pun tidak terbatas, bisa lewat internet,  lewat CD, atau metode lainnya.  Bahkan
Anda  bisa  menyertakannya  dalam  remasteran  Anda.  Prinsip  instalasi  normal
Ubuntu tidak bisa melakukan hal ini. 

6. Anda bisa mengetahui dengan pasti berapa ukuran berkas suatu aplikasi dalam satu
kali  lihat.  Prinsip  instalasi  normal  Ubuntu  tidak  bisa  melakukan  hal  ini.  Anda
hanya  bisa  melihat  ukuran  berkas  satu  per  satu  per  paket,  menjumlahkannya
sendiri  satu  per  satu untuk keseluruhan dependensi  untuk 1 aplikasi,  dan  yang
paling  sulit  menemukan  seluruh  dependensi  lengkap  untuk  1  aplikasi.  Alldeb
menghemat waktu dan daya otak Anda dengan sangat baik. 
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7. Anda tetap bisa upgrade aplikasi yang diinstal dari paket alldeb secara normal di
Ubuntu.  Tidak  seperti  instalasi  dari  kode  sumber  yang  seringkalinya  tidak
kompatibel dengan apt. Ini dikarenakan alldeb mempersatukan kecerdasan dpkg
dan apt dalam satu tempat,  sehingga yang berubah hanya state  instalasi  (yakni
100%  offline)  sedangkan  sifat-sifat  dan  kelebihan  aslinya  sama  sekali  tidak
dibuang. Salah satunya adalah upgradable. 

8. Anda  bisa  mendirikan  situs  semacam  Softpedia  sendiri  untuk  Linux,  karena
sekarang  instalernya  sudah  single  offline.  Tidak  seperti  dulu  lagi  yang  harus
resolve depencies. 

12.7.2 AllDeb Webmaker

Konsep kerja  AllDeb Webmaker  sebenarnya sangat  sederhana.  AllDeb  Webmaker
bertugas mengumpulkan semua file .deb yang dibutuhkan untuk menginstall suatu
aplikasi menjadi satu, lalu mengemasnya menjadi sebuah file tunggal (file .alldeb).
Untuk menggunakannya, anda tinggal klik  https://www.alldeb.net/ dan pilih Sistem
Operasi  yang anda gunakan,  kemudian  carilah  aplikasi  yang ingin  anda buat  file
alldeb-nya.

12.7.3 AllDeb Manager

Konsep  kerja  AllDeb  Manager  juga  sangat  sederhana.  AllDeb  Manager  akan
membuka  file  .alldeb,  lalu  membaca  semua  file  .deb  yang  termuat  di  dalamnya.
Kemudian  AllDeb  Manager  akan  memeriksa  apakah  file-file  tersebut  telah  cukup
untuk memenuhi dependensi yang diperlukan di komputer kita. Jika memenuhi, maka
installasi  aplikasi  dari  file  .alldeb  tersebut  dapat  dilakukan.  Untuk  memudahkan
dalam penggunaanya, kami menyertakan versi GUI. Untuk membukanya klik  Menu
Utama > Aksesoris > AllDeb Manager
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Kami juga sudah menyertakan buku panduan AllDeb yang dapat anda akses melalui
Menu Utama > Panduan > Panduan AllDeb
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 BAB 13 Program Aksesoris

Bagi sebagian orang, memiliki komputer yang mempunyai semua program yang dibutuhkan dalam
kegiatannya setiap hari mungkin menjadi kebutuhan tersendiri. Misalnya saja, seorang siswa yang
memiliki  kewajiban  dalam  mengerjakan  tugas-tugas  dari  sekolah,  akan  sangat  terbantu  bila
memiliki kalkulator yang lengkap di dalam komputer atau laptopnya. Pada distro Asril OS, sudah
tersedia beberapa program aksesoris atau program tambahan yang sangat berguna dan siap dipakai
oleh pengguna, dalam subbab ini akan dibahas beberapa diantaranya. 

13.1 Kalkulator

Seperti  namanya,  fungsi  program ini  untuk  melakukan  perhitungan  dengan  bantuan  komputer.
Program  ini  dapat  dijalankan  melalui  Menu  Utama  >  Aksesoris  >  Calculator.  Secara  default,
program  ini  akan  menampilkan  kalkulator  sederhana  untuk  melakukan  perhitungan  sederhana.
Untuk mengubahnya menjadi kalkulator yang lebih rumit, anda bisa pilih salah satu jenis kalkulator
pada menu “Mode”. 

13.2 Tabel Karakter

Untuk membuat teks atau simbol yang tidak ada di papan ketik, akan lebih mudah menggunakan
program bantu yang bernama Tabel Karakter atau Character Map. Program yang juga memiliki
tampilan yang sederhana ini akan memiliki fungsi yang sangat penting sekali, jika kita memerlukan
untuk menulis karakter yang tidak terdapat dalam papan ketik. Program ini dapat ditemukan pada
Menu > Aksesoris > Character Map. 
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Untuk menyalin simbol, Anda bisa klik ganda pada simbol yang ingin Anda salin, lalu klik tombol
[>Salin<].  Jika  menggunakan  program  pengolah  kata  LibreOffice  Writter,  Anda  cukup
menggunakan fitur karakter khusus melalui Menu Insert > Special Character. 

13.3 Cuplikan Layar

Walaupun tidak sering, mungkin saja Anda membutuhkan tangkapan layar atau gambar dari 
tampilan desktop yang sedang aktif. Dalam Asril OS menyediakan program bernama Screenshot, 
program ini terdapat pada Menu> Aksesoris > Cuplikan Layar. 
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Dengan menggunakan program yang satu ini, pekerjaan untuk mengambil gambar dari desktop 
Anda sendiri dapat dilakukan dengan mudah, langkah-langkahnya adalah sebagai berikut: 

✔ Pertama, siapkan terlebih dahulu desktop yang akan kita ambil gambarnya. 

✔ Kemudian, buka program ini dan gambar pun siap untuk diambil. 

Selain cara diatas, Anda juga bisa mengambil tangkapan layar dengan menekan tombol [>Prtscr<] 
pada papan ketik, atau dengan ditambah tombol [>Fn<]. 

13.4 Penyunting Teks

Walaupun kelihatan sepele, program Teks Editor merupakan sesuatu yang tidak dapat dipisahkan 
dari penggunaan sehari-hari. Asril OS menyediakan program Teks Editor bernama gedit. Program 
ini berada di Menu > Aksesoris > Penyunting Teks. 

Dengan menggunakan program ini kita dapat dengan mudah untuk membuat ataupun membaca
berkas  teks  yang  diinginkan.  Dengan  kemampuan  yang  lebih  tinggi,  teks  editor  ini  pun  dapat
digunakan  untuk  menulis  bahasa  pemrograman  karena  penggunaan  fitur  penanda  warna  pada
sintaks kode yang membuat penulisan kode program menjadi lebih enak.

13.5 StarDict

Kamus merupakan salah satu kebutuhan utama di era yang serba global dewasa ini. Baik pihak
institusi,  pengusaha,  pekerja  atau  apapun  profesi  Anda,  pasti  membutuhkan  program  untuk
menerjemahkan  bahasa  asing  ke  Bahasa  Indonesia  atau  sebaliknya.  Untuk  itulah  Asril  OS
dilengkapi dengan program kamus yang bernama StarDict dengan basis data kamus KBBI yang
terdiri dari :
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1. Tesaurus Bahasa Indonesia Pusat Bahasa,
2. Kamus Besar Bahasa Indonesia, Edisi III,

3. Bahasa Indonesia – Bahasa Inggris,
4. Bahasa Inggris – Bahasa Indonesia,

5. Bahasa Indonesia – Bahasa Aceh, 
6. Bahasa Indonesia – Bahasa Ambon, 

7. Bahasa Indonesia – Bahasa Bali, 
8. Bahasa Indonesia – Bahasa Banjar, 

9. Bahasa Indonesia – Bahasa Betawi, 
10. Bahasa Indonesia – Bahasa Bugis, 

11. Bahasa Indonesia – Bahasa Gayo, 
12. Bahasa Indonesia – Bahasa Jambi, 

13. Bahasa Indonesia – Bahasa Jawa, 
14. Bahasa Indonesia – Bahasa Madura, 

15. Bahasa Indonesia – Bahasa Makassar, 
16. Bahasa Indonesia – Bahasa Malangan, 

17. Bahasa Indonesia – Bahasa Minang, 
18. Bahasa Indonesia – Bahasa Palembang, 

19. Bahasa Indonesia – Bahasa Sasak, 
20. Bahasa Indonesia – Bahasa Simalungun, 

21. Bahasa Indonesia – Bahasa Sunda, 
22. Bahasa Indonesia – Bahasa Toba, 

23. Loka Tarjamah Otomatis Indonésia-Sunda,
24. Loka Tarjamah Otomatis Sunda – Indonésia

25. Bahasa Denmark – Bahasa Indonesia
26. Bahasa Indonesia – Bahasa Denmark

27. Bahasa Swedia – Bahasa Indonesia
28. Bahasa Indonesia – Bahasa Swedia

Database kosa kata yang tersedia untuk Bahasa Indonesia ke Bahasa Daerah masih terbatas, tidak
semua tersedia. Untuk itu gunakanlah dengan baik dan cermat. Selamat belajar Berbahasa. Untuk
menggunakannya klik Menu Utama > Aksesoris > StarDict.

13.6 Keyboard Virtual

Keyboard  Virtual  merupakan  program bantu  yang  dapat  kita  gunakan  untuk  mengetik  dengan
bantuan Keyboard Virtual. Ini dapat kita gunakan sebagai alternatif kalau sewaktu-waktu Keyboard
komputer  kita  mengalami  masalah.  Dengan  adanya  Program  Keyboard  Virtual  ini  kita  dapat
menggunakan Keyboard dengan mouse kita. Untuk menggunakannya klik Menu Utama > Aksesoris
> Keyboard Virtual. Berikut tampilan dari program Keyboard Virtual tersebut.
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13.7 Penampil Dokumen

Buku elektronik atau e-book merupakan format distribusi buku yang sangat umum saat ini. Buku-
buku atau majalah luar negeri  banyak mendistribusikan buku jenis ini  selain juga mengedarkan
edisi  cetaknya.  Harga dari  buku elektronik jelas  lebih murah daripada buku cetak karena tidak
memerlukan kertas. Hampir semua buku elektronik di distribusikan dalam bentuk format PDF yang
merupakan format dari perusahaan Adobe, inc. Untuk membuka format ini di distro Asril OS, Anda
bisa menggunakan program bernama Penampil Dokumen. Klik ganda pada berkas PDF yang ingin
Anda buka pada peramban berkas, maka program penampil Dokumen akan membukakannya untuk
Anda.

 
Untuk mempermudah navigasi antar halaman, Anda bisa memanfaatkan side pane
yang  tersedia  di  sebelah  kiri  jendela  Penampil  Dokumen.  Anda  juga  bisa
memanfaatkan tombol arah atau tombol Page Up/Down. Untuk memperbesar ukuran
halaman dengan memanfaatkan fitur  zooming dengan memilih  ukuran zoom yang
diinginkan pada opsi yang terdapat di bagian kanan toolbar. Agar lebih enak dibaca,
Anda bisa membuka halaman dengan layar penuh melalui menu Tampilan > Layar
Penuh atau Anda bisa tekan tombol F11 pada papan ketik, sebagai tambahan anda
juga  dapat  menampilkan  halaman  buku  elektronik  dengan  gaya  presentasi  yaitu
melalui menu Tampilan > Presentasi atau menekan tombol F5 pada papan ketik.
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BAB 14 Pengenalan Antarmuka Teks

Antarmuka dasar untuk pengoperasian sistem operasi Linux sebenarnya adalah antarmuka berbasis
teks, atau sering disebut Command Line. Antarmuka grafis atau desktop yang ada di dalam Linux
sebenarnya hanyalah alat bantu untuk pengoperasian bagi mereka yang sudah biasa bekerja dengan
Graphical User Interface (GUI) yang terdapat di beberapa sistem operasi modern. Ini mirip dengan
piranti lunak Microsoft Windows sebelum versi 95 yang hanya merupakan alat bantu pengoprasian
berbasis grafis untuk DOS. 
Untuk  memberikan  suatu  perintah  pada  antarmuka  teks,  para  pengguna  harus  mengetik  nama
perintah yang akan dijalankan beserta opsi-opsi/parameter-nya, kemudian menekan tombol Enter
untuk mengeksekusi perintah tersebut. Tidak seperti antarmuka grafis, penggunaan mouse secara
umum tidak diperlukan karena semua kontrol hanya dilakukan melalui papan ketik. 

Tidak benar jika penggunaan antarmuka teks tidak bisa melakukan produktivitas. Anda masih bisa
berproduktivitas  dengan  berbagai  aplikasi  berbasis  teks  yang  tersedia  dan  siap  Anda  gunakan.
Bahkan  untuk  para  administrator,  penggunaan  antarmuka  teks  sangat  disarankan  ketimbang
antarmuka grafis karena memakan sumberdaya CPU dan RAM yang lebih kecil,  sehingga tidak
menganggu kinerja komputer pada saat melakukan suatu tugas administrasi. 

Pada bab ini,  dijelaskan mengenai dasar pengoprasian antarmuka teks yang ada pada Asril  OS.
Sasaran pembaca tidak hanya bagi Anda yang power user, melainkan juga para pemula/newbie yang
ingin mempelajari Linux lebih lanjut. 

14.1 Membuka Antarmuka Teks

Ada dua jenis antarmuka teks yang bisa Anda buka, yaitu terminal dan virtual console. Terminal
merupakan antarmuka teks yang berjalan di dalam desktop dan berupa jendela aplikasi, sedangkan
virtual console merupakan antarmuka teks yang berjalan secara mandiri di luar desktop. 

14.1.1 Membuka Terminal

Untuk membuka terminal, klik Menu Utama > Aksesoris > Terminal atau melalui menu
Laucher bar dengan klik icon Terminal, kemudian jendela terminal akan muncul di dalam
desktop. 
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Untuk menampilkan baris menu, klik kanan > Tampilkan Baris Menu. Jika Anda ingin
membuka sesi kerja yang baru, Anda bisa membuat tab baru seperti layaknya fitur tabbed
browsing pada peramban web melalaui menu Berkas > Buka Tab atau dengan klik kanan
> Buka Tab, atau Anda bisa tekan tombol Shift+Ctrl+T pada keyboard.

Anda bisa mengkostumisasi penampilan terminal sesuai dengan keinginan Anda melalui
jendela pengaturan yang bisa Anda buka melalui menu Sunting > Preferensi Profil atau
klik kanan > Profil. Jika ingin membuat terminal dalam mode layar penuh, Anda bisa klik
menu Tampilan > Layar Penuh atau Anda bisa tekan tombol F11 pada keyboard. 

14.1.2 Membuka Virtual Console

Linux telah menyediakan enam sesi antarmuka teks yang bisa Anda buka dengan cara
menekan  tombol  Ctrl+Alt+F1,  Ctrl+Alt+F2  sampai  Ctrl+Alt+F6.  Berbeda  dengan
menggunakan terminal,  Anda harus melakukan login terlebih dahulu sebelum bekerja
dengan antarmuka teks. Ketik id pengguna kemudian tekan enter lalu masukkan sandi
(password tidak akan ditampilkan pada layar) Anda dan tekan enter sekali lagi. Berbeda
dengan terminal, Anda tidak bisa melakukan kustomisasi penampilan agar lebih menarik.
Bekerja disini layaknya bekerja dengan sistem operasi DOS (Disk Operating Systems).
Untuk kembali ke desktop, Anda bisa tekan tombol Ctrl+Alt+F8 sampai Ctrl+Alt+F12.
Bergantung dari sesi desktop yang digunakan (Secara default menggunakan Ctrl+Alt+F8
jika Anda tidak memanfaatkan fitur pindah pengguna untuk mengaktifkan lebih dari satu
sesi desktop). 

14.2 Pengenalan Antarmuka Teks

Setelah Anda membuka terminal atau login di dalam virtual console,  Anda akan diminta untuk
memasukkan  perintah  yang  ingin  Anda  jalankan.  Tempat  Anda  mengetik  berada  pada
kursor/penanda  yang berkedip-kedip.  Pada  bagian  kiri  kursor  tersebut,  Anda  akan melihat  teks
seperti berikut : 

✔ Teks tersebut memiliki berbagai informasi sebagai berikut : 

✔ Teks  “asrilmarhamah”  sebelum tanda  at  (@)  merupakan  nama id  pengguna  yang  login
menggunakan antarmuka teks, 

✔ Teks “PICO-DJH-Model” setelah tanda at (@) merupakan nama komputer yang digunakan
pada saat bekerja, 

✔ Teks “~” setelah nama komputer menunjukan folder yang saat ini dibuka. Folder “~” berarti
sedang membuka folder rumah/home. 

✔ Tanda “$” pada bagian akhir menunjukkan Anda bekerja di level pengguna biasa. Jika Anda
bekerja dalam mode administratif, maka tandanya akan berubah  menjadi “#”. 

Untuk menjalankan suatu perintah, Anda bisa ketik perintah tersebut lalu menekan tombol enter.

 Halaman 128   

14.2 Bagian-Bagian Terminal



 Pengenalan Antarmuka Teks  

Sebagai contoh, untuk menampilkan isi suatu folder/direktori, Anda bisa ketik perintah “ls” lalu
tekan tombol Enter, maka Anda akan melihat antarmuka teks seperti berikut : 

Untuk  menjalankan  perintah  yang  bersifat  administratif,  Anda  bisa  mengetik  perintah  “sudo”
sebelum perintah yang ingin Anda jalankan. Anda harus memiliki wewenang untuk menggunakan
sudo agar perintah bisa berjalan. Misalnya, jika ingin menghapus berkas “nasi.txt” pada folder /opt
(Dalam hal ini, Anda tidak memiliki hak untuk mengelola folder /opt), Anda bisa ketik perintah
“sudo rm /opt/nasi.txt”. 

Note : Walaupun menyediakan id pengguna khusus untuk menjalankan perintah bersifat
administratif (yaitu root), secara default Anda tidak bisa menggunakannya untuk login. Anda bisa

login ke root dengan cara mengetik perintah “sudo su -”. 
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14.3 Perintah-perintah dalam Antarmuka Teks

Berikut  adalah  berbagai  penjelasan  dari  perintah-perintah  dalam  pengelolaan  berkas  secara
sederhana menggunakan antarmuka teks. 

14.3.1 Berpindah Folder/Direktori (cd)

Untuk berpindah dari satu folder ke folder lainnya, Anda bisa ketik perintah “cd” dan
diikuti dengan alamat folder yang dibuka (dipisah dengan spasi). Sebagai contoh, jika
ingin membuka folder Dokumen yang ada di dalam folder home, Anda bisa ketik “cd
~/Dokumen”. Jika Anda berada di dalam folder home, Anda cukup ketik “cd Dokumen”
saja.

Jika ingin berpindah ke folder yang ada di level lebih atas, ketik perintah “cd ..”. 

14.3.2 Melihat Isi Folder/Direktori (ls) 

Untuk melihat isi dari suatu folder/direktory Anda saat ini, Anda cukup ketik opsi “ls”. 

Anda juga bisa membuka isi folder lain selain folder saat ini dengan menambahkan 
lokasi folder setelah perintah ls dengan dipisah spasi. Misalnya, ketik perintah “ls /usr” 
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untuk menampilkan isi folder /usr. 

Untuk informasi berkas/folder di dalam folder, Anda bisa menambahkan opsi “ -l” pada 
perintah “ls” yang Anda jalankan. 

14.3.3 Membuka Berkas

Untuk membuka suatu berkas menggunakan suatu aplikasi, Anda bisa mengetik perintah
untuk menjalankan aplikasi kemudian diikuti dengana nama atau path dari berkas yang
ingin  dibuka.  Misalnya,  jika  ingin  membuka  berkas  “Desain-Grafis.odt”  pada  folder
“Dokumen” dengan LibreOffice.org, Anda bisa ketik perintah “soffice Dokumen/Desain-
Grafis.odt”. 

Sebagai catatan, jika Anda ingin membuka file dengan mode Terminal, pastikan nama
file  tersebut  tidak  menggunakan  karakter  spasi  dalam  nama  filenya,  karena  mode
Terminal tidak bisa membaca nama file yang mengandung karakter spasi, akan muncul
pesan file tidak ditemukan.

14.3.4 Membuat Direktori (mkdir) 

Untuk membuat direktori / folder, Anda bisa menggunakan perintah “mkdir namafolder” 
atau “mkdir path-folder”. Maka akan dibuat folder baru yang berada di bawah folder 
Anda saat ini. 
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14.3.5 Menghapus Direktori (rmdir) 

Untuk  menghapus  suatu  direktory/folder,  Anda  bisa  gunakan  perintah  “rmdir
namafolder”  atau  “rmdir  path-folder”.  Syaratnya,  folder  tersebut  harus  kosong  tanpa
berisi berkas atau subfolder apapun. 

14.3.6 Menghapus Berkas (rm) 

Untuk menghapus suatu berkas, gunakan perintah “rm” lalu diikuti dengan nama berkas 
atau dilengkapi dengan path (alamat lengkapnya) jika diperlukan. 

Peringatan:  Setelah Anda menjalankan perintah ini, berkas akan dihilangkan begitu saja
tanpa konfirmasi. Jadi, hati-hati dalam menggunakannya.

Sebagai  contoh,  anda  ingin  menghapus  file  barongko.txt  yang  ada  di  dalam  folder
Dokumen, gunakan perintah rm Dokumen/barongko.txt

Jika  ingin  menghapus  suatu  isi  folder  sampai  isinya  secara  rekursif,  Anda juga  bisa
gunakan  perintah  ini  dengan  menambahkan  opsi  “-R”.  Sekali  lagi,  hati-hati  dalam
menggunakan perintah ini. 
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14.3.7 Menggandakan Berkas (cp)

Untuk menggandakan berkas,  gunakan perintah cp dengan format “cp berkas-sumber
folder-tujuan”. Seperti semua perintah di atas, Anda juga bisa menyebutkan path penuh
dari  berkas-sumber  atau  folder-tujuan  jika  diperlukan.  Contohnya,  jika  ingin
menggandakan berkas Desain-Grafis.odt yang ada di folder Dokumen ke dalam folder
Buras yang berada dalam folder Dokumen juga, gunakan perintah “cp Dokumen/Desain-
Grafis.odt Dokumen/Buras”.

Sama dengan perintah rm, Anda bisa manfaatkan opsi “-R” jika ingin menggandakan
suatu  folder  secara  rekursif.  Sebagai  contoh,  anda  ingin  menggandakan folder  Buras
yang ada didalam folder Dokumen ke folder Barobbo yang ada di folder Dokumen juga
maka gunakan “cp -R Dokumen/Buras Dokumen/Barobbo”.

14.3.8 Memindahkan Berkas/Folder (mv)

Untuk memindahkan berkas/folder,  Anda bisa gunakan perintah “mv”. Penggunaanya
mirip  dengan perintah “cp”.  Hanya saja,  jika  memindahkan suatu  folder,  Anda tidak
perlu  menggunakan  opsi  recursif  “-R”.  Contohnya,  jika  ingin  memindahkan  file
Barongko.txt yang berada di folder Dokumen ke dalam folder Buras yang ada di Folder
Dokumen juga, ketik perintah “mv Dokumen/Barongko.txt Dokumen/Buras”. 
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14.3.9 Mengubah Nama Berkas/Folder (mv)

Perintah  yang digunakan untuk mengubah nama berkas  sama dengan perintah  untuk
memindahkan berkas/folder yaitu “mv”. Cara penggunaannya pun sama. Contoh, untuk
mengubah  nama  berkas  Barongko.txt  yang  ada  di  folder  Dokumen  menjadi
Lemmang.txt, ketik perintah “mv Dokumen/Barongko.txt Dokumen/Lemmang.txt”. 

14.3.10 Mengubah Hak Akses Berkas/Folder (chmod)

Untuk mengubah hak akses berkas/folder, Anda bisa gunakan perintah chmod dengan
format “chmod hakakses berkas/folder”. Hak akses diisi dengan tiga angka oktal. Angka
ke-1 merupakan hak untuk pemilik, angka ke-2 merupakan hak untuk grup dan angka ke-
3 merupakan hak untuk selain pemilik dan grup. Masing-masing bagian diisi  dengan
angka basis 8, dimana hak baca bernilai 4, hak tulis bernilai 2, hak eksekusi bernilai 1. 

Sebagai contoh, untuk mengubah berkas “Barongko.txt” yang ada di folder Dokumen
agar hak baca,tulis dan eksekusi untuk pemilik, sedangkan yang lain hanya memiliki hak
baca dan eksekusi, Anda bisa ketik perintah “chmod 755 Dokumen/Barongko.txt”.

Untuk  memberikan  suatu  hak  akses  secara  rekursif  pada  suatu  folder,  Anda  bisa
menambahkan  opsi  “-R”.  Misalnya,  jika  ingin  memberikan  hak  mutlak  (hak
baca,tulis,eksekusi untuk semua aspek) pada folder Buras yang ada di folder Dokumen,
Anda bisa ketik perintah “chmod 777 -R Dokumen/Buras”. 
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Untuk menampilkan hak akses suatu berkas/folder, Anda bisa manfaatkan perintah “ls 
-l”. Kemudian, Anda akan melihat seperti karakter yang dicetak tebal yang merupakan 
hak akses dari berkas tersebut. Keenam karakter itu dibagi menjadi tiga, bagian pertama 
merupakan hak akses pemilik, bagian kedua merupakan hak akses grup dan bagian 
terakhir merupakan hak akses selain pemilik dan grup. 

Keterangan : r : Hak Baca, w : Hak tulis, x : Hak eksekusi 

14.3.11 Mengubah ID Pemilik / Grup pada Berkas/Folder (chown)

Untuk  mengubah  id  pemilik  atau  grup  pada  berkas/folder,  gunakan  perintah  chown
dengan  format  “chown  id-pemilik  namaberkas”  jika  ingin  mengubah  id  pemilik
berkas/folder, “chown :grup namaberkas” untuk mengganti grup berkas dan “chown id-
pemilik:grup nama berkas” jika ingin mengubah id pemilik dan nama grup pada suatu
berkas sekaligus. Ingat, yang hanya bisa mengubah pemilik berkas hanyalah pengguna
administratif, sedangkan grup hanya bisa diubah oleh pemilik berkas. 
 

Contohnya, jika ingin mengubah grup berkas menjadi “adm” pada berkas nasi.txt, Anda
bisa ketik perintah “chown :adm Dokumen/Barongko.txt”. 

Untuk mengetahui id pemilik dan grup dari suatu berkas/folder, Anda bisa manfaatkan
perintah “ls -l”. Kolom kedua dari setiap informasi berkas merupakan id pemilik berkas,
sedangkan kolom selanjutnya merupakan grup/kelompok pemilik berkas. 
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Keterangan : teks "asrilmarhamah" di sebelah kiri adalah id pengguna pemilik berkas,
sedangkan yang disebelah kanan merupakan id grup/kelompok pemilik berkas. 

14.3.12 Membuat Berkas Tar (tar)

Tar merupakan program yang berfungsi untuk menyatakan beberapa berkas/folder ke 
dalam satu berkas yang disebut dengan tarfile/tarball. Sangat berguna sekali untuk 
melakukan backup. 

Untuk membuat berkas tar, selain melalui aplikasi pengelola arsip pada desktop, Anda
juga bisa gunakan perintah tar  dengan format “tar -cvf berkas.tar  namaberkas/folder1
namaberkas/folder2.....”. Anda juga bisa gunakan opsi “-v” agar menampilkan informasi
detail dari proses tar. 

Sedangkan untuk mengekstrak atau mengeluarkan isi suatu tarfile, Anda bisa gunakan
perintah dengan format “tar -xf berkas.tar folder-tujuan”. 
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14.3.13 Kompresi Gzip (gzip)

Gzip atau GNU Zip merupakan format arsip terkompresi dengan algoritma Lempel-Ziv
(LZ77). Untuk melakukan kompresi suatu berkas dengan format Gzip, gunakan perintah
“gzip  namaberkas”.  Ekstensi  berkas  hasil  kompresi  adalah  *.gz.  Sebaliknya,  untuk
melakukan decompress, gunakan perintah “gunzip namaberkas”. 

14.3.14 Kompresi Bzip2 (bzip2)

Bzip2 atau GNU Bzip2 merupakan format kompresi arsip dengan algoritma Burrows-
Wheller block sorting text compression. Untuk melakukan kompresi suatu berkas dengan
format  bzip2,  gunakan  perintah  “bzip2  namaberkas”.  Ekstensi  berkas  hasil  kompresi
adalah  *.bz2.  Sedangkan  untuk  melakukan  decompress,  gunakan  perintah  “bunzip2
namaberkas”. 

INFO : Baik format gzip maupun bzip2 “hanya” melakukan kompresi terhadap sebuah
berkas. Jika ingin mengkompresi banyak berkas di dalam sebuah berkas,  Anda harus
menggunakan perpaduan antara perintah tar dengan perintah gzip maupun bzip2. Anda
bisa  menambahkan  opsi  “-z”  pada  perintah  tar  untuk  membuat/mengextract  tarball
dengan format kompresi GZIP. Sedangkan untuk membuatnya dengan format BZIP2,
gunakan opsi “-j” pada perintah tar. 

 Halaman 137   

14.27 Kompresi Gzip

14.28 Kompresi Bzip2



 Pengenalan Antarmuka Teks  

14.3.15 Pencarian Berkas (find)

Untuk  mencari  berkas,  gunakan  perintah  find  dengan  opsi  “find  folder  -name
“namaberkas”. Contohnya, jika Anda ingin mencari berkas bernama “Barongko.txt” di
dalam folder  Dokumen,  ketik  perintah  “find  Dokumen  -name “Barongko.txt”.  Maka
akan muncul path/lokasi dari berkas/folder yang bernama Barongko.txt.
 

TIP : Jika Anda ingin menulis nama berkas/folder lebih cepat, Anda bisa terlebih dahulu
mengetik satu/beberapa huruf awal dari nama berkas/folder tersebut, kemudian menekan
tombol Tab pada keyboard. Contohnya, jika ingin mengetik nama folder “Barobbo” lebih
cepat,  Anda  bisa  ketik  “B”  saja  atau  “Ba”,  kemudian  menekan  tombol  Tab.  Secara
otomatis, nama berkas akan dilengkapi. 

TIP : Jika ingin menyebutkan banyak nama berkas/folder yang memiliki huruf awal sama
(misalnya,  “Barongko.txt”,  “Buras.txt”,  “Bandang.txt”,  “Bella.txt”)  Anda cukup ketik
“B*”  (B  disertai  tanda  bintang  “*”).  Jika  ingin  menyebutkan  huruf  belakangnya
(misalnya ingin menyebutkan ekstensi berkas txt), Anda bisa ketik “*.txt”.

Sebenarnya,  masih banyak lagi  perintah-perintah untuk antarmuka teks  yang bisa
Anda gunakan untuk bekerja.  Untuk melakukan otomatisasi kerja,  Anda juga bisa
membuat  skrip  yang  disebut  dengan  shell  script.  Otomatisasi  pekerjaan  sangat
penting  bagi  administrator  untuk  memperingan  dan  mempercepat  pekerjaannya
dalam jaringan.  Untuk  mempelajari  shell  script  lebih  lanjut,  Anda bisa membaca
buku tentang Bash Scripting atau mencari referensi melalui internet.
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BAB 15 Pengaturan Perangkat Keras

Pengaturan  perangkat  keras  yang terpasang di  komputer  menggunakan Asril  OS sangat  mudah
sekali. Anda hampir tidak perlu melakukan pemasangan driver perangkat keras, karena Asril OS
sudah menyediakan hampir  semua driver  perangkat  keras  esensial  yang ada saat  ini.  Sehingga,
setelah pemasangan Asril  OS, hampir semua perangkat keras esensial  seperti  kartu video, kartu
suara, dsb bisa berjalan dengan baik. Namun untuk memantapkan perangkat keras tersebut, Anda
perlu  mengetahui  bagaimana  melakukan  pengaturan  perangkat  keras  yang  ada.  Semua  hal
menyangkut perangkat keras dibahas dalam bab ini. 
Walaupun hampir semua perangkat keras esensial mampu digunakan di Asril OS dengan baik dan
''out-of-the-box'' (tanpa perlu pengaturan mendetail), sampai saat ini masalah driver perangkat keras
masih  merupakan  masalah  dominan  dan  mengganggu  dunia  Linux.  Tidak  semua  produsen
perangkat  keras  merilis  driver-nya untuk platform Linux.  Walaupun ada  beberapa,  itupun tidak
Open Source dan masih dikembangkan secara tertutup. Hampir semua driver yang saat ini ada di
Linux merupakan hasil jerih payah para komunitas tanpa bantuan dari produsen perangkat keras.
Namun, hal ini akan menjadi masalah waktu saja. Beberapa produsen perangkat keras mulai maju
untuk mengembangkan driver-nya untuk Linux mengingat Linux semakin populer saat ini sebagai
sistem operasi untuk Desktop. 

15.1 Pengaturan Tampilan

Pengaturan Tampilan di Asril OS sudah diatur sedemikian rupa, sehingga resolusi layar monitor
sesuai dengan kemampuan monitor yang Anda miliki. Namun jika Anda ingin mengatur resolusi
monitor  agar  lebih  optimal,  atau  memanfaatkan beberapa  monitor  yang terpasang di  komputer,
Anda  bisa  melakukannya  dengan  fitur  pengaturan  Monitor.  Klik  Menu  Utama  >  Preferensi  >
Pengaturan Sistem pada sub Perangkat Keras pilih Tampilan. Tentukan resolusi layar pada pilihan
[>Resolusi<] serta Rotasi pada pilihan [>Rotasi<]. Jika semua pengaturan sudah selesai klik tombol
[>Terapkan<]. Mungkin saja, Anda akan diminta untuk me-restart  mode grafis agar konfigurasi
bisa diterapkan.
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15.2 Pengaturan Printer

Manajemen mesin pencetak atau printer yang ada di Asril OS diatur oleh sebuah perangkat lunak
server bernama CUPS (Common Unix Printing System). CUPS bertanggung jawab untuk menerima
permintaan  pencetakan  baik  dari  lokal  maupun  dari  jaringan,  melakukan  job  pencetakan  dan
mengirim informasi ke printer untuk melakukan pencetakan. 
Secara default,  driver mesin pencetak akan langsung terpasang di Asril OS jika mesin pencetak
tersebut sudah tersedia di sistem pada saat printer pertama kalinya dipasang ke komputer. Anda
akan melihat pesan notifikasi bahwa printer baru telah ditambahkan.

Namun, jika mesin pencetak Anda tidak terdeteksi sama sekali atau printer terbagi di jaringan, Anda
bisa  membuka  alat  konfigurasi  mesin  pencetak  yang  Anda  bisa  buka  melalui  Menu  Utama  >
Preferensi > Pengaturan Sistem pada sub Perangkat Keras pilih Printer.

 
Untuk menambahkan Printer, silahkan klik tombol [>Tambah>] maka anda akan melihat daftar
Printer yang terpasang ke komputer anda, apabila Printer anda sudah di kenali, maka akan tampil
nama printer anda tersebut (sebagai contoh Epson Stylus Photo R230) seperti tampak pada gambar
berikut.
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Untuk melanjutkan klik tombol [>Maju<], secara otomatis Deskripsi Pencetak akan terisi, tetapi
anda juga dapat merubahnya sesuai dengan keinginan anda. 

Jika sudah selesai semua, lanjutkan dengan klik tombol [>Terapkan>], maka akan muncul pilihan
untuk mencetak Halaman Uji, untuk mengetahui apakah Printer anda sudah terpasang dengan benar.
Untuk  melakukannya,  silahkan  pilih  [>Cetak  Halaman  Uji<],  jika  Cetak  Halaman  Uji  dapat
dicetak dengan baik, berarti Printer anda sudah terpasang dengan benar.

Untuk pengaturan yang lain, anda bisa atur melalui Properti Pencetak.
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Apabila sudah selesai semua, anda akan mendapatkan Printer anda sudah terdaftar pada Sistem
Konfigurasi Printer seperti tampak pada gambar berikut.

15.3 Pengaturan Pemindai

Manajemen  pemindai  di  Asril  OS  menggunakan  perangkat  lunak  bernama  Simple  Scan  atau
Pemindai  Ringkas.  Untuk  melakukan  pemindaian,  Anda  bisa  buka  program Pemindai  Ringkas
melalui Menu Utama > Grafik > Simple Scan. Sebelum melakukan pemindaian, Pemindai Ringkas
melakukan pendeteksian terhadap mesin pemindai yang terpasang di komputer. Setelah pemindai
ditemukan, maka Anda akan melihat tampilan utama Pemindai Ringkas.

 

Tampilan utama Pemindai  Ringkas  cukup sederhana.  Hanya ada baris  menu,  berapa ikon yang
mudah dimengerti  dan  jendela  utama hasil  pemindaian.  Sebelum melakukan pemindaian,  Anda
dapat melakukan pengaturan pemindaian seperti penggunaan warna, resolusi, ukuran halaman, dan
sisi  yang  hendak  dipindai  pada  jendela  utama  melalui  menu  Dokumen  >  Preferensi.  Setelah
pengaturan selesai, Anda dapat melakukan pemindaian dengan klik pada tombol [>Scan<] pada
jendela utama. 
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15.4 Pengaturan Kartu Wireless LAN

Berbeda dengan sistem operasi yang lain, dalam Linux khususnya Asril OS, Anda tidak perlu lagi
dipusingkan  dengan  masalah  kartu  wireless  LAN (WLAN),  karena  Asril  OS  sudah  memasang
driver-nya secara otomatis, hampir sebagian besar dari jenis-jenis kartu WLAN yang ada saat ini
sudah di dukung oleh Asril  OS. Namun, memang tidak dapat dipungkiri  bahwa sampai saat ini
masih saja ada beberapa jenis kartu WLAN yang belum di dukung sepenuhnya oleh Asril OS.

Untuk dapat  mengetahui apakah kartu WLAN yang kita  miliki  bekerja dengan baik,  kita dapat
memeriksannya  dengan  mengetikkan  perintah  [>sudo  iwconfig<]  ini  pada  Terminal.  Dengan
mengetikkan perintah tersebut, akan keluar output seperti berikut ini : 

Perintah tersebut akan menampilkan semua perangkat jaringan yang terpasang di komputer. Jika
perangkat  bukan  merupakan  WLAN,  maka  pada  bagian  kanan  nama  perangkat  tersebut  akan
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muncul teks [>no wireless extensions<]. Jika perangkat tersebut merupakan WLAN, maka akan
muncul beberapa detail pada bagian perangkat tersebut seperti pada bagian wlan0. Teks pada bagian
wlan0 menandakan bahwa driver WLAN sudah terpasang dan siap digunakan.

15.5 Pengaturan Bluetooth

Bluetooth  saat  ini  menjadi  sarana  komunikasi  antar  perangkat  mobile  yang  sangat  banyak
digunakan  saat  ini.  Dengan  menggunakan  Bluetooth,  tidak  perlu  lagi  memasang  kabel  LAN,
mengatur  ESSID,  Alamat  IP,  Gateway  dan  segala  tetek  bengek  lainnya  untuk  melakukan
komunikasi  antar  perangkat.  Cukup tentukan tujuan pengiriman data,  maka data  akan terkirim.
Untuk  menggunakan  Bluetooth  pada  komputer,  Anda  dapat  menggunakan  alat  yang  bernama
Bluetooth Adapter atau Bluetooth Dongle.  Bahkan, alat  ini  sudah tertanam secara built-in  pada
notebook-notebook terbaru.

Menggunakan Bluetooth adapter pada Asril OS tidaklah sulit.  Sebagian besar Bluetooth adapter
yang ada saat ini sudah dapat digunakan di Asril OS tanpa perlu memasang driver-nya lagi. Jika
Bluetooth adapter sudah terpasang dan sudah aktif, maka akan muncul ikon berlambang Bluetooth
pada area notikasi atau tray icon. 

Untuk melakukan sambungan terhadap suatu perangkat, berikut adalah langkah-langkahnya : 

✔ Klik pada ikon bluetooth pada notifikasi area, lalu pilih menu [>Set up a New Device<]. 

✔ Pilih perangkat bluetooth yang ingin Anda sambungan dan tentukan Opsi PIN yang Anda
inginkan untuk proses berpasangan, kemudian klik tombol [>Lanjutkan<].

 
✔ Kemudian, Asril OS akan melakukan koneksi ke perangkat yang Anda pilih. Pada tahapan

ini, Anda juga diberitahukan informasi kode PIN yang harus Anda masukkan di perangkat
agar  bisa  melakukan koneksi  dengan baik.  Setelah sambungan terjalin,  maka anda akan
diberi pilihan untuk pengaturan lebih lanjut. Jika tidak akan melakukan pengaturan tingkat
lanjut klik tombol [>Keluar<]. 
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Untuk melakukan transfer berkas ke perangkat, klik kanan pada ikon bluetooth pada area notifikasi,
lalu  klik  menu  [>Send Files  to  Device<].  Kemudian,  pilih  berkas  yang ingin  Anda kirim dan
tentukan Perangkat tujuan, kemudian klik [>Kirim<].

15.6 Penganalisa Penggunaan Disk

Untuk menganalisa penggunaan disk dalam komputer, Anda bisa menggunakan bantuan program
Penganalisa  Penggunaan Disk.  Program ini  berbasis  grafis  untuk menganalisa  penggunaan disk
pada  lingkungan  Cinnamon,  program ini  akan  dengan  mudah  memindai  semua  struktur  pohon
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filesistem, atau direktori khusus sesuai dengan pilihan Anda. Aplikasi ini bisa diakses melalui Menu
Utama > Administrasi > Penganalisa Penggunaan Disk silahkan pilih yang akan di analisa.
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BAB 16 Pengaturan Pengguna

Sistem operasi Asril OS merupakan sistem operasi multiuser atau banyak pengguna. Linux bisa
digunakan  oleh  banyak  pengguna  yang  memiliki  ruang  dan  lingkungan  masing-masing.  Setiap
pengguna juga memiliki nama akun pengguna (userid) dan kata sandi. Nama pengguna dan sandi
ini akan diminta pada saat pertama kali menjalankan Asril OS. Oleh karena itu, pengetahuan tentang
manajemen  pengguna  sangat  dibutuhkan dalam mempelajari  Asril  OS.  Baik  bagi  mereka  yang
sekadar pengguna rumahan yang hanya memilik satu jenis pengguna di sistem mereka, ataupun
mereka yang bertindak sebagai sistem administrator. Pada bab ini,  dibahas mengenai cara untuk
memanajemen pengguna yang ada di Asril OS melalui fitur Pengguna dan Grup. 

16.1 Pengaturan pengguna

Untuk melakukan pengaturan pengguna melalui antarmuka grafis, Anda bisa klik  Menu Utama >
Administrasi > Pengguna dan Grup. Masukkan kata sandi anda, berikut tampilan Pengguna dan
Grup. 

16.2 Menambah Pengguna

Untuk menambah pengguna baru, klik pada tombol “Tambah”. Masukkan Jenis Akun, Nama 
Lengkap, dan Nama Pengguna.

Setelah itu klik tombol “Tambah”. Maka akan terdaftar di Pengguna dan Grup.

 Halaman 147   

16.1 Pengguna dan Grup

16.2 Menu Tambah



 Pengaturan Pengguna  

Untuk memberikan sandi pada Pengguna Baru, klik pada “Kata sandi” pada “Belum ada kata sandi
yang dibuat”, maka akan muncul jendela untuk mengatur kata sandi.

Silahkan masukkan sandi baru dan konfirmasi, pastikan indikator sampai “OK”, setelah selesai klik
“Ubah”. Sekarang, Anda bisa melihat pengguna baru sudah memiliki sandi. Untuk masuk ke sistem
menggunakan pengguna tersebut, silahkan Log Out dan masuk lagi dengan Nama Pengguna dan
Kata Sandi yang telah dibuat. 

16.3 Mengganti Gambar Pengguna

Untuk mengganti gambar Pengguna,  klik Pengguna yang akan di ganti gambarnya dan klik pada
bagian  gambar,  kemudian  pilih  gambar  yang  sesuai,  jika  ingin  menggunakan  gambar  yang
tersimpan di komputer, klik Ramban untuk mencari gambar lainnya, lakukan pencarian pada folder
dimana  Anda  meletakkan  gambar  yang  ingin  digunakan,  klik  gambar  tersebut  kemudian  buka,
kemudian klik Pilih.
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16.4 Menghapus Pengguna

Untuk menghapus pengguna yang sudah ada, klik Pengguna yang akan di hapus kemudian klik
tombol “Hapus” maka akan muncul pemberitahuan untuk menghapus pengguna. Jika sudah yakin,
klik tombol “Ya”, maka pengguna tersebut terhapus.

 

16.5 Pengaturan Grup

Grup merupakan sekumpulan dari pengguna yang sama-sama memiliki suatu wewenang, seperti
wewenang pada sistem dan wewenang pada berkas sistem. Untuk melakukan pengaturan Grup, klik
tab “Grup”, maka akan muncul daftar grup yang ada di sistem. Anda bisa menambah, mengatur dan
menghapus Grup.
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BAB 17 Aksara Nusantara 

Asril OS adalah distribusi linux hasil remastering lokal Indonesia yang berusaha menampilkan ciri
khas Indonesia. Salah satu di antaranya adalah aksara - aksara Nusantara yang pernah dipakai di
negeri ini. Sayang sekali sekarang orang Indonesia sendiri justru tidak dapat membaca dan menulis
menggunakan aksara aslinya sendiri.
Aksara Nusantara yang ada di Asril OS ini diambil dari BlankOn Linux, kami percaya bahwa aksara
- aksara ini wajib dilestarikan dan digunakan kembali oleh orang-orang Indonesia. Oleh karena itu
Asril  OS  berusaha  menyertakan  aksara  Nusantara  di  setiap  rilisnya.  Dengan  adanya  Aksara
Nusantara ini, Asril OS dapat digunakan untuk pengetikan aksara-aksara Nusantara.

Aksara-aksara yang dapat digunakan antara lain : 

✔ Aksara Bugis 

✔ Aksara Sunda

✔ Aksara Rejang

✔ Aksara Bali (terbatas di beberapa aplikasi saja)

✔ Aksara Jawa (terbatas di beberapa aplikasi saja)

✔ Aksara Batak Toba

Aksara-aksara  tersebut  merupakan  bagian  dari  standarisasi  internasional  yang  disebut  dengan
Unicode (http://www.unicode.org). Dengan demikian, teks yang ditulis dengan Asril OS akan dapat
dibaca kembali pada sistem lain yang juga menggunakan standar Unicode.

Khusus aksara Bali dan Jawa tidak dapat digunakan penuh dengan aplikasi yang terinstal di Asril
OS  karena  keterbatasan  dukungan  perangkat  lunak.  Fonta  Bali  dan  Jawa  yang  dikembangkan
menggunakan  teknologi  OpenType yang tidak  sepenuhnya  berjalan  baik  di  beberapa  perangkat
lunak  terpasang  seperti  Chromium.  Namun pada  aplikasi-aplikasi  biasa  berbasis  Gtk+  lainnya,
aksara Bali dan Jawa bisa digunakan sempurna.

17.1 Mengaktifkan Metode Input

Untuk  dapat  mulai  mengetikkan  aksara-aksara  Nusantara,  Anda perlu  mengaktifkan metode
input  terlebih  dahulu.  Untuk  mengaktifkan metode input,  klik  Menu Utama > Preferensi  >
Bahasa. Pada Tab Metode Input di opsi ”Metode Input”, pilih ”SCIM”. Setelah itu keluarlah
dari desktop dan masuk kembali. Asril OS menggunakan SCIM sebagai alat metode inputnya.

17.2 Menggunakan Metode Input

Untuk  memulai  pengetikan,  buka  aplikasi  yang  hendak  Anda  isi  dengan  tulisan  beraksara
Nusantara. Kemudian pada kotak isian teks, tekan tombol pemicu “Ctrl + Spasi”. Pada pojok
kanan bawah layar klik gambar keyboard. Pilih aksara Nusantara yang hendak Anda pakai pada
menu tersebut, kemudian Anda bisa memulai pengetikan kata dan kalimat yang Anda inginkan
dalam aksara Nusantara. 
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17.3 Teknik Pengetikan 

Pengetikan bisa dilakukan seperti mengetik biasa dalam aksara latin. Metode input pada Asril
OS akan secara otomatis menerjemahkan apa yang anda ketik dalam aksara Nusantara. Agar
aksara dapat ditampilkan sesuai dengan keinginan, ada beberapa trik-trik khusus dalam proses
pengetikan, secara umum pengetikan dapat dilakukan dengan melakukan hal-hal berikut ini :

✔ Tekanlah tombol spasi setiap satu suku kata, agar proses pemenggalan baris dan 
pemilihan aksara lebih baik. 

✔ Tekan kembali Ctrl+Spasi untuk kembali ke pengetikan biasa (matikan fitur aksara 
Nusantara) 

17.4 Pengetikan Aksara Nusantara

17.4.1 Aksara Bugis

✔ Untuk bunyi è, ketik dengan kombinasi vokal ”AE”.

✔ Tanda pallawa ( ᨞ ), diperoleh dengan menekan tombol titik (.)

Contoh Pengetikan

Teks yang hendak di ketik Aksara Lontara Urutan Tombol tik

ènka ènka gare

ènka seuwa wètu
maseriadi

manre
marengala

 ᨕᨕᨕᨃᨕᨕᨕᨃ ᨁᨑ
 ᨕᨕᨕᨃᨔᨕᨕᨓᨓᨕᨈᨕ

ᨆᨔᨑᨑᨕᨉᨑ
ᨆᨋ
ᨆᨑᨂᨒ

aenka aenka gare
aenka seauwa waetu
maseriadi
manre
marengala

17.4.2 Aksara Bali

Pengetikan  Aksara  Bali  yang  tercantum  dibawah  ini  saya  ambil  dari  Buku  Panduan
BlankOn Rote, saya belum mencobanya. (Saya tidak paham tentang tata cara penulisan
aksara  Bali,  kalau  ada  yang  berkenang  mungkin  bisa  memberikan  masukan  untuk
melengkapi Buku Panduan sederhana ini).

✔ Untuk  menuliskan sebuah suku kata  dalam vokal  taling  (  ),  tekan tombol  Shift+E
setelah mengetik konsonan yang diinginkan. Misalnya dalam mengetik kata ”Nenten”
tekan tombol (secara berurutan) N, Shift+E, N, T, E, N 

✔ Untuk menuliskan vokal taling repa (ᬿᬿ), pada suatu suku kata, tekan tombol A + I
setelah tombol konsonan yang diinginkan. 

✔ Untuk menuliskan vokal taling repa tedung (ᬿᬿᭁ) pada suatu suku kata, tekan tombol A
+ U setelah menekan tombol konsonan yang diinginkan. 

✔ Untuk menuliskan vokal pepet tedung (ᬿᬿᭁ) pada suatu suku kata, tekan tombol A + U
setelah konsonan yang diinginkan. 
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✔ Untuk menuliskan vokal suku ilut (ᬿ)ᬹ, tekan tombol U selama 2 kali setelah menekan
tombol konsonan yang diinginkan. 

✔ Untuk menuliskan vokal  panjang (kosonan + tedung) dalam suatu suku kata,  tekan
tombol  A dua  kali  setelah  konsonan  yang  diinginkan.  Misalnya,  dalam  mengetik
”Kaatur” ( ), tekan tombol (secara berurutan) K, A, A, T, U, Shift+R. 

✔ Untuk menuliskan vokal ulu sari dalam suatu suku kata (dalam kondisi tertentu sesuai
aturan  penulisan  aksara  Bali),  tekan  tombol  I  dua  kali  setelah  konsonan  yang
diinginkan.  Misalnya,  dalam  mengetik  kata  ”Sari”  (ᬲᬭᬭ),  tekan  tombol  (secara
berurutan) S, A, R, I, I. 

✔ Untuk menuliskan tanda cecek untuk membunyikan konsonan ”NG” pada saat tertentu
(sesuai dengan aturan penulisan aksara Bali), tekanlah tombol Shift + N + G (secara
berurutan sambil menahan tombol yang sebelumnya ditekan) atau (secara berurutan)
Shift + N dan Shift + G. Misalnya jika ingin mengetik kata ”Kangkung”, tekan tombol
(secara berurutan) K, A, (Shift + N + G), K, U (Shift + N + G) (ᬓᬓᬓᬓᬓ ). 

✔ Untuk menuliskan tanda bisah untuk membunyikan konsonan ”H” pada saat tertentu
(sesuai dengan aturan penulisan aksara Bali), tekanlah tombol Shift + H. Misal jika
mengetik kata ”PISAH” (ᬧᬧᬲᬲ), tekan tombol (secara berurutan) P, I, S, A, Shift + H. 

✔ Untuk menuliskan tanda surang untuk membunyikan konsonan ”R”, tekanlah tombol
Shift + R. Misal jika mengetik kata ”KASAR” ( ), tekan tombol (secara berurutan) K,
A, S, A, Shift + R. 

✔ Untuk  menuliskan  konsonan-konsonan  dengan  aksara  khusus  (selain  18  konsonan
standar aksara Bali), gunakan kombinasitombol seperti tabel berikut : 

Da Madu 

Ta Latik 
Ta Tawa 

Sa Sapa 
Sa Saga 

Ba Kembang 
Pa Kapal 

Na Rambat 
Ka Mahaprana 

Ga Gora 
Ca Laca 

Ja Jera 
Ta Murda 

Da Murda Alpaprana 
Da Murda Mahaprana 

D + H + vokal 

T + T + vokal 
T + H + vokal 

S + S + vokal 
S + H + vokal 

B + H + vokal 
P + H + vokal 

N + N + vokal 
K + H + vokal 

G + H + vokal 
C + H + vokal 

J + H + vokal 
T + T + H + vokal 

D + D + vokal 
D + D + H + vokal 
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✔ Untuk mengetik karakter vokal tunggal (a kara, i kara, u kara). Gunakan kombinasi 
tombol seperti tabel berikut : 

A kara 
A kara tedung 

I kara 
I kara tedung 

U kara 
U kara tedung 

E kara 
O kara 

O kara tedung 
AI kara 

Shift + A 
Shift + A (2 kali) 

Shift + I 
Shift + I (2 kali) 

Shift + U 
Shift + U (2 kali) 

Shift + E 
Shift + O 

Shift + O (2 kali) 
Shift + A, Shift + I 
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✔ Fonta  Bali  yang  disertakan  belum  mendukung  beberapa  aplikasi  terkenal,  seperti
OpenOffice.org, Chromium, dan aplikasi non GTK lainnya (rencananya Fonta akan di-
porting ke teknologi SIL Graphite). 

✔ Belum menerapkan teknik ligatura untuk penggabungan antara suatu glyph dengan
tanda tedung (), seperti yang lumrah digunakan dalam teks aksara Bali. 

✔ Masih  terdapat  beberapa  kesalahan  rendering  jika  tanda  suara  atas  disandingkan
dengan konsonan tertentu (Ka Mahaprana, Ja Jera, Nya, dsb) 

Contoh Pengetikan.
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BAB 18 Content Management System

Content Management System (CMS) – Content Management System atau sering disebut dengan
CMS adalah aplikasi web yang berisikan template untuk mengelola isi halaman web secara mudah.
Penggunaan Content Management System tidak memerlukan pengetahuan pemrograman web yang
handal karena proses instalasi dan cara penggunaannya sudah user friendly. CMS sendiri ada yang
dibuat khusus menyesuaikan kasus yang ada dan biasanya berbayar dan ada yang berupa template
instan yang fungsionalitasnya dibuat dengan menyeuaikan pada beberapa proses bisnis yang ada
didunia nyata yang dapat digunakan secara gratis.
Aplikasi Content Management System instant yang banyak terdapat di internet saat ini kebanyakan
dibuat  menggunakan  scripting  language  PHP  dan  database-nya  adalah  MySQL.  Saat  ini
perkembangan  Content  Management  System cukup pesat,  banyak  vendor  yang  membuat  CMS
instant  yang  didistribusikan  secara  gratis.  Perkembangan  CMS  instant  ini  juga  dipicu  oleh
perkembangan web 2.0 yang memungkinkan interaksi dalam arti yang cukup luas antara pengelola
web dan pengunjung web.
Selain  perkembangan  teknologi  web  dan  infrastruktur  internet,  perkembangan  pesat  Content
Management System juga dipicu oleh kebutuhan masyarakat dan pelaku bisnis yang menginginkan
web dapat mendukung kegiatan bisnis mereka secara mudah dalam hal pengelolaan content, cepat
dalam pembuatan web, serta murah dalam pengadaannya.
Bahkan  saat  ini,  pengembangan  aplikasi  web  CMS  sudah  banyak  yang  menggunakan  konsep
freamework.  Dengan  konsep  ini,  sangat  dimungkinkan  untuk  melakukan  modifikasi  terhadap
beberapa fitur Content Management System instant tersebut karena semuanya dibuat lebih modular.
Berikut adalah beberapa contoh web CMS instant yang dibuat oleh vendor dan dapat digunakan
secara gratis dan scripting language yang digunakan adalah PHP dengan database server MySQL.
Untuk  menjalankan  aplikasi  berbasis  CMS,  kita  memerlukan  aplikasi  server,  aplikasi  web  dan
apliaksi database. Daripada memasang dan mengkonfigurasi satu per satu apliaksi tersebut, kita bisa
menggunakan aplikasi  Web Server  XAMPP yang sudah menyertakan server,  web dan database
dalam satu paket. Dengan demikian kita dapat menjalankan aplikasi berbasis CMS dengan mudah
dan praktis.
Berikut ini beberapa pemanfaatan dari Content Management System atau CMS, yaitu :

1. Untuk membuat website perusahaan, bisnis, komunitas.
2. Untuk membuat website pribadi / personal blog.

3. Untuk membuat aplikasi web e-Commerce.
4. Untuk membuat aplikasi web e-Learning.

5. Untuk membuat aplikasi e-Office.
6. Untuk membuat aplikasi web e-Forum dan lain-lain.

18.1 Web Server

Web Server adalah suatu server yang memberikan service (layanan) kepada klien yang meminta
informasi  berkaitan  dengan  web.  Web  server  sendiri  terdiri  dari  dua  komponen.  yang  pertama
adalah  komputer  itu  sendiri  dan  software  web  server  yang  dipakainya.  jadi  dapat  diambil
kesimpulan mesin(komputer)  apapun bisa saja menjadi web server asalkan software web server
tersedia di mesin(komputer) itu. salah satu software web server yang tersedia adalah Apache, tapi
selain itu masih banyak lagi web server lainnya seperti ISS, Xitami, dll.
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18.1.1 Web Server XAMPP

XAMPP  adalah  perangkat  lunak  bebas,  yang  mendukung  banyak  sistem  operasi,
merupakan kompilasi dari beberapa program. Fungsinya adalah sebagai server yang berdiri
sendiri (localhost), yang terdiri atas program Apache HTTP Server, MySQL database, dan
penerjemah bahasa yang ditulis dengan bahasa pemrograman PHP dan Perl. Nama XAMPP
merupakan  singkatan  dari  X (sistem operasi  apapun),  Apache,  MySQL,  PHP dan  Perl.
Program ini tersedia dalam GNU General Public License dan bebas, merupakan web server
yang mudah digunakan yang dapat melayani tampilan halaman web yang dinamis. Untuk
mendapatkanya  dapat  mendownload  langsung  dari  web  resminya  di
http://www.apachefriends.org/. 

Untuk mengaktifkan layanan Web Server XAMPP anda dapat lakukan dengan membuka
XAMPP Control Panel melalui  Menu Utama > Content Management System > XAMPP
Control Panel.

Secara default sudah kami aktifkan dalam artian sudah berjalan otomatis begitu komputer
diaktifkan,  sehingga  anda  bisa  langsung menggunakan  aplikasi  CMS yang  sudah  kami
sertakan tanpa harus mengaktifkan Web Server XAMPP terlebih dahulu. Melalui Control
Panel ini, anda dapat menjalankan ataupun menghentikan Web Server XAMPP. Bisa juga
anda lakukan dengan mengetikkan perintah di Terminal seperti berikut ini :

sudo /opt/lampp/lampp start ↵

untuk menjalankan Web Server XAMPP

sudo /opt/lampp/lampp restart ↵

untuk menjalankan ulang Web Server XAMPP

sudo /opt/lampp/lampp stop ↵

untuk menghentikan Web Server XAMPP
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Untuk mengakses Web Server XAMPP dapat dilakukan dengan mengetikkan “localhost”
pada  Web  Browser,  secara  default  keamanan  kami  aktifkan,  anda  dapat  membukanya
dengan menggunakan user name  xampp dengan password  admin.  Adapun tampilannya
seperti tampak pada gambar berikut ini :

Untuk  mengakses  phpMyAdmin  dan  melakukan  perubahan  pada  DataBase  anda  dapat
lakukan dengan mengetikkan http://localhost/phpmyadmin/ pada Web Browser, untuk login
gunakan usernam root dengan password admin.

Semua  username  yang  berhubungan  dengan  Web  Server  XAMPP  kami  atur  semua
password  nya  adalah  admin untuk  kemudahan  dalam  penggunaan,  namun  anda  dapat
menggantinya sesuai dengan kebutuhan anda.

18.1.2 Fitur Web Server XAMPP

Pada rilis kali ini, kami menyertakan XAMPP versi 5.6.23-0 dengan beberapa fitur sebagai 
berikut :

1. Apache 2.4.18
2. MySQL 5.0.11

3. PHP 5.6.23
4. PEAR + SQLite 2.8.17/3.7.17 + multibyte support (mbstring)

5. Perl 5.16.3
6. PhpMyAdmin 4.5.2

7. OpenSSL 1.0.1e
8. ProFTPD 1.3.4c

9. GD 2.0.35
10. Freetype 2.4.8
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18.2 Aplikasi CMS

Asril OS menyertakan beberapa aplikasi CMS yang kami anggap bisa memenuhi kebutuhan anda
dalam menggunakan komputer sehari-hari  dengan berbagai latar belakang dan profesi.  Adapaun
aplikasi CMS yang kami sertakan pada rilis kali ini yaitu AhadPOS merupakan Aplikasi CMS untuk
melakukan transaksi  Point  Of Sales  (POS),  JIBAS merupakan Aplikasi  CMS untuk melakukan
administrasi akademik pada dunia pendidikan, SLIMS merupakan Aplikasi CMS untuk melakukan
manajemen pada perpustakaan dan TCExam merupakan . Berikut penjelasan singkat dari Aplikasi
CMS tersebut.

18.2.1 AhadPOS

AhadPOS adalah software POS / Point Of Sales (software kasir / jual-beli) untuk UKM,
dengan lisensi Open Source (GPL v2).

AhadPOS di desain untuk dapat :

1. Melakukan  banyak  transaksi  jual-beli  dengan  akurat,  mudah,  dan  cepat,
memungkinkan UKM untuk berkembang.

2. Memungkinkan  pelacakan  stok  /  inventory  yang  akurat  secara  real-time,
meminimalisir kemungkinan kebocoran, kecurangan, pencurian, dll

3. Pencatatan  transaksi  keuangan  yang  akurat,  salah  satu  masalah  di  UKM  adalah
pembukuan.

Dengan AhadPOS, maka ini langsung tercatat di databasenya secara otomatis, sehingga bisa
terlacak secara akurat.

Berbasis Web

AhadPOS sangat powerful, dan tetap mudah digunakan. Dengan memanfaatkan berbagai
fitur dari browser Firefox, maka AhadPOS bisa digunakan dengan cepat, walaupun berbasis
Web / menggunakan software browser. Karena berbasis Web, maka AhadPOS jadi memiliki
beberapa kelebihan dibandingkan software POS lainnya, Seperti :

1. Fleksibel.
2. Mudah di customize / disesuaikan dengan kebutuhan masing-masing penggunanya.

3. Bisa diakses dari berbagai jenis perangkat : tablet, notebook, dll. AhadPOS bahkan
telah digunakan dengan menggunakan Smartphone (Nokia E71) di sebuah lokasi.

4. Mudah di maintain / maintenance.

5. Dan banyak lagi keuntungan dari platform Web.
Untuk menggunakan aplikasi  AhadPOS ini,   bisa  melalui  klik  Menu Utama > Content
Management  System > AhadPOS  atau  melalui  web browser  dengan mengakses  alamat
http://localhost/ahadpos/

Adapun username dan password untuk login menggunakan AhadPOS ini  secara default
dibagi menjadi tiga tingkatan yaitu :

1. Administrator dengan user : admin dan password : admin

Adapun tampilan AhadPOS dengan Pengguna Admin ini adalah sebagai berikut :
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2. Gudang dengan user : input dan password : input
Adapun tampilan AhadPOS dengan Pengguna Input ini adalah sebagai berikut :
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3. Kasir dengan user : kasir1 dan password : kasir1

Adapun tampilan AhadPOS dengan Pengguna Kasir ini adalah sebagai berikut :

Silahkan gunakan sesuai dengan kebutuhan anda, anda dapat mengaturnya sesuai dengan
keinginan  anda,  silahkan  dipergunakan  dengan  bijak.  Selamat  menggunakan  AhadPOS.
Semoga dapat banyak bermanfaat bagi bisnis Anda. Info lebih lanjut mengenai AhadPOS
ini, anda dapat mengeceknya di blog resmi AhadPOS di https://ahadpos.wordpress.com/.

18.2.2 JIBAS

JIBAS singkatan dari  Jaringan Informasi Bersama Antar  Sekolah.  JIBAS lahir  dari  visi
"Kebersamaan untuk Kemajuan Pendidikan Indonesia".  Misi JIBAS adalah membangun
jaringan informasi dan komunitas pendidikan yang bisa mewadahi interaksi dan aktifitas
setiap  elemen pendidikan dari  siswa,  guru,  orang tua,  sekolah,yayasan,  pemerintah  dan
masyarakat umum.

Singkat kata, jaringan yang dibentuk JIBAS akan menggabungkan fitur dan layanan berupa
komunitas + konten + informasi + hiburan, mirip gabungan Facebook + Google + Yahoo +
Wikipedia  tetapi  khusus  untuk  pendidikan  Indonesia.  Jaringan  ini  bersifat  terbuka  dan
tumbuh mandiri.  Terbuka artinya,  berbagai  pihak dapat  ikut  serta  mengembangkan dan
menyediakan  layanan  pendidikan  bagi  komunitas  yang  terbentuk.  Tumbuh  mandiri
maksudnya,  jaringan  komunitas  ini  berkembang  dari  aktifitas  dan  interaksi  dari  setiap
anggotanya.

Salah  satu  wujud  JIBAS  yaitu  sistem  informasi  manajemen  sekolah  yang  membantu
operasional sekolah mulai dari akademik, keuangan, perpustakaan, pelaporan dan interaksi
guru-siswa.  Diharapkan,  sistem  ini  dapat  membantu  sekolah  mengatur,  mengelola  dan
merapikan  datanya.  Dengan  demikian,  data  ini  menjadi  informasi  yang  mengalir  dan
bermanfaat bagi berbagai pihak yang berkepentingan. Tentunya, hal ini dapat menjadi salah
satu  nilai  tambah  dari  layanan  komunitas  pendidikan  yang  dibentuk.  Karena  Yahoo,
Facebook,  Google  dan  Wikipedia,  dan  berbagai  layanan  yang  diberikan  situs  lainnya
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berasal dari kerapihan dan keteraturan data.

Sistem  ini  dipasang  secara  lokal  di  sekolah  jadi  memudahkan  sekolah  untuk
menggunakannya. Secara berkala, data operasional sekolah ini ditransfer secara online atau
offline ke basis data JIBAS pusat. Jadi, bagi sekolah yang berada di daerah atau belum
memiliki fasilitas Internet memadai, masih dapat terhubung ke jaringan JIBAS. Dari basis
data  JIBAS pusat  inilah  kemudian  dibentuk  layanan  komunitas,  informasi  sekolah  dan
konten pendidikan yang dapat diakses oleh berbagai elemen pendidikan, dari mulai siswa,
guru, orang tua, sekolah, yayasan, pemerintah dan masyarakat umum.

Untuk  menggunakan  aplikasi  JIBAS  ini,   bisa  melalui  klik  Menu  Utama  >  Content
Management  System  >  JIBAS  atau  melalui  web  browser  dengan  mengakses  alamat
http://localhost/  jibas  /. Adapun tampilan utama JIBAS seperti tampak pada gambar berikut
ini.

Untuk menggunakannya silahkan klik menu yang ada di Tampilan Utama tersebut, secara
default, gunakan user : jibas dan password : password

Silahkan gunakan sesuai dengan kebutuhan anda, anda dapat mengaturnya sesuai dengan
keinginan anda, silahkan dipergunakan dengan bijak. Info lebih lanjut mengenai JIBAS ini,
anda dapat mengeceknya di web resmi JIBAS di http://www.jibas.net/. 

18.2.3 SLIMS

Apa itu SLIMS (Software Senayan Library Management System)

SLIMS  adalah  perangkat  lunak  sistem  manajemen  perpustakaan  (library  management
system) sumber  terbuka yang dilisensikan di  bawah GPL v3.  Aplikasi  ini  pertama kali
dikembangkan dan digunakan oleh Perpustakaan Kementerian Pendidikan Nasional, Pusat
Informasi dan Hubungan Masyarakat, Kementerian Pendidikan Nasional. Aplikasi SLIMS
dibangun dengan menggunakan PHP, basis data MySQL, dan pengontrol versi Git. Pada
tahun 2009, SLIMS mendapat penghargaan tingkat pertama dalam ajang INAICTA 2009
untuk kategori open source.
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Ketika dirilis  pertama kali,  SLIMS baru diunduh 704 kali.  Angka ini  melonjak menjadi
6.000 kali lebih pada Desember 2007 dan 11 ribu lebih Januari 2008. Adapun pada Oktober
lalu program itu sudah diunduh hampir 27 ribu kali. Dengan demikian, total sudah 250 ribu
kali  lebih  program  itu  diunduh.  Saat  ini  SLIMS  telah  digunakan  luas  oleh  berbagai
perpustakaan, baik di dalam maupun luar negeri.

Beberapa Fitur SLIMS :

1. Online  Public  Access  Catalog  (OPAC)  dengan  pembuatan  thumbnail  yang  di-
generate on-thefly.

2. Thumbnail berguna untuk menampilkan cover buku.

3. Mode penelusuran tersedia untuk yang sederhana (Simple Search) dan tingkat lanjut
(Advanced Search)

4. Detail  record  juga  tersedia  format  XML (Extensible  Markup  Language)  untuk
kebutuhan web service.

5. Manajemen data bibliografi yang efisien meminimalisasi redundansi data.
6. Manajemen  masterfile  untuk  data  referensial  seperti  GMD  (General  Material

Designation), Tipe Koleksi, Penerbit, Pengarang, Lokasi, Supplier, dan lain-lain.

7. Sirkulasi dengan fitur: Transaksi peminjaman dan pengembalian, Reservasi koleksi,
Aturan peminjaman yang fleksibel, Informasi keterlambatan dan denda.

8. Manajemen keanggotaan.

9. Inventarisasi koleksi (stocktaking)
10. Laporan dan Statistik

11. Pengelolaan terbitan berkala
12. Dukungan  pengelolaan  dokumen  multimedia  (.flv,.mp3)  dan  dokumen  digital.

Khusus untuk pdf dalam bentuk streaming.

13. Beragam format bahasa termasuk bahasa yang tidak menggunakan penulisan selain
latin.

14. Menyediakan  berbagai  bahasa  pengantar  (Indonesia,  Inggris,  Spanyol,  Arab,
Jerman).

15. Dukungan Modul Union Catalog Service.
16. Counter Pengunjung perpustakaan.

17. Member Area untuk melihat koleksi sedang dipinjam oleh anggota.
18. Modul  sistem  dengan  fitur:  Konfigurasi  sistem  global,  Manajemen  modul,

Manajemen User (Staf Perpustakaan) dan grup, Pengaturan hari libur, Pembuatan
barcode otomatis, Utilitas untuk backup.

Untuk  menggunakan  aplikasi  SLIMS  ini,   bisa  melalui  klik  Menu  Utama  >  Content
Management  System  >  SLIMS  atau  melalui  web  browser  dengan  mengakses  alamat
http://localhost/slims/. Adapun tampilan utama SLIMS seperti tampak pada gambar berikut
ini.
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Untuk menggunakannya silahkan klik menu yang ada di sebelah kanan atas, secara default,
gunakan user :  admin dan password :  admin adapun tampilan menu nya seperti tampak
pada gambar berikut.

Silahkan  gunakan  sesuai  dengan
kebutuhan  anda,  anda  dapat
mengaturnya  sesuai  dengan  keinginan
anda,  silahkan  dipergunakan  dengan
bijak. Info lebih lanjut mengenai SLIMS
ini,  anda  dapat  mengeceknya  di  web
resmi SLIMS di http://slims.web.id/ 
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18.2.4 TCExam

TCExam merupakan sebuah software open source berbasis web yang dapat menghasilkan
dan  mengelola  tes  atau  ujian  secara  online.  Sebuah  e-tes  (ujian  berbasis  komputer)
merupakan ujian elektronik yang dapat dieksekusi dengan menggunakan komputer pribadi
atau perangkat elektronik yang setara (misalnya iPad).
Sistem ini memungkinkan Anda untuk menyederhanakan siklus ujian secara keseluruhan,
termasuk  pelaksanaan,  evaluasi,  presentasi,  dan  pengarsipan.  Penyederhanaan  ini
memungkinkan Anda untuk menghemat waktu dan uang sambil meningkatkan kehandalan
ujian.

Adapun fitur-fitur TCExam :

1. Sistem instalasi otomatis
2. Software server dengan platform independent

3. Dukungan multi bahasa (termasuk dukungan untuk TMX standar dan Unicode UTF-8)
4. Berdasarkan  teknologi  standar  dan  standar  terbuka  (PHP5,  MySQL,  PostgreSQL,

XHTML, JavaScript, PDF)

5. Termasuk lapisan abtraksi database dengan driver dari MySQL dan PostgreSQL
6. Antarmuka berbasis web, kompatibel dengan hampir semua web browser modern

7. Mencakup  wilayah  administrasi  yang  dilindungi,  yang  memungkinkan  untuk
mengelola seluruh sistem

8. Mendukung  tingkat  akses  yang  berbeda  baik  untuk  pengguna  dan  sumber  daya
(halaman, bentuk, bagian)

9. Termasuk  sistem  keamanan  tambahan  untuk  mengakses  tes  berdasarkan  dari
pengecekan alamat IP

10. Mendukung jumlah tes, topik, pertanyaan, dan jawaban yang tak terbatas

11. Mendukung format teks dan penggunaan gambar dalam deskripsi tes, pertanyaan, dan
jawaban

12. Sekali ditetapkan, topik dapat digunakan sendiri-sendiri atau bersama-sama untuk tes
yang berbeda

13. Mendukung  pertanyaan  dengan  jawaban  banyak  dan  pertanyaan  dengan  jawaban
bebas

14. Menghitung nilai kumulatif secara otomatis untuk berbagai jawaban

15. Mencakup sistem manual untuk mengevaluasi jawaban bebas
16. Menghasilkan  tes  unik  untuk  setiap  pengguna  dengan  memilih  pertanyaan  dan

jawaban secara acak yang mungkin

17. Mendukung waktu untuk mulai dan durasi tes
18. Dapat menghasilkan versi PDF dari tes, sehingga dapat dilakukan tanpa menggunakan

komputer

19. Menghasilkan laporan dan data statistik baik dalam XHTML dan format PDF
20. Memungkinkan kostumisasi format dan header dari dokumen PDF

21. Mendukung output dari hasil tes bagi pengguna akhir
22. Mengirimkan hasil tes kepada pengguna ke alamat email pengguna
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Hirarki TCExam dimulai dari membuat :
1. Group

2. User
3. Modul

4. Paket Soal
5. Butir Soal (dibuat satu persatu, berikut kunci jawaban benar dan salahnya, untuk 

Multiple Choice)

6. Lalu terakhir adalah membuat Ujian (Test), di sini kita dapat menentukan beberapa 
parameter seperti waktu mulai dan akhir ujian (Test), nilai per butir soal, group yang 
dapat mengikuti ujian sampai KKM.

7. Terakhir menggandeng Test (Ujian) dengan paket soal dan modul yang sudah kita buat
sebelumnya.

Untuk  menggunakan  aplikasi  TCExam  ini,  bisa  melalui  klik  Menu  Utama  >  Content
Management  System  >  TCExam atau  melalui  web  browser  dengan  mengakses  alamat
http://localhost/tcexam/.  Adapun  tampilan  utama  TCExam  seperti  tampak  pada  gambar
berikut ini.

Untuk menggunakannya silahkan login terlebih dahulu, secara default, gunakan user : admin
dan password : 1234 adapun tampilan menu nya seperti tampak pada gambar berikut.
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Silahkan gunakan sesuai dengan kebutuhan anda, anda dapat mengaturnya sesuai dengan
keinginan anda, silahkan dipergunakan dengan bijak. Info lebih lanjut mengenai TCExam
ini, anda dapat mengeceknya di web resmi TCExam di http://www.tcexam.org/.
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